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FCC Information

This is an FCC Class A product. In a domestic environment this product may 
cause radio interference in which case the user may be required to take 
adequate measures.

This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user 
will be required to correct the interference at his own expense.

RoHS

This product is RoHS compliant.

SJ/T 11364-2006

The following contains information that relates to China.
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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

International http://support.aten.com

North America http://www.aten-usa.com/product_registration

International 886-2-8692-6959

China 86-10-5160-1602

Japan 81-3-5323-7178

Korea 82-2-467-6789

North America ATEN TECH 1-888-999-ATEN

ATEN NJ 1-732-356-1703

United Kingdom 44-8-4481-58923
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Package Contents

The KVM Over the NETTM switch package consists of:

1 KN2124v, KN2140v, KN4124v, KN4140v, KN2116A, KN2132, KN4116, 
or KN4132 KVM Over the Net™ Switch

2 SA0142 Serial Adapters (RJ45-F to DB9-M; DTE to DCE)

1 Grounding Wire

1 Power Cord (KN2116A / KN4116 / KN2132 / KN4132 only)

2 Power Cords (KN2124v / KN2140v / KN4124v / KN4140v only)

2 Utility Power Cords (KN2124v / KN2140v / KN4124v / KN4140v only)

1 5-in-1 Console Cable (KN2124v / KN2140v / KN4124v / KN4140v only)

1 Rack Mount Kit

1 Foot Pad Set (4 pcs.)

1 User Manual*

1 Quick Start Guide

Check to make sure that all of the components are present and in good order. 
If anything is missing, or was damaged in shipping, contact your dealer.

Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the switch or to any other 
devices on the installation.

* Features may have been added since this manual was printed. Please visit our 
website to download the most up to date version of the manual.

Copyright © 2006–2009 ATEN® International Co., Ltd.
Manual Part No. PAPE-0296-AX4G

F/W Version: 1.1.108
Manual Date: 2010-01-12

Altusen and the Altusen logo are registered trademarks of ATEN International Co., Ltd. All rights reserved.
All other brand names and trademarks are the registered property of their respective owners.
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About This Manual

This User Manual is provided to help you get the most from your KVM Over 
the NETTM system. It covers all aspects of installation, configuration and 
operation. An overview of the information found in the manual is provided 
below.

Overview
Chapter 1, Introduction, introduces you to the KN2124v / KN2140v / 
KN4124v / KN4140v / KN2116A / KN2132 / KN4116 / KN4132 KVM Over 
the NETTM System. Its purpose, features and benefits are presented, and its 
front and back panel components are described.

Chapter 2, Hardware Setup, provides step-by-step instructions for setting 
up your installation, and explains some basic operation procedures.

Chapter 3, Super Administrator Setup, explains the procedures that the 
super administrator employs to set up the KVM Over the NETTM switch 
network environment, and change the default username and password.

Chapter 4, Logging In, describes how to log in to the KVM Over the 
NETTM switch with each of the available access methods: from a local console; 
an internet browser; a stand-alone Windows application (AP) program; and a 
stand-alone Java application (AP) program.

Chapter 5, The User Interface, describes the layout and explains the 
components of the KVM Over the NETTM user interface.

Chapter 6, Port Access, describes the Port Access page and how to 
configure the options it provides regarding port manipulation.

Chapter 7, User Management, shows super administrators and 
administrators how to create, modify, and delete users and groups, and assign 
attributes to them.

Chapter 8, Device Management, shows super administrators how to 
configure and control overall KVM Over the NETTM switch operations.

Chapter 9, Maintenance, explains how to upgrade the KVM Over the 
NETTM switch firmware, as well as the firmware of the KVM Adapter Cables 
used to connect its ports to the installed devices.

Chapter 10, Download, describes how to download stand-alone AP 
versions of the Win Client, the Java Client, the Log Server, and Power Over the 
Net (PON) programs.
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Chapter 11, Port Operation, provides detailed information on accessing 
and operating the devices connected to the KVM Over the NETTM switch ports.

Chapter 12, The Log Server, explains how to install and configure the 
Log Server.

Chapter 13, LDAP Server Configuration, explains how to configure the 
KVM Over the NETTM switch for LDAP / LDAPS authentication and 
authorization with Active Directory or OpenLDAP.

An Appendix, at the end of the manual provides technical and 
troubleshooting information.

Conventions
This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means 
to press the Enter key. If keys need to be chorded, they appear 
together in the same bracket with a plus sign between them: 
[Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential 
steps.

→ Indicates selecting the option (on a menu or dialog box, for 
example), that comes next. For example, Start → Run means 
to open the Start menu, and then select Run.

Indicates critical information.
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Terminology
Throughout the manual we make reference to the terms Local and Remote in 
regard to the operators and equipment deployed in a KVM Over the NETTM 
switch installation. Depending on the point of view, users and servers can be 
considered Local under some circumstances, and Remote under others:

Switch’s Point of View
Remote users – We refer to a user as a Remote user when we think of 
him as someone who logs into the switch over the net from a location 
that is remote from the switch.
Local Console – The keyboard mouse and monitor connected directly 
to the switch.
Servers – The servers attached to the switch via KVM Adapter Cables.

User’s Point of View
Local client users – We refer to a user as a Local client user when we 
think of him as sitting at his computer performing operations on the 
servers connected to the switch that is remote from him.
Remote servers – We refer to the servers as Remote servers when we 
think of them from the Local Client User’s point of view – since, 
although they are locally attached to the switch, they are remote from 
him.

When we describe the overall system architecture we are usually speaking 
from the switch’s point of view – in which case the users are considered 
remote. When we speak about operations users perform via the browser, 
viewers, and AP programs over the net, we are usually speaking from the user’s 
point of view – in which case the switch and the servers connected to it are 
considered remote.

Product Information

For information about all ALTUSEN products and how they can help you 
connect without limits, visit ALTUSEN on the Web or contact an ALTUSEN 
Authorized Reseller. Visit ALTUSEN on the Web for a list of locations and 
telephone numbers:

International http://www.aten.com

North America ATEN TECH http://www.aten-usa.com

ATEN NJ http://www.aten.com
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Chapter 1
Introduction

Overview

The KVM Over the NETTM series of switches are IP-based KVM control units 
that allow both local and remote operators to monitor and access multiple 
servers from a single console. A single KN4140v can control up to 40 servers, 
and by cascading up to 40 compatible 16 port switches, as many as 640 servers 
can be controlled on a complete two stage installation.

The switches are differentiated according to the number of buses they support 
and the number of KVM ports they provide – as shown in the table below:

Each bus permits a separate user session so that up to three (1 Local; 2 Remote) 
or five (1 Local; 4 Remote) concurrent independent connections to the attached 
servers can take place.

Model Bus Support KVM Ports
KN2124v 1 Local; 2 Remote 24
KN2140v 1 Local; 2 Remote 40
KN4124v 1 Local; 4 Remote 24
KN4140v 1 Local; 4 Remote 40
KN2116A 1 Local; 2 Remote 16
KN2132 1 Local; 2 Remote 32
KN4116 1 Local; 4 Remote 16
KN4132 1 Local; 4 Remote 32

Local

Remote

Remote

Remote

Remote

1 - 20

21 - 40

TCP/IP
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Since KVM Over the NETTM switches use TCP/IP for their communications 
protocol, they can be accessed via their IP addresses from anywhere on the 
LAN, WAN, or Internet – whether the connecting computer is located down 
the hall, down the street, or half-way around the world. Remote operators can 
log in via their browser or make use of stand-alone Windows or Java GUI 
applications. Java allows the switches to work with JRE (Sun’s Java Runtime 
Environment) enabled operating systems – ensuring multi-platform 
operability.

The client software allows operators to exchange keyboard, video and mouse 
signals with the servers attached to the KVM Over the NETTM switches as if 
they were present locally and working on the equipment directly.

Up to 32 users can share the switch’s buses. A Message Board feature allows 
them to communicate with each other to facilitate port sharing.

Administrators can handle a multitude of maintenance tasks with ease – from 
installing and running GUI applications, to BIOS level troubleshooting, routine 
monitoring, concurrent maintenance, system administration, rebooting and 
even pre-booting functions.

Local console operation is easily accomplished either by entering hotkey 
combinations from the keyboard with a full screen GUI display.

Monitoring the installation’s activities couldn’t be easier. An convenient Auto 
Scan feature permits automatic switching from port to ports at user-specified 
intervals, while the Panel Array Mode can display the video output of up to 40 
servers at the same time.

The switches feature RJ-45 connectors allowing them to use CAT 5e cable to 
link to the servers. This space-saving innovation means that a full 16, 24, 32 or 
40 port switch can be conveniently installed in a 1U system rack, and the 
installation can take advantage of the internal network wiring built into most 
modern commercial buildings.

Setup is fast and easy; plugging cables into their appropriate ports is all that is 
entailed. Because the switch intercepts keyboard input directly, there is no need 
to get involved in complex software installation routines, or to be concerned 
with incompatibility problems.

Since the firmware is upgradeable over the Net, you can stay current with the 
latest functionality improvements simply by downloading firmware updates 
from our website as they become available.

With its advanced security features, the KVM Over the NETTM switch provides 
the fastest, most reliable, most cost effective way to remotely access and 
manage widely distributed multiple server installations.
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KVM Over the NETTM switches have an Adapter ID function that stores port 
information like the adapter ID, OS, keyboard language, adapter name, 
operation modes and more, so that when you move a KVM Adapter Cable from 
one port to another, the switch recognizes the same adapter cable at the new 
location. Also, for greater ease of use when moving the adapter cable to another 
switch, the adapter ID, OS, keyboard language, adapter name, and operation 
modes of the port stay with the adapter.

With its advanced virtual media features, the KN2124v / KN2140v / KN4124v 
/ KN4140v series of switches let you map DVD/CD drives and other storage 
media to a server. This function allows you to conduct file transfers, installs 
applications and OS patches, and perform diagnostics remotely. You can 
upgrade your entire installation from a single remote console located anywhere 
in the world.

The KN4140v offers dual power supplies so that if one of the power supplies 
fails, the second power supply automatically takes over. In addition to 
supporting dual power, the KN4140v guards against power failure from your 
server room outlets. If your server room has more than one power source, 
connecting the KN4140v power supplies to different power sources is a wise 
choice. If one of the server room power supplies loses power, the KN4140v 
will automatically adjust the power it draws from the second source to keep 
functioning.

The KN2124v, KN2140v, KN4124v, and KN4140v models support four 
temperature sensors that can control up to six fans. The sensors regulate the 
fans so that they run at optimum speed depending on the server room 
temperature – throttling down when necessary, to use energy more efficiently 
and prolong the life of both the fans and the switch.

The KN2124v, KN2140v, KN4124v, and KN4140v models are also audio 
enabled. Microphone and speakers are supported on the Local Console for the 
servers; speakers are supported on the remote users’ computers.
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Features

Hardware
High port density – RJ-45 connectors for up to 40 ports in a 1U housing
Two or four separate buses for remote KVM over IP access
Two 10/100/1000 Mbps NICs for redundant LAN or two IP operation
Supports PS/2, USB, Sun Legacy (13W3) and serial (RS-232) 
connectivity
Local console provides PS/2 and USB keyboard and mouse support
Supports multiplatform server environments: Windows, Mac, Sun, Linux 
and VT100 based serial devices
High video resolution – up to 1600 x 1200 @ 60Hz – 32 bit color depth for 
the local console; up to 1600 x 1200 @ 60Hz with 24 bit color depth for 
remote sessions, at up to 50 m
Monitor and control up to 16, 24, 32, or 40 servers on a single level, or 
control up to 640 servers in a two-level cascade*

Note: Cascade-compatible KVM Switches include the following: 
CS9134, CS9138, CS88A, KH1508, and KH1516

Management
Up to 64 user accounts – up to 32 users simultaneously share the control
Fan speed varies according to temperature
End session feature – administrators can terminate running sessions
Event logging and Windows-based Log Server support
Critical system events sent by email and SNMP trap; and Syslog support
Firmware upgradeable
Modem dial-in/dial back support
Adapter ID
Port Share Mode allows multiple users to gain access to a server 
simultaneously
Integration with ALTUSEN CC2000 Management software
Power Over the NET™ integration for remote power control
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Ease-to-Use Interface
Local Console, browser-based, and AP GUIs offer a unified multilanguage 
interface to minimize user training time and increase productivity
Multiplatform client support (Windows, Mac OS X, Linux, Sun)
Multibrowser support (IE, Mozilla, Firefox, Safari, Opera, Netscape)
Browser-based UI in pure Web technology allows administrators to 
perform administrative tasks without pre-installed Java software package 
required 
User can launch multiple Virtual Remote Desktops to control multiple 
connected servers from the same login session 
Magic Panel
Full-screen or sizable and scalable Virtual Remote Desktop
Panel Array Mode

Advanced Security
Remote authentication support: RADIUS, LDAP, LDAPS, and MS Active 
Directory
Advanced security features include password protection and advanced 
encryption technologies – 1024 bit RSA; 56 bit DES; 256 bit AES; and 
128 bit SSL
Flexible encryption design allows users to choose any combination of 56-
bit DES, 168-bit 3DES 256-bit AES, 128-bit RC4, or Random for 
independent KB/Mouse, video, and virtual media data encryption 
Support for IP/MAC Filter
Supports strong password protection
Configurable user and group permissions for server access and control
Local and remote access logged and authenticated
Private CA
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Virtual Media
Virtual media enables file applications, OS patching, software installation 
and diagnostic testing 
Works with USB enabled servers in operating system and BIOS level
Supports DVD/CD drives, USB mass storage devices, PC hard drives and 
ISO images

Virtual Remote Desktop
Video quality and video tolerance can be adjusted to optimize data transfer 
speed; monochrome color depth setting, threshold and noise settings for 
compression of the data bandwidth in low bandwidth situations 
Full screen video display or scalable video display
Message Board for communication among remote users
Mouse DynaSync™
Keyboard pass through support
Exit Macros support
On-screen keyboard with multilanguage support
BIOS-level access

V-Series Exclusive
Features found only with the V-Series KVM Over the NETTM switches 
(KN2124v, KN2140v, KN4124v, and KN4140v) include the following:

Audio – a microphone and speakers are supported on the Local Console; 
speakers (only) are supported on the remote user computers.
Dual power supply support – Log and UI reflect the power status
Virtual Media support
Variable fan speed – speed changes according to the switch’s temperature
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System Requirements

Remote User Computers
Remote user computers (also referred to as client computers) are the ones the 
users log into the switch with from remote locations over the internet (see 
Terminology, page xv). The following equipment must be installed on these 
computers:

For best results we recommend that the computers used to access the 
switch have at least a P III 1 GHz processor, with their screen resolution 
set to 1024 x 768.
Browsers must support 128 bit SSL encryption.
For best results, a network transfer speed of at least 512kbps is 
recommended.
For the Windows Client AP, DirectX 8 must be present, and at least 90MB 
of memory must be available after installation.
For the Java Client AP, the latest version of Sun's Java Runtime 
Environment (JRE) must be installed, and at least 145MB of memory must 
be available after installation.
For the browser-based WinClient ActiveX Viewer, DirectX 8 must be 
present, and at least 150MB of memory must be available after 
installation.
For the browser-based Java Applet Viewer the latest version of Sun's Java 
Runtime Environment (JRE) must be installed, and at least 205MB of 
memory must be available after installation.
For the Log Server, you must have the Microsoft Jet OLEDB 4.0 or higher 
driver installed.

Servers
Servers are the computers connected to the switch via KVM Adapter Cables 
(see Terminology, page xv). The following equipment must be installed on 
these servers:

A VGA, SVGA or multisync port
For USB KVM Adapter Cable Connections: a Type A USB port and USB 
host controller
For PS/2 KVM Adapter Cable Connections: 6-pin Mini-DIN keyboard 
and mouse ports
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Video
Only the following non-interlaced video signals are supported:

KVM Adapter Cables
Cat 5e (or higher) cable is required to connect the KVM Over the NETTM 
switch to the KVM Adapter Cables (see page 21).
The following KVM Adapter Cables are required for use with the KVM 
Over the NETTM switch:

Note: 1. The KVM Adapter cables marked with an asterisk (*) are for use with 
the KN2124v, KN2140v, KN4124v and KN4140v switches only.

2. If you use Adapter Cables that were purchased prior to your switch 
purchase, you may have to upgrade the Adapter Cable’s firmware. 
You can upgrade the Adapter Cable’s firmware from the 
Maintenance page (see page 149 for details). 

Resolution Refresh Rates

640 x 480 60, 70, 72, 75, 85

720 x 400 70, 75

800 x 600 56, 60, 70, 72, 75, 85

1024 x 768 60, 70, 75, 85

1152 x 864 60, 70, 75, 85

1152 x 900 66, 76

1280 x 1024 60, 70, 75, 85

1600 x 1200 60

Function Module

Connect to devices with PS/2 ports KA9120 / KA7120

Connect to devices with USB ports
(All platforms – PC, Mac, Sun)

KA9170 / KA7170

Connect to Sun Legacy Computers KA9130 / KA7130

Connect to serial based devices KA9140 / KA7140

Connect to devices with USB ports and virtual 
media support

KA7175*

Connect to devices with USB ports, virtual 
media and audio support

KA7176*
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Operating Systems
Supported operating systems for remote user computers that log into the 
KVM Over the NETTM switch include Windows 2000 and higher, and 
those capable of running Sun's Java Runtime Environment (JRE) 6, 
Update 3, or higher (Linux, Mac, Sun, etc.).
Supported operating systems for the servers that are connected to the 
switch’s ports are shown in the table, below:

Browsers
Supported browsers for users that log into the KVM Over the NETTM 
switch include the following:

* See Mac Systems, page 204, for further information.

OS Version

Windows 2000 and higher

Linux RedHat 7.1 and higher

Fedora Core 2 and higher

SuSE 9.0 and higher

Mandriva (Mandrake) 9.0 and higher

UNIX AIX 4.3 and higher

FreeBSD 4.2 and higher

Sun Solaris 8 and higher

Novell Netware 5.0 and higher

Mac OS 9 and higher*

DOS 6.2 and higher

Browser Version

IE 6 and higher

Firefox 1.5 and higher

Mozilla 1.7 and higher

Safari 2.0 and higher*

Opera 9.0 and higher

Netscape 8.1 and higher
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Components

KN2124v / KN2140v / KN4124v / KN4140v Front View

Note: The figure above shows the front panel of a KN2140v / KN4140v.
The KN2124v / KN4124v differs in that there are fewer port LEDs.

KN2116A / KN2132 / KN4116 / KN4132 Front View

Note: The figure above shows the front panel of a KN4132 /KN2132.
The KN2116A / KN4116 differs in that it only has a single row of port 
LEDs.

2

5 74

1 3

6

2

5 74

1 3
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No. Component Description
1 Power LED Lights when the unit is powered up and ready to operate.
2 Port LEDs The Port LEDs provide status information about their 

corresponding KVM Ports.
GREEN: The computer attached to the port is On Line.
RED: The computer attached to the port is Selected (has 
KVM focus).
GREEN + RED (ORANGE): The computer attached to the 
port is On Line and Selected.

The LEDs are steady under normal conditions, but a LED 
flashes at half second intervals when its corresponding port is 
accessed under Auto Scan Mode or Skip Mode (see pages 158 
and 159).

3 LAN LEDs Primary and Secondary 10/100/1000 Mbps LAN LEDs. 
RED: 10 Mbps
RED + GREEN (ORANGE): 100 Mbps
GREEN: 1000 Mbps
Flashes to indicate that the switch is being accessed over 
the Net.

4 USB Ports A USB keyboard and mouse can plug in here. This can either 
be in place of, or in addition to, plugging a keyboard and mouse 
into the ports on the rear panel. (This port can be used to 
connect USB flash storage only on the KN4140v.)

5 Reset Switch Note: This switch is recessed and must be pushed with a small 
object such as the end of a paper clip, or a ballpoint pen.

Pressing and releasing this switch when the unit is running 
performs a system reset.
Pressing and holding this switch in for more than three 
seconds when the unit is running resets its configuration to 
the factory default settings.
Note: This does not clear User Account information. 

See Clear Login Information, page 226, for 
information on clearing user account information.

Pressing and holding this switch while powering on the 
switch returns the unit to its factory default firmware level, 
rather than the firmware version that the switch has been 
upgraded to. This allows you to recover from a failed 
firmware upgrade and gives you the opportunity to try 
upgrading the firmware again.
Note: This operation should only be performed in the event 

of a firmware upgrade failure that results in the device 
becoming inoperable.

6 Audio Ports Speakers and microphone plug in here. (KN4140v only)
7 Port Switching 

Buttons
Press PORT DOWN to switch from the current port to the 
previous port on the installation.
Press PORT UP to switch from the current port to the next 
port on the installation.
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KN2124v / KN2140v / KN4124v / KN4140v Rear View

Note: The figure above shows the rear panel of a KN2140v / KN4140v with 
two blocks of 16 KVM ports and one block of 8 (40 ports in total). The 
KN2124v / KN4124v differs in that it only has a single block of 16 
KVM ports and one bock of 8 (24 ports in total).

KN2116A / KN2132 / KN4116 / KN4132 Rear View

Note: The figure above shows the rear panel of a KN2132 / KN4132 with two 
blocks of 16 KVM ports (32 ports in total). The KN2116A / KN4116 
differs in that it only has a single block of KVM ports (16 ports in total).

1 2 3 4

65 7 8 9

1 2 3 4

65 7 8 9
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No. Component Description

1 Power Socket The power cable(s) plugs in here.
Note: For the KN2124v, KN2140v, KN4124v and the 
KN4140v units, the top power socket corresponds to the left 
power switch, and the bottom power socket corresponds to 
the right power switch.

2 Power Switch This standard slide switch powers the unit on and off.

3 Secondary LAN 
Port

The cable that connects the unit to the backup network 
interface (10/100/1000 Mbps) plugs in here.

4 PON Port This connector is provided for a Power over the Net™ 
(PON) unit which allows servers attached to the KVM Over 
the NETTM switch to be booted remotely over the net. 
See Single Stage Installation, page 21, step 6 for 
installation details. Contact your dealer for more information 
regarding PON units.

5 Grounding 
Terminal

The wire used to ground the unit connects here.

6 Primary LAN 
Port

The cable that connects the unit to the primary network 
interface (10/100/1000 Mbps) plugs in here.

7 Modem Port For dial in connection should the unit be unavailable over 
the network. See Single Stage Installation, page 21, step 7 
for installation details.

8 Local Console 
Port(s)

The unit can be accessed via a local console as well as over 
the Net. The local console devices (keyboard, monitor and 
mouse), plug in here. Any combination of USB and PS/2 
keyboards and mice can be used.
Note: For the KN2124v, KN2140v, KN4124v and the 
KN4140v units, use the 5-in-1 cable supplied with the 
package to connect your console devices to the unit.

9 KVM Ports The Cat 5e cables that link the unit to the KVM Adapter 
Cables (which connect to the servers), plug in here.
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Chapter 2
Hardware Setup

Overview

For convenience and flexibility that allows mixing the PS/2 and USB 
interfaces, as well as multiple platforms, the KVM Over the NETTM switch 
design utilizes KVM Adapter Cables, that serve as intermediaries between the 
switch and the connected devices (refer to the installation diagram on p. 16).

A separate KVM Adapter Cable is required for each server or device 
connection. The model numbers of the Adapters are given in the KVM Adapter 
Cables section, page 8.

Before You Begin

1. Important safety information regarding the placement of this 
device is provided on page 189. Please review it before 
proceeding.

2. Make sure that the power to any device that you connect to the 
installation has been turned off. You must unplug the power cords 
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Stacking and Rack Mounting

The KVM Over the NETTM switch can be stacked on the desktop or rack 
mounted in a variety of ways. The following sections take you through the 
procedures for each method.

Stacking
The KVM Over the NETTM switch can be placed on any appropriate level 
surface that can safely support its weight plus the weight of its attached cables. 
To place the KVM Over the NETTM switch, or to stack units if you are daisy-
chaining them, remove the backing material from the bottom of the rubber feet 
that came with this package, and stick them onto the switch’s bottom panel at 
the corners, as shown in the diagram, below:

Note: To ensure adequate ventilation, allow at least 5.1 cm on each side, and 
12.7 cm behind the unit for power cord and cable clearance.
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Rack Mounting
The KVM Over the NETTM switch can be mounted in a 19" (1U) rack. The 
mounting brackets can screw into either the front or the back of the unit so that 
it can attach to the front or the back of the rack. 

Rack Mounting - Front
To mount the unit at the front of the rack, do the following:

1. Remove the two screws at the front of the unit.

2. Use the M3 x 8 Phillips head hex screws supplied with the rack mount kit 
to screw the rack mounting brackets into the front of the unit.

Phillips head hex
M3 x 6

Phillips head hex
M3 x 8
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3. Position the device in the front of the rack and align the holes in the 
mounting brackets with the holes in the rack.

4. Screw the mounting brackets to the rack.

Note: Cage nuts are provided for racks that are not prethreaded.

kn2124v-4132.book  Page 18  Tuesday, January 12, 2010  5:08 PM



 Chapter 2. Hardware Setup

19

Rack Mounting - Rear
To mount the unit at the rear of the rack, do the following:

1. Remove the two screws at the rear of the unit.

2. Use the M3 x 8 Phillips head hex screws supplied with the rack mounting 
kit to screw the rack mounting brackets into the rear of the unit.

3. Position the device in the rack and align the holes in the mounting brackets 
with the holes in the rack.

Phillips head hex
M3 x 6

Phillips head hex
M3 x 8
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4. Screw the mounting brackets to the rear of the rack.

Note: Cage nuts are provided for racks that are not prethreaded.
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Single Stage Installation

In a single stage installation, there are no additional switches cascaded from the 
KVM Over the NETTM switch. To set up a single stage installation, refer to the 
installation diagrams starting on page 23 (the numbers in the diagram 
correspond with the numbers of the instruction steps), and do the following:

1. For the KN2124v, KN2140v, KN4124v and KN4140v, use the 5-in-1 
Console Cable supplied with the package to connect your Local Console 
devices to the unit. 
For the KN2132, KN4116, and KN4132, plug your Local Console’s 
keyboard, monitor, and mouse into the unit’s Console Ports. Each port is 
color coded and marked with an appropriate icon.

Note: 1. You can use any combination of keyboard and mouse 
connections. For example, you can use a PS/2 keyboard with a 
USB mouse.

2. USB keyboards and mice can plug into the USB ports on the front 
panel, as well as into the ports in the console port section.

3. The KVM Over the NETTM switch does not support distances that 
exceed 20m between itself and the local monitor.

2. Use Cat 5e cable to connect any available KVM port to a KVM Adapter 
Cable that is appropriate for the server you are installing (see the table on 
page 8 for details).

Note: 1. If you are using a KA7120, KA7130, KA9120, KA9130, or 
KA9131 Adapter Cable, refer to page 216 for mouse pointer 
synchronization information.

2. If you are using a KA9131 Adapter Cable, refer to page 204 for 
video and mouse adjustment information.

3. If you are using a KA7140 Adapter Cable, refer to page 214 for 
setup and operation information.

4. The distance between the switch and the KVM Adapter Cable 
must not exceed these lengths: KA7140: 300m; KA71xx: 50m; 
KA91xx: 40m.

3. Plug the connectors on the KVM Adapter Cable into the appropriate ports 
of the server you are installing. (See Adapter Cable Connection Diagram, 
page 25.)
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4. Plug a cable from the LAN or WAN into the KVM Over the NETTM switch 
primary network interface socket.

5. (Optional) Plug another cable from the LAN or WAN into the KVM Over 
the NETTM switch backup (secondary) network interface socket.

6. (Optional) Use Cat 5e cable to connect the KVM Over the NETTM switch 
PON port to an SA0142 Adapter. Connect the Adapter to the PON IN port 
of a PN0108 Power Over the Net™ unit.

7. (Optional) Use Cat 5e cable to connect the KVM Over the NETTM switch 
Modem port to an SA0142 Adapter. Connect the Adapter’s serial 
connector to the modem’s DB-9 port.

8. Use the grounding wire supplied with this package to ground the unit by 
connecting one end of the wire to the grounding terminal, and the other 
end of the wire to a suitable grounded object.

Note: Do not omit this step. Proper grounding helps to prevent damage to 
the unit from surges or static electricity.

9. Plug the power cord(s) supplied with this package into the KVM Over the 
NETTM switch power socket, and then into an AC power source.
For the KN2124v, KN2140v, KN4124v and KN4140v, when using a 
single power socket, be sure to turn on the correct power switch (see 
Power Switch, page 13). When using both power sockets, either of the 
power switches can be used to turn on the KVM switch – or, to enable dual 
power, turn on both power switches.

Note: If you are connecting the power to a UPS or an ALTUSEN PN9108/
PN0108 use the utility power cords supplied with this package 
instead of the standard power cords.

After the KVM Over the NETTM switch is cabled up you can turn on the power. 
After it is powered up, you can turn on the servers.
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KN2124v / KN2140v / KN4124v / KN4140v
Single Stage Installation Diagram

9

7

1

6

3

2

2

4

5

Modem

PN0108

8

by
 ATEN

P
S
/2

 C
P
U
 M

O
D
U
LE

M
O

D
E
L 

N
O

. K
A
91

20

P
S
/2

 C
P
U
 M

O
D
U
LE

M
O

D
E
L 

N
O

. K
A
91

20

LIN
K

1

kn2124v-4132.book  Page 23  Tuesday, January 12, 2010  5:08 PM



KVM Over the NET™ User Manual

24

KN2116A / KN2132 / KN4116 / KN4132
Single Stage Installation Diagram
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Adapter Cable Connection Diagram
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Two Stage Installation

To control even more servers, up to 40 additional KVM switches can be 
cascaded from the KVM ports of the KVM Over the NETTM switch. As many 
as 640 servers can be controlled in a complete two stage installation.

In a cascaded installation, the KVM Over the NETTM switch is considered the 
First Stage unit, the cascaded switches are considered Second Stage units.

Note: The cascaded KVM switch shown in the example is the KH1516. 
See Supported KVM Switches, page 228, for a list of other switches.

To set up a two stage installation, refer to the diagram on page 27, and do the 
following:

1. Make sure that power to all the devices you will be connecting, including 
all preexisting devices on the installation, have been turned off.

2. Use Cat 5e cable to connect any available KVM Port on the First Stage 
unit (the KVM Over the NETTM switch) to a KVM Adapter Cable (as 
described under KVM Adapter Cables, page 8).

3. Plug the adapter cable’s KVM connectors to the Keyboard, Video, and 
Mouse Console ports of the Second Stage unit.

Note: The distance between the First Stage unit and the Second Stage unit 
must not exceed 40m or 50m based on the KVM adapter cable used.

4. Use KVM cable sets (as described in the Cables section of the cascaded 
KVM switch’s User Manual), to connect any available KVM port on the 
Second Stage unit to the Keyboard, Video, and Mouse ports of the server 
you are installing.

5. Plug the power cord that came with the cascaded KVM switch into its 
Power Socket, and then into an AC power source.

6. Repeat these steps for any other Second Stage units you wish to connect.

7. Power on the Second Stage unit(s), then power on the First Stage unit.

8. Turn on the power to all the servers.

Note: The Power On sequence requires that all Second Stage switches be 
powered on first. After all Second Stage switches are powered on, 
the First Stage switch can be powered on. After all the switches are 
powered on, the servers can be powered on.
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Two Stage Installation Diagram
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Hot Plugging

The KVM Over the NETTM switch supports hot plugging – components can be 
removed and added back into the installation by unplugging and replugging 
cables from the ports without the need to shut the unit down.

Note: If the server’s Operating System does not support hot plugging, this 
function may not work properly.

The Adapter ID Function
Adapter Cable information that includes the Adapter ID, port name, OS, 
keyboard language, and access mode is stored on the adapter. The Adapter ID 
function stores this information, as well as the adapter cable’s configuration 
information (such as access rights, etc.), in the switch’s database.

When you move a server together with its adapter cable from one port to 
another, you don’t have to reconfigure its settings – the Adapter ID function 
restores them at the new location. The only change is in the port number.

When moving the server and adapter cable to another switch, however, only the 
information that is stored on the adapter is retained. For the other settings you 
must either reconfigure them, or use the Port Utilities export/function (see 
page 84) to restore them.

Since port settings are stored with the adapter, if you move a server to a new 
port without its original adapter; or if you connect a different server to the 
adapter, you must manually configure the port settings for the new server. 
See Port Utilities, page 84 for port configuration details.

Powering Off and Restarting

If it becomes necessary to power off the switch, or if the switch loses power 
and needs to be restarted, wait 10 seconds before powering it back on. The 
servers should not be affected by this, but if any of them should fail, simply 
restart them.
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Port ID Numbering

Each server on the installation is assigned a unique Port ID. The Port ID is a 
one or two segment number that is determined by the Stage Level and KVM 
Port number of the KVM switch that the server is connected to.

The first segment represents the KVM Port number of the First Stage unit; the 
second segment represents the KVM Port number of the Second Stage unit.

A server attached to a First Stage unit has a one segment Port ID (from 1–40) 
that corresponds to the KVM Port number that it is connected to.

A server attached to a Second Stage unit has a two segment Port ID:
The second segment (from 1–16), represents the KVM Port number on the 
Second Stage unit that the server is connected to. The first segment (from 
1–40) represents the KVM Port number on the First Stage unit that the 
Second Stage unit links back to.
For example, a Port ID of 12 - 3 refers to a server that is connected to 
KVM Port 3 of a Second Stage unit that links back to KVM Port 12 of the 
First Stage unit.

Port Selection

Port selection is accomplished by means of the GUI. Port selection details are 
discussed in Chapter 6, Port Access.
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Chapter 3
Super Administrator Setup

Overview

The KVM Over the NETTM switch supports three types of user, as shown in the 
table, bellow:

This chapter discusses the administrative procedures that the Super 
Administrator performs.

First Time Setup

Once the KVM Over the NETTM switch has been cabled up, the Super 
Administrator needs to set the unit up for user operation. This involves setting 
the network parameters and adding users. The most convenient way to do this 
for the first time is from the local console.

Note: For remote methods of setting up the network, see IP Address 
Determination, page 208.

After the local console has been connected (see Single Stage Installation, 
page 21), and the KVM Over the NETTM switch turned on, a login prompt 
appears on the console monitor:

User Type Role

Super Administrator Access and manage ports and devices. Manage Users, and 
Groups. Configure the overall installation. Configure 
personal working environment.

Administrator Access and manage authorized ports and devices. Manage 
Users and Groups. Configure personal working environment.

User Access authorized ports and devices. Manage authorized 
ports and devices; configure personal working environment.
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Since this is the first time you are logging in, use the default Username: 
administrator; and the default Password: password.

Note: For security purposes, you should change these to a unique Username 
and Password. (See Changing the Super Administrator Login, page 34 
for details.)

After you successfully log in, the Local Console Main Page appears:
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Network Setup
To set up the network, do the following:

1. Click the Device Management tab.

2. Select the Network tab.

3. Fill in the fields according to the information provided under Network, 
page 124.
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Changing the Super Administrator Login
To change the default Super Administrator Username and Password, do the 
following:

1. At the top of the screen, click User Management.
The User Management page has a list of Users and Groups in the left hand 
panel, and a more detailed list of users – with more information about 
them – in a large central panel. Since this is the first time the page is being 
accessed, only the Super Administrator appears:

2. Click administrator in the left panel
– or –
Select administrator in the central panel, then click Modify (at the bottom 
of the page.)

(Continues on next page.)
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(Continued from previous page.)

The User Information page appears:

3. Change the Username and Password to something unique.

4. Re-enter the password to confirm it is correct.

5. Click Save.

6. When the dialog box informing you that the change completed 
successfully appears, Click OK.

7. Click on another item on the Local Console Main Page, to close this page.
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Moving On

After setting up the network and changing the default Super Administrator 
password, you can proceed to other administration activities. These include 
User Management, Device Management, and Firmware Upgrade Maintenance.

These activities can be accomplished using any of the KVM Over the NETTM 
switch GUI utilities. These include the Local Console; the browser-based 
Windows ActiveX Viewer; the browser-based Java Applet Viewer; the 
stand-alone Windows Client AP; and the stand-alone Java Client AP. Choose 
the approach that suits you best.

Note: Firmware Upgrade Maintenance cannot be performed from the local 
console. You must log in remotely with one of the KVM Over the 
NETTM switch other GUI utilities for this operation.
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Chapter 4
Logging In

Overview

KVM Over the NETTM switches can be accessed from a local console; an 
internet browser; a Windows application (AP) program; and a Java application 
(AP) program.

No matter which access method you choose, the KVM Over the NETTM 
switch’s authentication procedure requires you to submit a valid username and 
password. If you supply an invalid login, the authentication routine will return 
an Invalid Username or Password, or Login Failed message. If you see this 
type of message, log in again with a correct username and password.

Note: If the number of invalid login attempts exceeds an amount specified by 
the switch’s Super Administrator, a timeout period is invoked. You must 
wait until the timeout period expires before you can attempt to log in 
again. See Login Failures, page 138 for further details.

Local Console Login

When the local console is attached (see Single Stage Installation, page 21) and 
there is no user logged in, the KVM Over the NETTM login screen appears on 
the display:

Simply key in your Username and Password, then click Login to bring up the 
Local Console Main Page. The Local Console Main Page is similar to the Web 
Browser, WinClient and Java Client Main Pages. For a description of the Web 
Browser Main Page, see page 45.
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Browser Login

The KVM Over the NETTM switch can be accessed via an Internet browser 
running on any platform. To access the switch, do the following:

1. Open the browser and specify the IP address of the switch you want to 
access in the browser's location bar.

Note: For security purposes, a login string may have been set by the 
administrator (see page 136 for details). If so, you must include a 
forward slash and the login string along with the IP address when 
you log in. For example:

192.168.0.100/kn4140v

If you don't know the IP address and login string, ask your 
Administrator.

2. When a Security Alert dialog box appears, accept the certificate – it can be 
trusted. (See Trusted Certificates, page 219, for details.) If a second 
certificate appears, accept it as well.
Once you accept the certificate(s), the login page appears:

3. Provide your username and password (set by the administrator), then click 
Login to bring up the Web Main Page. For a discussion of the Web Main 
Page, see page 45.
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WinClient AP Login

In some cases, the Administrator may not want the KVM Over the NETTM 
switch to be available via browser access. The Windows AP Client allows 
direct remote access to Windows systems users, without having to go through 
a browser.

You initially download the Windows AP Client program from the browser 
page (see Chapter 10, Download). To connect to the KVM Over the NETTM 
switch, go to the location on your hard disk that you downloaded the Windows 
AP Client program to, and double-click its icon (WinClient.exe) to bring up the 
Windows Client Connection Screen:
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The Connection Screen
A description of the Connection Screen is given in the following table:

Item Description

Menu Bar The Menu Bar contains two items: File and Help.

The File Menu allows the operator to Create, Save, and 
Open user created Work files (see The File Menu, 
page 41).
The Help Menu displays the WinClient AP version.

Server List Each time the WinClient.exe file is run, it searches the User's 
local LAN segment for KVM Over the NETTM units, and lists 
whichever ones it finds in this box. If you want to connect to 
one of these units, double-click it.
Note: 1. The switch will not appear in the list unless its 

Enable Device List configuration parameter has 
been enabled. See Working Mode, page 139 for 
details.

2. Only units whose Access Port settings for Program 
(see Service Ports, page 125) match the number 
specified for Port in the Server area of this dialog 
box appear in the Server List window.

Server This area is used when you want to connect to a KVM Over 
the NETTM switch at a remote location. You can drop down 
the IP list box and select an address from the list. If the 
address you want isn't listed, you can key in the target IP 
address in the IP field, and its port number in the Port field. (If 
you don't know the port number, contact your Administrator.)

When the IP address and Port number have been 
specified, click Connect to bring up a login dialog box. 
Provide your Username and Password then click OK to 
bring up the WinClient Main Page. For a description of the 
WinClient Main Page, see page 48.

When you have finished with your session, click 
Disconnect to end the connection.

Message List Lists status messages regarding the connection to the KVM 
Over the NETTM switch.

Switch to Remote View Once a connection with a KVM Over the NETTM switch has 
been established, this button becomes active. Click it to 
switch to the WinClient Main Page. The WinClient Main Page 
is described on page 48.
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The File Menu
The File Menu allows the operator to Create, Save, and Open user created 
Work files. A Work File consists of all the information specified in a Client 
session. This includes the Server List and Server IP list items, as well as the 
Hotkey settings.

Whenever a user runs the Client program, it opens with the values contained in 
the current work file. The current work file consists of the values that were in 
effect the last time the program was closed.

The File menu consists of the following items:

New Allows the user to create a named work file so its values will not 
be lost, and it will be available for future recall.

Open Allows the user to open a previously saved work file and use the 
values contained in it.

Save Allows the user to save the values presently in effect as the 
current work file.

Exit Exits the WinClient.
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Java Client AP Login

In those cases in which the Administrator does not want the KVM Over the 
NETTM switch to be available via browser access, but the local client users 
aren’t running Windows, the Java AP Client provides direct remote access to 
non-Windows systems users.

You initially download the Java AP Client program from the browser page (see 
Chapter 10, Download). To connect to the KVM Over the NETTM switch, go to 
the location on your hard disk that you downloaded the Java AP Client program 
to, and double-click its icon (JavaClient.jar) to bring up the Address Input 
dialog box:

1. Key in the IP address for the unit you want to connect to. For example:
192.168.0.132

Note: If the system administrator set the switch’s Program port to 
something other than the default you must specify the port number 
along with the IP address. For example: 192.168.0.132:9111 
See Program, page 125 for details.
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Click OK. A Login dialog box appears:

.

Provide a valid Username and Password, and then click OK to switch to the 
Java Client AP Main Page. The Java Client AP Main Page is similar to that of 
the WinClient AP Main Page. For a description of the Main Page, see page 48.
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Chapter 5
The User Interface

Overview
Once you have successfully logged in the KVM Over the NETTM user interface 
Main Page appears. The look of the page varies slightly, depending on which 
method you used to log in. Each of the interfaces is described in the sections 
that follow.

The Web Browser Main Page

To ensure multi-platform operability, access to the KVM Over the NETTM 
switches can be accomplished with most standard web browsers. Once users 
log in and are authenticated (see page 38), the Web Browser Main Page comes 
up, with the Port Access page displayed:

Note: 1. The screen depicts a Super Administrator’s page. Depending on a 
user’s type and permissions, not all of these elements appear.

2. When logging in from the Local Console, the Maintenance and 
Download icons do not appear, and Array Mode is not available (it is 
grayed out).
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The web page components are described in the table below:

Page Components
The web page screen components are described in the table, below:

No. Item Description

1 Tab Bar The tab bar contains the KVM Over the NETTM’s 
main operation categories. The items that appear in 
the tab bar are determined by the user’s type, and 
the authorization options that were selected when 
the user’s account was created.

2 Menu Bar The menu bar contains operational sub-categories 
that pertain to the item selected in the tab bar. The 
items that appear in the menu bar are determined by 
the user’s type, and the authorization options that 
were selected when the user’s account was created.

3 Sidebar The Sidebar provides a tree view listing of ports that 
relate to the various tab bar and menu bar 
selections. Clicking a node in the Sidebar brings up 
a page with the details that are relevant to it.
There is a Filter button at the bottom of the Sidebar 
that lets you expand or narrow the scope of the ports 
that appear in the tree. The Filter function is 
discussed in detail on page 90

4 About About provides information regarding the switch’s 
current firmware version.

5 Logout Click this button to log out of your KVM Over the 
NETTM session.

6 Welcome Message If this function is enabled (see Welcome Message*, 
page 97), a welcome message displays here.

7 Interactive Display Panel This is your main work area. The screens that 
appear reflect your menu choices and Sidebar node 
selection.
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The Tab Bar
The number and type of icons that appear on the Tab Bar at the top of the page 
are determined by the user’s type (Super Administrator, Administrator, User) 
and the permissions assigned when the user’s account was created. The 
functions associated with each of the icons are explained in the table below:

There are two small icons at the extreme right of the page. Their functions are 
described in the table, below:

Icon Function

Port Access: The Port Access page is used to access and control the 
devices on the KVM Over the NETTM installation. This page is 
available to all users.

User Management: The User Management page is used to create 
and manage Users and Groups. It can also be used to assign devices 
to them. User Management is discussed on page 105. This page is 
available to the Super Administrator and Administrators. The icon 
doesn’t display on the page of ordinary users.

Device Management: The Device Management page is used by the 
Super Administrator (and Administrators and Users with Configuration 
permission) to configure and control the overall operation of the KVM 
Over the NETTM switch. This page is available to the Super 
Administrator. The icon doesn’t display on the page of ordinary 
administrators and users.

Log: The Log page displays the contents of the log file. The Log page 
is discussed on page 98.

Maintenance: The Maintenance page is used this icon to install new 
versions of the KVM Over the NETTM switch's firmware. 
See Upgrading the Main Firmware, page 148, for details. This page is 
available to the Super Administrator (and Administrators and Users 
with Configuration permission). The icon doesn’t display on the page 
of ordinary administrators and users.

Download: Users with appropriate permission can click this icon to 
download AP versions of the Windows Client; the Java Client; the Log 
Server; and the PON program. This page is available to all users. The 
programs that can be downloaded depend on the user’s permissions.

Icon Function

Click this icon to brings up a panel with information about the KVM 
Over the NETTM switch firmware version.

Click this icon to log out and end your KVM Over the NETTM switch 
session.
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The GUI Main Page

With WinClient AP, and Java Client AP access, once users log in (see Logging 
In, page 37), the GUI Main Page comes up:

The GUI Main Page is similar to that of the Web Browser. The differences 
between them are as follows:

1. The GUI version doesn’t have a menu bar below the tab bar; it has a series 
of tabs like a notebook, instead. Like the Web Browser interface, however, 
the makeup of the tabbed notebook changes depending on the items 
selected on the main Tab Bar and in the Sidebar.

2. The GUI version doesn’t have a Log tab on the icon bar. (It’s Log tab can 
be found in the notebook under the Port Access Tab – see Log, page 98.)

3. In addition to Filter, there are also buttons for Scan and Array Mode at the 
bottom of the Sidebar. These functions are discussed in Chapter 6, Port 
Access.

4. There is a hidden Control Panel at the upper or lower center of the screen 
that becomes visible when you mouse over it. (The default is at the upper 
center of the screen.)
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5. There is an additional icon at the extreme right of the page: . Click this 
icon to close the GUI Main Page and go to the display of the last selected 
port.

6. The GUI can be navigated via the keyboard as shown in the table, below:

Keys Action

Ctrl + P Opens the Port Access page.

Ctrl + U Opens the User Management page.

Ctrl + C Opens the Device Management page.

Ctrl + F Opens the Maintenance page.

Ctrl + D Opens the Download page.

F1 To see About information

F2 To edit the port name of the selected port.

F4 Selects the Sidebar (left) panel.

F5 Selects the main (right) panel

F7 Closes the GUI.

F8 To log out.
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The Local Console GUI Main Page

The Local Console GUI Main Page is similar to the Java and Windows GUI 
Main Page:

The major difference is that the Local Console Main Page doesn’t have tabs for 
Maintenance or Download, and Array Mode isn’t available.

In addition, there are two small icons at the bottom right – as described in the 
following table.

Icon Function

Speaker. Allows sound output from the servers connected to the 
switch’s ports to be heard on the speakers connected to the Local 
Console. Click the icon to toggle speaker support On and Off. When 
Off, a red X displays across the icon.

Microphone. Allows microphone input from the Local Console to be 
sent to the servers connected to the switch’s ports. Click the icon to 
toggle microphone support On and Off. When Off, a red X displays 
across the icon.
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The Control Panel

WinClient Control Panel
Since the WinClient ActiveX Viewer and WinClient AP Control Panel 
contains the most complete functionality of all the user interface control panels, 
this section describes the WinClient Control Panel. Although the other control 
panels may not have all of the features that this one does, you can refer to the 
information described here when using them.

The WinClient Control Panel consists of three rows: a row of icons at the top, 
with two text rows below it:

Note: The above image shows the complete Control Panel. The icons that 
appear can be customized. See Control Panel Configuration, page 78, 
for details.

By default, the top text row shows the video resolution of the remote 
display. As the mouse pointer moves over the icons in the icon bar, 
however, the information in the top text row changes to describe the icon's 
function. In addition, if a message from another user is entered in the 
message board, and you have not opened the message board in your 
session, the message will appear in the top row.
The lower row shows the IP address of the device you are accessing at the 
left. In the center of the bar, the number before the slash indicates which 
bus the user is on, while the number behind the slash indicates the number 
of users on that bus.

Note: See Multiuser Operation, page 163 for further information 
regarding the KVM Over the NETTM switch’s bus assignments.

(Continues on next page.)
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(Continued from previous page.)
Right clicking in the text row area brings up a menu that allows you to 
select options for the Screen Mode, Zoom, Mouse Pointer type, and Mouse 
Sync Mode. These functions are discussed in the sections that follow.

To move the Control Panel to a different location on the screen, place the 
mouse pointer over the text bar area, then click and drag.
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WinClient Control Panel Functions

The Control Panel functions are described in the table below.

Icon Function

This is a toggle. Click to make the Control Panel persistent – i.e., it 
always displays on top of other screen elements. Click again to have 
it display normally.

Click to bring up the Macros dialog box (see page 55 for details).

Click to bring up the Video Options dialog box. Right-click to perform 
a quick Auto Sync (see Video Settings, page 64, for details).

Click to perform a video and mouse autosync operation. It is the 
same as clicking the Auto-sync button in the Video Options dialog 
box (see Video Settings, page 64).

Toggles the display between Full Screen Mode and Windowed Mode.

Click to take a snapshot (screen capture) of the remote display. 
See Snapshot, page 79, for details on configuring the Snapshot 
parameters.

Click to bring up the Message Board (see The Message Board, 
page 67).

Click to send a Ctrl+Alt+Del signal to the remote system.

Click to toggle the remote display between color and gray scale 
views.

Click to bring up the Virtual Media dialog box. The icon changes 
when a virtual media device is started on the port. See Virtual Media, 
page 70, for specific details.
Note: 1. This icon is displayed on the KN2124v, KN2140v, KN4124v 

and KN4140v switches only.
2. This icon displays in gray when the function is disabled or 

not available.

Click to zoom the remote display window.
Note: This feature is only available in windowed mode (Full Screen 
Mode is off). See Zoom, page 73, for details.

Click to bring up the on-screen keyboard (see The On-Screen 
Keyboard, page 74).
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Click to select the mouse pointer type.
Note: This icon changes depending on which mouse pointer type is 

selected (see Mouse Pointer Type, page 75).

Click to toggle Automatic or Manual mouse sync.

When the selection is Automatic, a green √ appears on the icon.

When the selection is Manual, a red X appears on the icon.
See Mouse DynaSync Mode, page 76 for a complete explanation of 
this feature.

Click to toggle sound from the remote server to be heard on the client 
computer’s speakers on or off. The “prohibited” symbol (a red circle 
with a diagonal bar) displays on the icon when the speaker is toggled 
Off.

Click to display a dropdown list of User macros. Access and run 
macros more conveniently rather than using the Macros dialog box 
(see the Macros icon in the table above, and the Macros section on 
page 55).

Click to bring up the Control Panel Configuration dialog box. 
See Control Panel Configuration, page 78, for details on configuring 
the Control Panel.

Click to exit the viewer.

Exiting from a viewer accessed session brings you back to the web 
browser Main Page.

Exiting from a WinClient AP session logs you out and brings you 
back to the login dialog box (see page 39).

Exiting from a Java Client AP session logs you out and closes the 
Java program.

These icons show the Num Lock, Caps Lock, and Scroll Lock status 
of the remote computer.

When the lock state is On, the LED is bright green and the lock 
hasp is closed.

When the lock state is Off, the LED is dull green and the lock hasp 
is open.

Click on the icon to toggle the status.
Note: These icons and your local keyboard icons are in sync. 
Clicking an icon causes the corresponding LED on your keyboard to 
change accordingly. Likewise, pressing a Lock key on your keyboard 
causes the icon’s color to change accordingly.
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Macros
The Macros icon provides access to three functions found in the 
Macros dialog box: Hotkeys, User Macros, and System Macros. Each 

of these functions is described in the following sections.

Hotkeys
Various actions related to manipulating the remote server can be accomplished 
with hotkeys. The Hotkey Setup utility (accessed by clicking this icon), lets you 
configure which hotkeys perform the actions.

The actions are listed in the left panel; the hotkeys that invoke them are shown 
in the panel at the right. Use the checkbox to the left of an action’s name to 
enable or disable its hotkey.

1. Highlight an Action, then click Set Hotkey.

2. Press your selected Function keys (one at a time). The key names appear in 
the Hotkeys field as you press them.

You can use the same function keys for more than one action, as long 
as the key sequence is not the same.
To cancel setting a hotkey value, click Cancel; to clear an action’s 
Hotkeys field, click Clear.

3. When you have finished keying in your sequence, click Save.

To reset all the hotkeys to their default values, click Reset.
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An explanation of the Hotkey actions is given in the table below:

Action Explanation
Exit remote location Breaks the connection to the KVM Over the NETTM switch and 

returns you to local client computer operation. This is equivalent 
to clicking the Exit icon on the Control Panel. The default keys are 
F2, F3, F4.

Adjust Video Brings up the Video Settings dialog box. This is equivalent to 
clicking the Video Settings icon on the Control Panel. The default 
keys are F5, F6, F7.

Toggle OSD Toggles the Control Panel Off and On. The default keys are F3, 
F4, F5.

Toggle mouse 
display

If you find the display of the two mouse pointers (local and 
remote) to be confusing or annoying, you can use this function to 
shrink the non-functioning pointer down to a barely noticeable tiny 
circle, which can be ignored. Since this function is a toggle, use 
the hotkeys again to bring the mouse display back to its original 
configuration. This is equivalent to selecting the Dot pointer type 
from the Mouse Pointer icon on the Control Panel. The default 
keys are F7, F8, F9.
Note: The Java Control Panel does not have this feature.

Adjust mouse This synchronizes the local and remote mouse movements. The 
default keys are F7, F8, F9.

Video Auto-sync This combination performs an auto-sync operation. It is 
equivalent to clicking the Video Autosync icon on the Control 
Panel. The default keys are F6, F7, F8.

Show/Hide Local 
Cursor

Toggles the display of your local mouse pointer off and on. This is 
equivalent to selecting the Null pointer type from the Mouse 
Pointer icon on the Control Panel. The default keys are F4,F5.

Substitute Ctrl key If your local client computer captures Ctrl key combinations, 
preventing them from being sent to the remote server, you can 
implement their effects on the remote server by specifying a 
function key to substitute for the Ctrl key. If you substitute the F11 
key, for example, pressing [F11 + 5] would appear to the remote 
server as [Ctrl + 5]. The default key is F11.

Substitute Alt key Although all other keyboard input is captured and sent to the KVM 
Over the NETTM switch, [Alt + Tab] and [Ctrl + Alt + Del] work on 
your local client computer. In order to implement their effects on 
the remote server, another key may be substituted for the Alt key. 
If you substitute the F12 key, for example, you would use [F12 + 
Tab] and [Ctrl + F12 + Del]. The default key is F11.
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User Macros
User Macros are used to perform specific actions on the remote server. To 
create the macro, do the following:

1. Select User Macros, then click Add.

2. In the dialog box that comes up, replace the “New Macro” text with a 
name of your choice for the macro:
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3. Click Record.
The dialog box disappears, and a small panel appears at the top left of the 
screen:

4. Press the keys for the macro.
To pause macro recording, click Pause. To resume, click Pause again.
Clicking Show brings up a dialog box that lists each keystroke that you 
make, together with the amount of time each one takes:

Clicking Cancel cancels all keystrokes.
When you have finished, click Stop. This is the equivalent of clicking 
Done in Step 5.

Note: 1. Case is not considered – typing A or a has the same effect.

2. When recording the macro the focus must be on the remote screen. It 
cannot be in the macro dialog box.

3. Only the default keyboard characters may be used. Alternate 
characters cannot be used. For example, if the keyboard is Traditional 
Chinese and default character is A the alternate Chinese character 
obtained via keyboard switching is not recorded.
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5. If you haven’t brought up the Show dialog, click Done when you have 
finished recording your macro. You return to the Macros dialog box with 
your system macro key presses displayed in the Macro column:

6. If you want to change any of the keystrokes, select the macro and click 
Edit. This brings up a dialog box similar to the one for Show. You can 
change the content of your keystrokes, change their order, etc.

7. Repeat the procedure for any other macros you wish to create.
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After creating your macros, you can run them in any of three ways:

1. By using the hotkey (if one was assigned).

2. By opening the Macro List on the Control Panel and clicking the one you 
want (see page 54).

3. By opening this dialog box and clicking Play.

If you run the macro from this dialog box, you 
have the option of specifying how the macro runs.

If you choose Play Without Wait, the macro runs the keypresses one after 
another with no time delay between them.
If you choose Play With Time Control, the macro waits for the amount of 
time between key presses that you took when you created it. Click on the 
arrow next to Play to make your choice.
If you click Play without opening the list, the macro runs with the default 
choice. The default choice (NoWait or TimeCtrl), is shown in the Playback 
column.

You can change the default choice by clicking on the current choice 
(NoWait in the screenshot above), and selecting the alternative choice.

Note: 1. Information about the Search function is given on page 61.

2. User Macros are stored on the Local Client computer of each user. 
Therefore there is no limitation on the of number of macros, the size 
of the macro names, or makeup of the hotkey combinations that 
invoke them
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Search
Search, at the bottom of the dialog box, lets you filter the list of macros that 
appear in the large upper panel for you to play or edit. Click a radio button to 
choose whether you want to search by name or by key; key in a string for the 
search; then click Search. All instances that match your search string appear in 
the upper panel.

System Macros
System Macros are used to create exit macros for when you close a session. For 
example, as an added measure of security, you could create a macro that sends 
the Winkey-L combination which would cause the remote server’s log in page 
to come up the next time the device was accessed. To create the macro, do the 
following:

1. Select System Macros, then click Add.

2. In the dialog box that comes up, replace the “New Macro” text with a 
name of your choice for the macro:
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3. Click Record.
The dialog box disappears, and a small panel appears at the top left of the 
screen:

4. Press the keys for the macro.
To pause macro recording, click Pause. To resume, click Pause again.
Clicking Show brings up a dialog box that lists each keystroke that you 
make, together with the amount of time each one takes (see page 62).

Note: 1. Case is not considered – typing A or a has the same effect.

2. When recording the macro the focus must be on the remote screen. It 
cannot be in the macro dialog box.

3. Only the default keyboard characters may be used. Alternate 
characters cannot be used. For example, if the keyboard is Traditional 
Chinese and default character is A the alternate Chinese character 
obtained via keyboard switching is not recorded.

5. If you haven’t brought up the Show dialog, click Done when you have 
finished recording your macro. You return to the Macros dialog box with 
your system macro key presses displayed in the Macro column:

6. If you want to change any of the keystrokes, select the macro and click 
Edit. This brings up a dialog box similar to the one for Show. You can 
change the content of your keystrokes, change their order, etc.
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7. Repeat the procedure for any other macros you wish to create.

Once the system macros have been created, they are available for use on a 
port-by-port basis. They get selected on a port’s Connection page (see Exit 
Macro, page 92, for details).

Note: 1. Information about the Search function is given on page 61.

2. You can choose only one system macro per port.

3. Systems macros are stored on the switch, therefore macro names may 
not exceed 64 Bytes; hotkey combinations may not exceed 256 Bytes; 
each key usually takes 3–5 Bytes.
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Video Settings
Clicking the Hammer icon on the Control Panel brings up the Video 
Settings dialog box. The options in this dialog box allow you to adjust 

the placement and picture quality of the remote screen on your monitor:

The meanings of the video adjustment options are given in the table below:

Options Usage

Screen Position Adjust the horizontal and vertical position of the remote server 
window by Clicking the Arrow buttons.

Auto-Sync Click Auto-Sync to have the vertical and horizontal offset values of 
the remote screen detected and automatically synchronized with the 
local screen.
Note: 1. If the local and remote mouse pointers are out of sync, in 

most cases, performing this function will bring them back 
into sync.

2. This function works best with a bright screen.
3. If you are not satisfied with the results, use the Screen 

Position arrows to position the remote display manually.
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RGB Drag the slider bars to adjust the RGB (Red, Green, Blue) values. 
When an RGB value is increased, the RGB component of the image 
is correspondingly increased.
If you enable Set to Grayscale, the remote video display is changed 
to grayscale.

Gamma This section allows you to adjust the video display's gamma level. 
This function is discussed in detail in the next section, Gamma 
Adjustment.

Network Type Select the type of internet connection that the local client computer 
uses. The switch will use that selection to automatically adjust the 
Video Quality and Detect Tolerance settings to optimize the quality of 
the video display.
Since network conditions vary, if none of the pre-set choices seem to 
work well, you can select Customize and use the Video Quality and 
Detect Tolerance slider bars to adjust the settings to suit your 
conditions.

Video Quality Drag the slider bar to adjust the overall Video Quality. The larger the 
value, the clearer the picture and the more video data goes through 
the network. Depending on the network bandwidth, a high value may 
adversely effect response time.

Enable Refresh The KVM Over the NETTM switch can redraw the screen every 1 to 
99 seconds, eliminating unwanted artifacts from the screen. Select 
Enable Refresh and enter a number from 1 through 99. The KVM 
Over the NETTM switch will redraw the screen at the interval you 
specify. This feature is disabled by default. Click to put a check mark 
in the box next to Enable Refresh to enable this feature.
Note: 1. The switch starts counting the time interval when mouse 

movement stops.
2. Enabling this feature increases the volume of video data 

transmitted over the network. The lower the number 
specified, the more often the video data is transmitted. 
Setting too low a value may adversely affect overall 
operating responsiveness.

Transparency Adjusts the transparency of the Control Panel and other Toolbars. 
Slide the bar until the display in the example window is to your liking.

Color Depth 
Control

This setting determines the richness of the video display by adjusting 
the amount of color information.

Detect 
Tolerance

This setting also relates to video quality. It governs detecting or 
ignoring pixel changes. A high setting can result in a lower quality 
display due to less data transfer. A lower setting will result in better 
video quality, but setting the threshold too low may allow too much 
data to be transferred, negatively impacting network performance.

Options Usage
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Gamma Adjustment
If it is necessary to correct the gamma level for the remote video display, use 
the Gamma function of the Video Adjustment dialog box.

Under Basic configuration, there are ten preset and four user-defined levels 
to choose from. Drop down the list box and choose the most suitable one.
For greater control, clicking the Advanced button brings up the following 
dialog box:

Click and drag the diagonal line at as many points as you wish to achieve 
the display output you desire.
Click Save As to save up to four user-defined configurations derived from 
this method. Saved configurations can be recalled from the list box at a 
future time.
Click Reset to abandon any changes and return the gamma line to its 
original diagonal position.
Click OK to save your changes and close the dialog box.
Click Cancel to abandon your changes and close the dialog box.

Note: For best results, change the gamma while viewing a remote server.
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The Message Board
The KVM Over the NETTM switch supports multiple user logins, 
which can possibly give rise to access conflicts. To alleviate this 

problem, a message board feature has been provided, allowing users to 
communicate with each other:
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Button Bar
The buttons on the Button Bar are toggles. Their actions are described in the 
table below:

Message Display Panel
Messages that users post to the board - as well as system messages - display in 
this panel. If you disable Chat, however, messages that get posted to the board 
won't appear.

Compose Panel
Key in the messages that you want to post to the board in this panel. Click 
Send, or press [Enter] to post the message to the board.

Button Action

Enable/Disable Chat. When disabled, messages posted to the board 
are not displayed. The button is shadowed when Chat is disabled. The 
icon displays next to the user's name in the User List panel when the 
user has disabled Chat.

Occupy/Release Keyboard/Video/Mouse. When a port is set to 
Occupy mode (see Access Mode, page 87), you can use this button to 
occupy the KVM. When you Occupy the KVM, other users cannot see 
the video, and cannot input keyboard or mouse data. The button is 
shadowed when the KVM is occupied. The icon displays next to the 
user's name in the User List panel when the user has occupied the 
KVM.

Occupy/Release Keyboard/Mouse. When a port is set to Occupy 
mode (see Access Mode, page 87), you can use this button to occupy 
the KM. When you Occupy the KM, other users can see the video, but 
cannot input keyboard or mouse data. The button is shadowed when 
the KM is occupied. The icon displays next to the user's name in the 
User List panel when the user has occupied the KM.

Show/Hide User List. When you Hide the User List, the User List 
panel closes. The button is shadowed when the User List is open.
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User List Panel
The names of all the logged in users are listed in this panel.

Your name appears in blue; other users' names appear in black.
By default, messages are posted to all users. To post a message to one 
individual user, select the user's name before sending your message.
If a user's name is selected, and you want to post a message to all users, 
select All Users before sending your message.
If a user has disabled Chat, its icon displays before the user's name to 
indicate so.
If a user has occupied the KVM or the KM, its icon displays before the 
user's name to indicate so.
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Virtual Media
The Virtual Media feature allows a drive, folder, image file, or 
removable disk on a user’s system to appear and act as if it were 

installed on the remote server.

Note: Virtual Media is only supported on remote servers connected to the 
KVM Over the NETTM switch with KA7175 or KA7176 adapter cables.

To implement this redirection feature, do the following:

1. Click this icon to bring up the Virtual Media dialog box:.

Note: The T button at the top right brings up a slider to adjust the 
transparency of the dialog box. After making your adjustment, click 
anywhere in the dialog box to dismiss the slider.

2. Click Add; then select the media source.

Depending on your selection, additional dialog boxes appear to enable you 
to select the drive, file, folder, or removable disk you desire. See Virtual 
Media Support, page 229 for details about mounting each of these media 
types.
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3. To add additional media sources, click Add, and select the source as many 
times as you require.
Up to three virtual media choices can be mounted. The top three in the list 
are the ones that are selected. To rearrange the selection order, highlight 
the device you want to move, then click the Up or Down Arrow button to 
promote or demote it in the list.

4. Read refers to the redirected device being able to send data to the remote 
server; Write refers to the redirected device being able to have data from 
the remote server written to it. The default is for Write to not be enabled 
(Read only). If you want the redirected device to be writable as well as 
readable, click to put a check in the Enable Write checkbox:

Note: 1. If a redirected device cannot be written to, it appears in gray in the 
list.

2. See Virtual Media Support, page 229, for a list of supported 
virtual media types.

3. To remove an entry from the list, select it and click Remove.

4. After you have made your media source selections, click Mount. The 
dialog box closes. The virtual media devices that you have selected are 
redirected to the remote server, where they show up as drives, files and 
folders on the remote server’s file system.
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Once mounted, you can treat the virtual media as if they were really on the 
remote server – drag and drop files to/from them; open files on the remote 
server for editing and save them to the redirected media, etc.

Files that you save to the redirected media, will actually be saved on your 
local client computer’s storage. Files that you drag from the redirected 
media will actually come from your local client computer’s storage.

5. To end the redirection, bring up the Control Panel and click on the Virtual 
Media icon. All mounted devices are automatically unmounted.

Virtual Media Icons
The Virtual Media icon on the Windows Client Control Panel changes, 
depending on the type of drive used, as shown in the table below:

Icon Function

The icon displays in gray to indicate that the virtual media function is 
disabled or not available

The icon displays in blue to indicate that the virtual media function is 
available. Click the icon to bring up the virtual media dialog box.

The icon displays in blue with a red X to indicate that a virtual media 
device has been mounted on the remote server. Click the icon to 
unmount all redirected devices.
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Zoom
The Zoom icon controls the zoom factor for the remote view window. 
Settings are as follows:

Setting Description

100% Sizes and displays the remote view window at 100%.

75% Sizes and displays the remote view window at 75%.

50% Sizes and displays the remote view window at 50%.

25% Sizes and displays the remote view window at 25%.

1:1 Sizes and displays the remote view window at 100%. The difference 
between this setting and the 100% setting is that when the remote 
view window is resized its contents don’t resize – they remain at the 
size they were. To see any objects that are outside of the viewing 
area move the mouse to the window edge, to have the screen scroll.
Note: The 1:1 Zoom size is not available in the Java Applet Viewer 
or the Java Client AP.
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The On-Screen Keyboard
The KVM Over the NETTM switch supports an on-screen keyboard, 
available in multiple languages, with all the standard keys for each 

supported language. Click this icon to pop up the on-screen keyboard:

One of the major advantages of the on-screen keyboard is that if the keyboard 
languages of the remote and local systems aren’t the same, you don’t have to 
change the configuration settings for either system. The user just has to bring 
up the on-screen keyboard; select the language used by the server on the port 
he is accessing; and use the on-screen keyboard to communicate with it.

Note: You must use your mouse to click on the keys. You cannot use your 
actual keyboard.

To change languages, do the following:

1. Click the down arrow next to the currently selected language, to drop 
down the language list.

2. Select the new language from the list.
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To display/hide the expanded keyboard keys, click the arrow to the right of the 
language list arrow.

Mouse Pointer Type
KVM Over the NETTM switches offer a number of mouse pointer 
options when working in the remote display. Click this icon to select 

from the available choices:

Note: 1. Before accessing a port, only Dual and Crosshairs are available. Once 
the port is accessed, all four pointers are available.

2. The icon on the Control Panel changes to match your choice.

3. Selecting the Dot pointer has the same effect as the Toggle mouse 
display hotkey function (see Toggle mouse display, page 56, for 
details).

4. The Dot pointer is not available with the Java Applet Viewer or the 
Java Client AP.
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Mouse DynaSync Mode
Synchronization of the local and remote mouse pointers is 
accomplished either automatically or manually.

Automatic Mouse Synchronization (DynaSync)
Mouse DynaSync provides automatic locked-in synching of the remote and 
local mouse pointers – eliminating the need to constantly resync the two 
movements.

Note: This feature is only available for Windows and Mac systems (G4 and 
higher) whose adapter attribute OS setting is configured for Win or Mac 
(see Port Properties, page 86), which are connected to the switch with 
one of the following Adapter Cables: KA7170, KA7175, KA7176, or 
KA9170.

All other configurations must use manual mouse synchronization 
(described in the next section).

The icon on the toolbar indicates the synchronization mode status as follows:

When Mouse DynaSync is available, clicking the icon toggles its status 
between enabled and /disabled. If you choose to disable Mouse DynaSync 
mode, you must use the manual synching procedures described in the next 
section.

Icon Function

This icon displays in gray to indicate that Mouse DynaSync is not 
available – you must use manual synching procedures. This is the 
default setting for all KVM Adapters other than the KA7170, 
KA7175, KA7176, and KA9170.

The green check mark on this icon indicates that Mouse DynaSync 
is available and is enabled. This is the default setting when Mouse 
DynaSync is available. (See the Note, above.)

The red X on this icon indicates that Mouse DynaSync is available 
but is not enabled.
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Mac and Linux Considerations
For Mac systems, there is a second DynaSync setting to choose from when 
Mouse DynaSync is enabled. If the default synchronization result is not 
satisfactory, try the Mac 2 setting. To select Mac 2, right click in the text area 
of the Control Panel and select Mouse Sync Mode → Automatic for Mac 2:

Linux doesn’t support DynaSync Mode, but it has an additional setting on the 
Mouse Sync Mode menu (Redhat AS3.0). If you are using one of the USB 
Adapter Cables (see the Note on the previous page), and the default mouse 
synchronization is not satisfactory, you can try the Redhat AS3.0 setting. In 
either case, you must perform the manual mouse synchronization procedures 
described in the next section.

Manual Mouse Synchronization
If the local mouse pointer goes out of sync with the remote system's mouse 
pointer there are a number of methods to bring them back into sync:

1. Perform a video and mouse auto sync by clicking the Video Settings icon 
on the Control Panel (see page 64).

2. Perform an Auto Sync with the Video Adjustment function (see Video 
Settings, page 64, for details).

3. Invoke the Adjust Mouse function with the Adjust Mouse hotkeys (see 
Adjust mouse, page 56, for details).

4. Move the pointer into all 4 corners of the screen (in any order).

5. Drag the Control Panel to a different position on the screen.

6. Set the mouse speed and acceleration for each problematic server attached 
to the switch. See Additional Mouse Synchronization Procedures, 
page 216, for instructions.
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Control Panel Configuration
Clicking the Control Panel icon brings up a dialog box that allows you to 
configure the items that appear on the Control Panel, as well as its graphical 
settings:

The dialog box is organized into six main sections as described in the table, 
below:

(Continues on next page.)

Item Description

Customize 
Control Panel

Allows you to select which icons display in the Control Panel

Control Panel 
Style

Enabling Transparent makes the Control Panel semi-transparent, 
so that you can see through it to the display underneath.

Enabling Icon causes the Control Panel to display as an icon until 
you mouse over it. When you mouse over the icon, the full panel 
comes up.
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(Continued from previous page.)

Item Description

Screen Options If Full Screen Mode is enabled, the remote display fills the entire 
screen.

If Full Screen Mode is not enabled, the remote display appears as 
a window on the local desktop. If the remote screen is larger than 
what is able to fit in the window, move the mouse pointer to the 
screen border that is closest to the area you want to view and the 
screen will scroll.

If Keep Screen Size is enabled, the remote screen is not resized.

If the remote resolution is smaller than that of the local monitor, 
its display appears like a window centered on the screen.

If the remote resolution is larger than that of the local monitor, 
its display is centered on the screen. To access the areas that 
are off screen, move the mouse to the corner of the screen that 
is closest to the area you want to view and the screen will 
scroll.

If Keep Screen Size is not enabled, the remote screen is resized to 
fit the local monitor's resolution.

Bus Info If Bus Info is enabled, the number of the bus you are on, as well as 
the total number of users on the bus, displays on the bottom row 
center of the Control Panel as follows: Bus No./Total Users. (See the 
Control Panel diagram on page 51 for an example.)

Snapshot These settings let the user configure the KN2124v / KN2140v / 
KN4124v / KN4140v / KN2132 / KN4116 / KN4132’s screen capture 
parameters (see the Snapshot description under The Control Panel, 
page 51):

Path lets you select a directory that the captured screens 
automatically get saved to. Click Browse; navigate to the directory 
of your choice; then click OK. If you don’t specify a directory here, 
the snapshot is saved to your desktop.

Click a radio button to choose whether you want the captured 
screen to be saved as a BMP or a JPEG (JPG) file.

If you choose JPEG, you can select the quality of the captured file 
with the slider bar. The higher the quality, the better looking the 
image, but the larger the file size.

Keyboard Pass 
Through

When this is enabled, the Alt-Tab key press is passed to the remote 
server and affect that server. If it is not enabled, Alt-Tab acts on your 
local client computer.
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The Java Control Panel
The Java Applet Viewer and Java Client AP Control Panel is similar to the one 
used by the WinClient:

The major differences between them are:
In the Macros dialog box, Toggle Mouse Display is not available.
The Dot mouse pointer type is not available.
The 1:1 Zoom feature is not available.
The Message Board:

There is no Show/Hide button to show or 
hide the user list. This function is 
achieved by clicking the arrows at the 
top of the bar that separates the User List 
panel from the Main panel.
If another user sends a message to the 
message board and your message board is not open, instead of the 
message appearing in the text bar, a window showing the message pops 
up on your screen.

In Virtual Media, only ISO and Folder are supported. See Java Applet 
Viewer / Java Client AP, page 229 for further details.
The Control Panel Lock LED icons are not in sync with your keyboard. 
When you first connect, the LED display may not be accurate. To be sure, 
click on the LED icons to set them.
In Control Panel Configuration, the following functions are not available: 
the Transparent control panel style; Screen Options; and Keyboard 
Passthrough. The BMP Snapshot format has been replaced by PNG.
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Chapter 6
Port Access

Overview

When you log in to the switch the Port Access page comes up with the 
Connections page displayed.
Web Browser Interface

GUI Interface
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The page is organized into several main areas. All the ports that a user is 
permitted to access are listed in the Sidebar at the left of the page. At the bottom 
of the Sidebar, there are buttons for different port display functions.

The tabs at the top of the main panel open different pages for information and 
configuration options related to the ports. The main panel provides a detailed 
listing of each port, as well as a means of accessing the ports.
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The Port Selection Sidebar

All switches and their ports – including cascaded switches and their ports – are 
listed in a tree structure in the Sidebar at the left of the screen:

The Port Selection Tree
Users are only allowed to see the switches and ports that they have access 
permission for.
Ports and child switches can be nested under their parent switches. Click 
the + in front of a switch to expand the tree and see the ports nested 
underneath it. Click the - to collapse the tree and hide the nested ports.
A port’s ID number is displayed in brackets next to the port icon. For 
convenience the ports can be named (see Port Naming, page 88, for 
details).
Switches and ports that are on line have their monitor screen icons lit 
green; the monitor screens are gray for devices and ports that are offline.
To access a port, double click its icon. Port operation details are discussed 
in Chapter 11, Port Operation.
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Port Views
In the Web Browser version, you can open as many port viewers as there are 
ports, but the number of ports that you see depends on the number of buses that 
the switch supports. For example, if the switch supports 4 buses, the 5th viewer 
displays the same port as the 1st viewer; the 6th viewer displays the same 
screen as the 2nd viewer, etc.

In the GUI version you can only access one port at a time. To see two different 
ports, you would have to log in two separate times.

Port Utilities
The GUI version Port Access page provides a convenient method to 
manipulate the device tree. When you right click an item in the Sidebar, a list 
with various options pops up:

Note: The screenshot shows an example of just one of the pop-ups that can 
appear. The items that you see depend on whether you are logged in 
from a Local Console, or remotely; your user type; and whether you 
selected a switch or a port. The table below lists and explains all of the 
possibilities.

kn2124v-4132.book  Page 84  Tuesday, January 12, 2010  5:08 PM



 Chapter 6. Port Access

85

The meanings of the pop-up items are explained in the following table:

Item User Type Explanation

Expand/
Collapse

Administrators
Users

If the device’s ports are nested (not displayed), 
the dialog box entry is Expand. Click Expand to 
open the tree and display the ports.

If the device’s ports are displayed, the dialog box 
entry is Collapse. Click Collapse to nest the 
ports.

Note: 1. This item only appears for switches or 
ports that have child devices connected to 
them.

2. This has the same effect as clicking the + 
or - in the tree view.

Rename Administrators
Users

For convenience – especially in large installations 
with many switches and ports – each switch and 
each port can be given a name. See Port Naming, 
page 88, for details.

Copy Administrators
Users

This item is only available for ports. After selecting 
Copy, you can Paste the port into the Favorites 
page. See Adding a Favorite, page 94, for details.

Properties Administrators This item allows you to configure the properties for 
a switch or port.

For switches, clicking this item takes you to the 
Device Management page. See Device 
Management, page 121, for configuration details.

For ports, a dialog box opens allowing you to 
make configuration settings for that port. 
See Port Properties, page 86, for details.

Export 
Configuration

Administrators This item is only available through a remote login 
and is only available for switches. It allows you to 
save the configuration settings for the switch in an 
external file (SysConfig.cfg). Simply click Export 
Config; browse to where you want to save the file; 
then click Save.

Import 
Configuration

Administrators This item is only available through a remote login 
and is only available for switches. It imports 
previously saved configuration settings. Click 
Import Config. In the dialog box that comes up, 
browse to where the saved configuration file is 
located; select the setting components you wish to 
import; then click Import.

Mount Administrators
Users

This item is only available through a Local Console 
login. It appears when a USB device is plugged into 
the switch’s USB port and allows you to mount the 
device and make it available to users logged into 
the installation.
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Port Properties
When you select Properties from the popup menu, a dialog box that allows 
you to make configuration settings for the selected port appears:

Note: This is a quick setting method that performs the same port configuration 
functions as the ones found under Adapter Attributes on the Device 
Management Customization page. See Customization, page 138, for 
details.

(Continues on next page.)
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(Continued from previous page.)

An explanation of the configuration fields is given in the table, below:

After making your configuration choices, click Save to save your new settings 
and close the dialog box.

Field Explanation

Port OS Specifies the operating system that the server on the connected 
port is using. Choices are Win, Mac, Sun, and Other. The default 
is Win.

OS Language Specifies the OS language being used by the server on the 
connected port. Drop down the list to see the available choices. 
The default is English US.

Cable Length Specifies the length of the Cat5e cable that is used to connect 
the server to the port. Choices are Short (less than 10 m), 
Medium (10–25 m), and Long (greater than 25 m). The default is 
Short.
Note: Cable length can affect video quality. Generally speaking, 
shorter cables offer better quality. This setting is designed to 
compensate for longer or shorter cable lengths. You can 
experiment to find the setting that best suits your connection.

Access Mode Defines how the port is to be accessed when multiple users have 
logged on, as follows:
Exclusive: The first user to switch to the port has exclusive 

control over the port. No other users can view the port. The 
Timeout function does not apply to ports which have this 
setting.

Occupy: The first user to switch to the port has control over the 
port. However, additional users may view the port’s video 
display. If the user who controls the port is inactive for longer 
than the time set in the Timeout box, port control is transferred 
to the next user to move the mouse or strike the keyboard.

Share: Users simultaneously share control over the port. Input 
from the users is placed in a queue and executed 
chronologically. Under these circumstances, users can take 
advantage of the Message Board, which allows a user to take 
control of the keyboard and mouse or keyboard, mouse, and 
video of a Share port (see The Message Board, page 67).

Timeout This field sets a time threshold for users on ports whose Access 
Mode has been set to Occupy (see Access Mode – above, in this 
table). If there is no activity from the user occupying the port for 
the amount of time set here, the user is timed out and the port is 
released. The first user to send keyboard or mouse input after 
the port has been released gets to occupy the port.
Input a value from 0 to 255 seconds. The default is 3 seconds. A 
setting of 0 causes the port to be released the instant there is no 
input.
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Port Naming
For convenience – especially in large installations with many switches and 
ports – each switch and each port can be given a name. To assign, modify or 
delete a port name, do the following:

1. Click once on the port you want to edit; wait a second; then click again.

Note: 1. This is not a double-click. It involves two separate clicks. A 
double-click will switch you to the device attached to the port.

2. In the GUI version you can right click on the port you want to edit, 
then select Rename in the popup box that appears.

– or –

Press F2
After a second or two, the port field changes to provide a text input box:

2. Key in a name for the port (or change/delete a previous one). The 
maximum number of characters allowed for a port name is 20. You can use 
any combination of letters, numbers, and symbols on the typewriter keys 
of keyboards with PC US English layout.

kn2124v-4132.book  Page 88  Tuesday, January 12, 2010  5:08 PM



 Chapter 6. Port Access

89

3. When you have finished editing the port name, press [Enter] or click 
anywhere outside of the input box to complete the operation.

Scan
Scan is found at the bottom of the GUI Sidebar. It automatically switches 
among all the ports that are visible in the Sidebar tree (see Filter, below), at 
regular intervals, so that their activity can be monitored automatically. 
See Auto Scanning, page 158 for details.

Note: This item doesn’t appear at the bottom of the Sidebar in the Web 
Browser version. You must invoke it from the port’s Toolbar. See The 
Port Toolbar, page 156, for details.

Array
Array is found at the bottom of the GUI Sidebar. It represents another way of 
monitoring port activity. Under this function your screen is divided into a grid 
of panels, with each panel representing. Only ports that are visible in the 
Sidebar tree (see Filter, below), and that are on line are displayed – all other 
ports are blank. See Panel Array Mode, page 161, for details.

Note: This item doesn’t appear at the bottom of the Sidebar in the Web 
Browser version. You must invoke it from the port’s Toolbar. See The 
Port Toolbar, page 156, for details.
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Filter
Filter allows you to control the number and type of ports that display in the 
Sidebar Tree, as well as which ports get scanned when Auto Scan and Array 
Mode is invoked (see Scan and Array, above). When you click Filter, the 
bottom of the panel changes to look similar to the figure, below:

The meanings of the choices are explained in the table, below:

Choices Explanation

All This is the default view. With no other filter options selected, 
all of the ports that are accessible to the user are listed in the 
Sidebar tree.
If any Favorites have been specified (see page 94), you can 
drop down the list box and select Favorites instead of All. If 
you select Favorites, only the items you have selected as 
Favorites display in the tree.

Powered On If you enable Powered On (by putting a check in the 
checkbox) only the ports that have their attached devices 
powered on display in the tree.

Search If you key in a search string and click Search, only port names 
that match the search string display in the tree. Wildcards (? 
and *) are acceptable, so that more than one port can show up 
in the list. For example, if you key in Web*, both Web Server 1 
and Web Server 2 show up in the list.

Exit Clicking Exit closes the filter dialog.
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Connections

The Connections page displays port status information at the device level, and 
port connection configuration options at the port level.

Device Level
When a KVM Over the NETTM switch is selected in the Sidebar tree, the 
Connections page displays a list of ports for the device that the user is 
authorized to access or view.

The following attributes are listed for each device:
Port Number – the port’s number on the switch.
Port Name – if a name has been assigned to a port it displays here.
Device Name – if a name has been assigned to a switch it displays here.
Status – the current status of the switch – online, or offline.
Operation – Connect means you can access the port by double clicking 
anywhere on its line entry.

Note: In the Web Browser version, the sort order of the information displayed 
can be changed by clicking the column headings.
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Port Level
When a port is selected in the Sidebar tree, the Connections page changes to 
display the port connection and configuration options:

The screen is divided into three major panels, as described in the table below:

Panel Description

Status The Status Panel displays the port’s current status 
information, including whether the port is online or offline, and 
if the port is mountable.
Click the Connect button to view the port display via the 
switch’s built-in Win Viewer (when using Windows Internet 
Explorer), or Java Viewer (when using other web browsers).

Associated Link The Associated Link Panel provides a method of associating 
other ports on the same switch to the selected port. This 
function is primarily intended to be used when connecting 
both KVM and serial ports (KA7140, KA9140) from a single 
server to the switch. Click Add to add a desired associated 
port. To remove an unwanted associated port, select it and 
click Remove. To connect to a port, select it, and click 
Connect.

Exit Macro The Exit Macro Panel contains a dropdown listbox of System 
macros. You can select a macro from the list that will execute 
when exiting the port. See System Macros, page 61 for details 
on creating exit macros.
The macro only executes after the last user accessing the port 
exits the port.
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History

The History page provides a record of each time that a port was accessed.

If there are more entries than there is room on the screen, a scroll bar 
appears to let you scroll up and down to see the entire record.
To clear the record and start over, click the Clear History button at the 
bottom right of the page.

Note: 1. In the Web Browser version, the sort order of the information 
displayed can be changed by clicking the column headings.

2. You can access a port by double clicking it.
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Favorites

The Favorites page is similar to a bookmarks feature. Ports that you frequently 
visit can be saved in a list here. Simply open this page and select the port – 
rather than hunting for it in the Sidebar tree. This feature is especially handy on 
large, crowded installations:

Note: This feature is only available in the GUI version.

Adding a Favorite
To add a port to the favorites, do the following:

1. Right click in the main panel; click Add Favorite.
An Untitled Favorite entry is appears at the top of the panel.

This will be a container to hold your port entries, so you will want to give 
it an appropriate name.
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2. Click inside the text entry box to erase Untitled Favorite and key in an 
appropriate name.

3. To add a port:
Drag it from the Sidebar and drop it onto the container, or Right Click on it 
in the Sidebar; select Copy. Right click on the container; select Paste.

The switch that the port belongs to is added to the container; the selected 
port is appended under the switch.

Note: To add multiple ports at the same time, hold the Shift or Ctrl key 
down while you make your Sidebar selections then drag or copy the 
entire group to the Favorites panel.

4. Repeat step 3 for any other Favorite categories you wish to create

Note: Favorites can be selected for filtering in the Sidebar tree. See Filter, 
page 90, for details.

Modifying a Favorite
To modify a Favorite, or one of the items contained in it, right click on it, 
then select a choice from the popup menu that appears.
To simply edit a Favorite’s name, click on it once, wait a second, then click 
again. You can edit the name after the display changes to provide a text 
input box, This is the same procedure as the one described for port naming 
(see Port Naming, page 88).
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User Preferences

The User Preferences page allows users to set up their own, individual, 
working environments. The switch stores a separate configuration record for 
each user profile, and sets up the working configuration according to the 
Username that was keyed into the Login dialog box:

The page settings are explained in the following table:

(Continues on next page.)

Setting Function

Language Selects the language that the interface displays in.

OSD Hotkey Selects which Hotkey controls the GUI function: [Scroll Lock] 
[Scroll Lock], or [Ctrl] [Ctrl]. Since the Ctrl key combination may 
conflict with programs running on the local client computers or 
servers, the default is the Scroll Lock combination.

ID Display Selects how the Port ID is displayed: the Port Number alone 
(PORT NUMBER); the Port Name alone (PORT NAME); or the 
Port Number plus the Port Name (PORT NUMBER + PORT 
NAME). The default is PORT NUMBER + PORT NAME.
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(Continued from previous page.)

* This item is only available with the Web Browser version.

Setting Function

ID Duration Determines how long a Port ID displays on the monitor after a 
port change has taken place. You can choose an amount from 
1—255 seconds. The default is 3 Seconds. A setting of 0 (zero) 
means the Port ID is always on.

Scan Duration Determines how long the focus dwells on each port as it cycles 
through the selected ports in Auto Scan Mode (see Auto 
Scanning, page 158). Key in a value from 1—255 seconds. The 
default is 5 seconds; a setting of 0 disables the Scan function.

Screen Blanker If there is no input from the console for the amount of time set 
with this function, the screen is blanked. Key in a value from 1—
30 minutes. A setting of 0 disables this function. The default is 0 
(disabled).
Note: Although this function can be set from either the local 
console or a remote login, it only affects the local console 
monitor.

Logout Timeout If there is no user input for the amount of time set with this 
function, the user is automatically logged out. A login is 
necessary before the KVM Over the NETTM switch can be 
accessed again.

Beeper When set to ON, the beeper sounds whenever a Port is 
changed; when activating the Auto Scan function (see Auto 
Scanning, page 158); or if only a single power line is connected 
(or only a single power switch is On) – see Device Information, 
page 122. The default is ON.

Viewer* You can choose which viewer is used when accessing a server:

Auto Detect will select the appropriate viewer based on the 
web browser used; WinClient for Windows Internet Explorer, 
Java Client for other web browsers (ex. Firefox).

Java Client will open the Java based viewer regardless of the 
web browser being used.

Welcome Message* You can choose to hide or show the welcome message 
displayed in the submenu bar. The default is disabled.

Save Click Save to save any changes made to the User Preferences 
settings.

Changing a 
Password

To change a user’s password, key in the old password and new 
password into the input boxes, then click Change Password to 
apply the change.
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Log

The KVM Over the NETTM switch logs all the events that take place on it. The 
Log page displays the information in the log file:

Note: 1. The screenshot displays an GUI version screen. In the Web Browser 
version, Log appears as a separate icon on the Icon Tab Bar.

2. The Log tab only appears for administrators and users who have been 
given permission to view the log file (see Access, page 101). It isn’t 
available for other users.

The log file tracks a maximum of 2048 events. When the limit is reached, 
the oldest events get discarded as new events come in.
Clicking Pause stops the display of new events; the button changes to 
Resume. Click Resume to start displaying events again.
To clear the log file, click the Clear Log icon.
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Filter
Filter allows you to search for particular events by date or by specific words or 
strings. When you access this function, the log filter dialog box displays at the 
bottom of the page:

A description of the items is given in the table, below:

Item Description

Priority Sets the level for how detailed the filter results display should be.

Start Date/Time Put a check in the checkbox to bring up a calendar. Set the date 
and time that you want the filtering to start from. All events from 
the Start date/time to the End date/time are displayed.

End Date/Time Put a check in the checkbox to bring up a calendar. Set the date 
and time that you want the filtering to end at. All events from the 
Start date/time to the End date/time are displayed.

Today Only Only the events for the current day are displayed.

Pattern Key in the pattern that you are filtering for here. Wildcards (? and 
*) are supported. E.g., h*ds would match hands and hoods.

Apply Starts the procedure; filters the events according to the criteria 
you specified; and returns the results.

Reset Click this button to clear the entries in the dialog box and start 
with a clean slate.

Exit Click this button to exit the log filter function.
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Sessions

The Session page lets the administrator see at a glance all the users currently 
logged into the KVM Over the NETTM switch, and provides information about 
each of their sessions.

Note: 1. The Session page only appears in Administrator sessions. It isn’t 
available for ordinary users.

2. The Category heading lists the type of user who has logged in: SA 
(Super Administrator); Admin (Administrator); Normal user (User).

The meanings of the headings at the top of the page are fairly straightforward. 
The IP heading refers to the IP address that the user has logged in from; the 
Device and Port headings show which device and port the user is currently 
accessing. The Bus ID refers to the bus that the user is currently on (Bus 0 refers 
to the Local Console’s bus). 

Note: 1. In the Web Browser version, the sort order of the information 
displayed can be changed by clicking the column headings.

2. The Bus ID also displays on the control panel (see page 51).

3. See Users and Buses, page 164 for information about users and 
buses.

This page also gives the administrator the option of forcing a user logout by 
selecting the user and clicking End Session.
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Access

Administrators use the Access page to set user and group access and 
configuration rights for switches and ports. The page is organized into three 
main areas: a large Main panel; a Status panel at the lower left, and a Properties 
panel at the lower right.

Note: The Access tab only appears in Administrator sessions. It isn’t available 
for ordinary users.

Device Level
If a switch is chosen in the Sidebar Tree, the Main panel looks similar to the 
one shown below:

The main panel consists of three columns: Name, Config, and View Log:
Name lists all the users and groups that have been created. 
Config indicates the users who have Configuration privileges. A check 
mark ( √ ) indicates that the user has permission to make changes to the 
switch configuration settings (see Chapter 8, Device Management); an X 
means that the user is denied permission to make configuration changes. 
Click the icon to toggle permission for Administrators and Users (Super 
Administrators always have configuration privileges).
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View Log indicates the users who have permission to view the log files. A 
check mark ( √ ) indicates that the user has permission to view the files; an 
X means that the user is denied permission to view them. Click the icon to 
toggle permission.
The panels at the bottom of the page are inactive except for the Timeout 
field. This field sets a time threshold for users on ports whose Access 
Mode has been set to Occupy. See Timeout, page 87, for details.

Port Level
If a port is chosen in the Sidebar Tree, the Main panel looks similar to the one 
shown below:

Name lists all the users and groups that have been created. 
Access displays the access rights of the users and groups for each port, as 
shown in the table below.

Full Access: The user can view the remote screen and can perform 
operations on the remote server from his keyboard and monitor.

View Only: The user can only view the remote screen; he cannot 
perform any operations on it.

No Access: No port access. The Port will not show up on the User's list 
on the Main Screen.
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Mount USB indicates users who have permission to mount Virtual Media 
devices on remote servers. A check mark ( √ ) indicates that a user has 
permission; an X means the user does not have permission.

Note: This entry does not appear for switches that do not support the USB 
Virtual Media function (KN2132, KN4116, KN4132).

The Status Panel
The Status panel provides information about the online status of a selected port, 
and the KVM Adapter cable attached to it:

Note: This panel is inactive when a switch is selected in the Sidebar.

The Properties Panel
For convenience, the Properties panel offers an additional input method to 
make configuration settings for the selected port.

These port properties settings are the same as the ones that were discussed 
earlier in this chapter. Refer back to Port Properties, page 86 for setting details.

Saving Changes
Click the Save button at the lower right corner of the page to save any changes 
made on the Access page.
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This Page Intentionally Left Blank
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Chapter 7
User Management

Overview

When you select the User Management tab the screen comes up with the Users 
page displayed:

Web Browser Interface

GUI Interface
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The page is organized into two main areas. All users and groups appear in the 
panel at the left of the page. The large panel at the right provides more detailed 
information at-a-glance for each.

There is a pre-installed super administrator account. It can be used to set 
up the switch and to begin creating users and groups. The Username for 
this account is administrator; the password is password. For security 
purposes, we strongly recommend changing these to something unique.
When using the GUI Interface, the section located below the Sidebar Users 
and Groups list provides a filter that allows you to manage the Sidebar list:

Click the arrow at the right of the list box to select whether you want to 
view only Users, only, Groups, or both Users and Groups.
Click to put a check in the Active checkbox to filter out any users 
whose accounts are not active.
To only select Users or Groups that match a particular string, key it 
into the text box in front of the Go button, then click Go. Only Users or 
Groups that match the string will display. Wildcards (? and *) are 
acceptable.

The Web version has separate menu bar entries for Accounts (Users) and 
Groups.
In the Web version, the sort order of the information displayed can be 
changed by clicking the column headings.
The buttons below the main panel are used in managing users and groups, 
as shown in the sections that follow.
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Users

Adding Users
To add a user, do the following:

1. Select Users in the Sidebar.

2. Click Add at the bottom of the main panel. The User notebook opens, with 
the User tab selected:

3. Enter the required information in the appropriate fields. A description of 
each of the fields is given in the table below:
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(Continues on next page.)

Field Description

Username From 1 to16 characters are allowed depending on the 
Account Policy settings. See Account Policy, page 136.

Password From 0 to16 characters are allowed depending on the 
Account Policy settings. See Account Policy, page 136.

Confirm Password To be sure there is no mistake in the password, you are 
asked to enter it again. The two entries must match.

Description Additional information about the user that you may wish to 
include.

Role There are three categories: Super Administrator, 
Administrator and User. There is no limitation on the number 
of accounts that can be created in each category.

The super administrator is responsible for the overall 
installation configuration and maintenance; user 
management; and device and port assignments.

Administrators have user management privileges. They 
can also access the ports and devices assigned to them 
by the super administrator.

Users can access the ports and devices assigned to them 
by the super administrator.
Note: By default the User account is inactive. The user 
will not be able to log in until you give him any of the 
available permissions (see below).

Permissions Super administrators and administrators automatically have 
Windows Client, Java Client, and Power Management 
permissions. Permissions and restrictions for ordinary users 
are set individually by checking the appropriate boxes, as 
follows:

Windows Client allows a user to download the Windows 
Client software, and access the switch with it, in addition 
to (or instead of) the browser access method.

Java Client allows a user to download the Java Client 
software, and access the KVM Over the NETTM switch 
with it, in addition to (or instead of) the browser access 
method.

View Only limits users to only being able to view the 
display of connected devices. They cannot control port 
access, nor can they input any keyboard or mouse signals 
to the devices they view.

Power Management allows a User to connect to Power on 
the Net™ devices.

Force to Grayscale forces the user’s view of the remote 
display to be in grayscale. This can speed up I/O transfer 
in low bandwidth situations.
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(Continued from previous page.)

4. At this point you can assign the new user to a group by selecting the 
Groups tab – the Groups page is discussed on page 114. You can also 
assign the user’s port access rights by selecting the Devices tab – the 
Devices page is discussed on page 118. 

Note: Optionally, you can skip this step now to add more users and create 
groups, and come back to it later.

5. When your selections have been made click Save.

6. When the Operation Succeeded message appears, click OK.

Field Description

Status Status allows you to control the user’s account and access to 
the installation, as follows:

Disable Account lets you suspend a user’s account without 
actually deleting it, so that it can be easily reinstated in the 
future.

If you don’t want to limit the time scope of the account, 
select Account never expires; if you want to limit the 
amount of time that the account remains in effect, select 
Account expires on, and key in the expiration date.

To require a user to change his password at the next logon, 
select User must change password at next logon. This can 
be used by the administrator to give the user a temporary 
password to log in for the first time, and then let the user 
set the password of his choice for future logins.

To make a password permanent, so that the user cannot 
change it to something else, select User cannot change 
password.

For security purposes, administrators may want users to 
change their passwords from time to time.

If not, select Password never expires. This allows 
users to keep their current passwords for as long as 
they like.

If so, select Password expires after, and key in the 
number of days allowed before the password expires. 
Once the time is up, a new password must be set.
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7. Click Users in the Sidebar to return to the main screen. The new user 
appears in the Sidebar list and in the main panel, as well.

The Sidebar Users list can expand and collapse. If the list is expanded, 
click the minus symbol ( – ) next to the Users icon to collapse it; if it is 
collapsed there is a plus symbol ( + ) next to the icon. Click the plus 
symbol to expand it.
The icon for super administrators has two black bands; the icon for 
administrators has one red band.
The large main panel shows the user’s name; the description that was 
given when the account was created; and whether the account is 
currently active or has been disabled.

Modifying User Accounts
To modify a user account, do the following:

1. In the Sidebar User list, click the user’s name
– or –

In the main panel, select the user’s name, then click Modify.

2. In the User page that comes up, make your changes, then click Save.

Note: The User page is discussed on page 107; the Groups page is 
discussed on page 114, the Devices page is discussed on page 118.

Deleting User Accounts
To delete a user account do the following:

1. In the main panel, select the user’s name, then click Delete.

2. Click OK.
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Groups

Groups allow administrators to easily and efficiently manage users and 
devices. Since device access rights apply to anyone who is a member of the 
group, administrators need only set them once for the group, instead of having 
to set them for each user individually. Multiple groups can be defined to allow 
some users access to specific devices, while restricting other users from 
accessing them.

Creating Groups
To create a group, do the following:

1. Select Groups in the Sidebar.

2. Click Add at the bottom of the main panel. The Group notebook opens, 
with the Group tab selected:

(Continues on next page.)
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(Continued from previous page.)

3. Enter the required information in the appropriate fields. A description of 
each of the fields is given in the table below:

4. At this point you can assign users to the group by selecting the Members 
tab – the Members page is discussed on page 116. You can also assign the 
group’s port access rights by selecting the Devices tab – the Devices page 
is discussed on page 118. 

Note: Optionally, you can skip this step now to add more groups and 
assign users to them, and come back to it later.

5. When your selections have been made click Save.

6. When the Operation Succeeded message appears, click OK.

Field Description

Group Name A maximum of 16 characters is allowed.

Description Additional information about the user that you may 
wish to include. A maximum of 63 characters is 
allowed.

Permissions Permissions and restrictions for groups are set by 
checking the appropriate boxes, as follows:

Windows Client allows group members to 
download the Windows Client software, and access 
the KVM Over the NETTM switch with it, in addition 
to (or instead of) the browser access method.

Java Client allows group members to download the 
Java Client software, and access the KVM Over the 
NETTM switch with it, in addition to (or instead of) 
the browser access method.

Power Management allows group members to 
connect to Power on the Net™ devices.

View Only limits group members to only being able 
to view the display of connected devices. They 
cannot control port access, nor can they input any 
keyboard or mouse signals to the devices they 
view.

Force to Grayscale forces the group members’ 
view of the remote display to be in grayscale. This 
can speed up I/O transfer in low bandwidth 
situations.

Note: If a user has permissions in addition to the 
ones assigned to the group, the user keeps those 
permissions in addition to the group ones.
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7. Click Group in the Sidebar to return to the main screen. The new group 
appears in the Sidebar Group list and in the main panel.

The Sidebar Groups list can expand and collapse. If the list is 
expanded, click the minus symbol ( – ) next to the Users icon to 
collapse it; if it is collapsed there is a plus symbol ( + ) next to the icon. 
Click the plus symbol to expand it.
The large main panel shows the group’s name, and the description that 
was given when the group was created (the Status column is inactive).

Modifying Groups
To modify a group, do the following:

1. In the Sidebar Group list, click the group’s name
– or –
In the main panel, select the group’s name, then click Modify.

2. In the Group notebook that comes up, make your changes, then click Save.

Note: The Group page is discussed on page 111; the Members page is 
discussed on page 116, The Devices page is discussed on page 118.

Deleting Groups
To delete a group do the following:
1. In the main panel, select the group’s name, then click Delete.

2. Click OK.
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Users and Groups

There are two ways to assign users to – and remove users from – groups: from 
the Users notebook; and from the Group notebook.

Note: Before you can assign users to groups, you must first create them. 
See Adding Users, page 107 for details.

Assigning Users to a Group From the User’s Notebook
To assign a user to a group from the User’s notebook, do the following:

1. In the Sidebar User list, click the user’s name
– or –

In the main panel, select the user’s name, then click Modify.

2. In the User notebook that comes up, select the Groups tab. A screen, 
similar to the one below, appears:

3. In the Available column, select the group that you want the user to be in.

4. Click the Right Arrow to put the group’s name into the Selected column.

5. Repeat the above for any other groups that you want the user to be in.

6. Click Save when you are done.
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Removing Users From a Group From the User’s Notebook
To remove a user from a group from the User’s notebook, do the following:

1. In the Sidebar User list, click the user’s name
– or –

In the main panel, select the user’s name, then click Modify.

2. In the User notebook that comes up, select the Groups tab. A screen, 
similar to the one below, appears:

3. In the Selected column, select the group that you want to remove the user 
from.

4. Click the Left Arrow to remove the group’s name from the Selected 
column. (It goes back into the Available column.)

5. Repeat the above for any other groups that you want to remove the user 
from.

6. Click Save when you are done.
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Assigning Users to a Group From the Group’s Notebook
To assign a user to a group from the Group notebook, do the following:

1. In the Sidebar Group list, click the group’s name
– or –

In the main panel, select the group’s name, then click Modify.

2. In the Group notebook that comes up, select the Members tab. A screen, 
similar to the one below, appears:

3. In the Available column, select the user that you want to be a member of 
the group.

4. Click the Right Arrow to put the user’s name into the Selected column.

5. Repeat the above for any other users that you want to be members of the 
group.

6. Click Save when you are done.
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Removing Users From a Group From the Group’s Notebook
To remove a user from a group from the Group’s notebook, do the following:

1. In the Sidebar Group list, click the group’s name
– or –

In the main panel, select the group’s name, then click Modify.

2. In the Group notebook that comes up, select the Members tab. A screen, 
similar to the one below, appears:

3. In the Selected column, select the user that you want to remove from the 
group.

4. Click the Left Arrow to remove the user’s name from the Selected 
column. (It goes back into the Available column.)

5. Repeat the above for any other users that you want to remove from the 
group.

6. Click Save when you are done.
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Device Assignment

When a user logs in to the KVM Over the NETTM switch, the interface comes 
up with the Port Access page displayed. All the ports that the user is permitted 
to access are listed in the Sidebar at the left of the page. Access permissions for 
those ports and the devices connected to them are assigned on a port-by-port 
basis from the User or Group list on the Sidebar of the User Management page.

Assigning Device Permissions From the User’s Notebook
To assign a device permissions to a user User’s notebook, do the following:

1. In the Sidebar User list, click the user’s name
– or –

In the main panel, select the user’s name, then click Modify.

2. In the User notebook that comes up, select the Devices tab. A screen, 
similar to the one below, appears:

Ports are listed under Names in the left hand column.
The Access column is where device access rights are set.
The USB column is where USB Virtual Media device access rights are 
listed. This entry does not appear for switches that do not support the 
USB Virtual Media function (KN2132, KN4116, KN4132).
Config enables/disables the user from making changes to the KVM 
Over the NETTM switch configuration settings.
View Log permits/restricts viewing of the KVM Over the NETTM 
switch log file.
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3. Under the Access or USB column, click the icon that corresponds to the 
port you want to configure to cycle through the choices, as shown below:

Note: You can use Shift-Click or Ctrl-Click to select a group of ports to 
configure. Clicking to cycle through the choices on any one of the 
selected ports causes all them to cycle in unison.

4. Under Config, click the icon to toggle the choices. A check mark ( √ ) 
indicates that the user has permission to make changes to the KVM Over 
the NETTM switch configuration settings (see Chapter 8, Device 
Management); an X means that the user is denied permission to make 
configuration changes.

5. Under View Log, click the icon to toggle the choices. A check mark ( √ ) 
indicates that the user has permission to view the KVM Over the NETTM 
switch’s log files; an X means that the user is denied permission to view 
the files.

6. When you have finished making your choices, click Save.

7. In the confirmation popup that appears, click OK.

Icon Meaning Description

Full Access
The user can view the remote screen and can perform 
operations on the remote server from his keyboard and 
monitor.

View Only
The user can only view the remote screen; he cannot 
perform any operations on it.

No Access
No access rights - the Port will not show up on the User's 
list on the Main Screen.
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Filters
There are three filters at the top of the page that allow you to expand or limit 
the scope of the ports that are displayed, as described in the following table:

Assigning Device Permissions From the Groups’ Notebook
To assign a device permissions to a Group of users, do the following:

1. In the Sidebar Groups list, click the group’s name
– or –

In the main panel, select the group’s name, then click Modify.

2. In the Groups notebook that comes up, select the Devices tab.

3. The screen that comes up is the same one that appears in the User’s 
notebook. Make your device assignments according to the information 
described under Assigning Device Permissions From the User’s Notebook, 
page 118.
The only difference is that whatever settings you make apply to all 
members of the group instead of just one individual member.

Filter Description

Name To filter on the port name, key in the name, partial name, or 
partial name and wild card ( * ) then press Enter. Only the 
ports whose names correspond to what you have keyed in 
appear in the list.

Access All All ports appear in the list.

Full Access Only ports configured as Full Access ports appear in the list.

View Only Only ports configured as View Only ports appear in the list.

No Access Only ports configured as No Access ports appear in the list.

USB All All ports appear in the list.

Permitted Only ports configured as Permitted appear in the list.

Restricted Only ports configured as Restricted appear in the list.
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Chapter 8
Device Management

Overview

The Device Management page allows super administrators to configure and 
control overall KVM Over the NETTM switch operations.
Web Browser Interface

GUI Interface
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Device Information

The General section of the Device Information page presents information 
about the selected device.

Note: The screenshot shows the GUI version. The Web version only displays 
the upper panel.

Each item of this section is described in the following table.

Item Meaning

Device Name This field lets you give the switch a unique name. This can be 
convenient when you need to differentiate among several devices 
in multi station installations. Simply delete the switch’s number and 
key in the name of your choice.

MAC1 Address The KVM Over the NETTM switch supports two network 
interfaces. This item displays the MAC address of the first 
interface.

MAC2 Address The KVM Over the NETTM switch supports two network 
interfaces. This item displays the MAC address of the second 
interface.

Firmware Version This item displays the current firmware version number. You can 
reference it to see if there are newer versions available on the 
Altusen website.
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The lower panel of the GUI page presents information about the selected 
device, as described in the table, below:

IP Address 1 This item displays the IP address of the first network interface.

IP Address 2 This item displays the IP address of the second network interface.

Item Description

Power Supply Detection The icons for Power Supply 1 and Power Supply 2 display 
in gray when there is no power to the power supply – they 
display in blue when power is present.
When this function is enabled (there is a check in the 
checkbox), if there is only one source of power, the switch 
will beep constantly to warn you of the problem.
If you are at the Local Console you will see a message 
asking you to confirm that your intention is to only have one 
power source. If your intention is to only have one source of 
power, there are two ways to stop the beeping: 1) You can 
disable power supply warnings by unchecking the 
checkbox. Do this if you want to disable this function on a 
permanent basis.
Or, 2) you can confirm your intention in the dialog box. Do 
this if you only want to disable the warning temporarily. With 
this method, the warning function will be back in effect after 
the next system reset.
The default for this function is enabled.

Fan Warning Message Place a check in the checkbox to enable a fan warning 
message.
If any fan stops spinning the system beeps to warn you of 
the problem. If you are at the Local Console a message 
appears informing you of the situation. You can select 
Confirm (to ignore the warning and stop the beeping) if you 
are sure there is no problem.
Note: The warning doesn’t necessarily mean that the fan 
has failed, since the fan will stop spinning (as desired) when 
the temperature drops below its lower setting.
The default for this function is enabled.

Fan Speed Fan speeds are indicated here. See Fan Location and 
Speed Information, page 224.

Temperature Temperature readings from the switch’s built-in sensors are 
indicated here and can be displayed in degrees celsius or 
fahrenheit. See Temperature Sensor Location and 
Information, page 225

Item Meaning
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Network

The Network page is used to specify the KVM Over the NETTM switch network 
environment.
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Service Ports
As a security measure, if a firewall is being used, the Administrator can specify 
the port numbers that the firewall will allow. If a port other than the default is 
used, users must specify the port number as part of the IP address when they 
log in. If not, an invalid port number (or no port number) is specified, the KVM 
Over the NETTM switch will not be found. An explanation of the fields is given 
in the table below:

Note: 1. Valid entries for all of the Service Ports are from 1–65535.

2. The service ports cannot have the same value. You must set a 
different value for each one.

3. If there is no firewall (on an Intranet, for example), it doesn’t matter 
what these numbers are set to, since they have no effect.

Field Explanation

Program This is the port number for connecting with the WinClient 
ActiveX Viewer, WinClient AP, Java Applet Viewer, Java Client 
AP, or via Virtual Media. The default is 9000.

HTTP The port number for a browser login. The default is 80.

HTTPS The port number for a secure browser login. The default is 443.
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NIC Settings

Redundant NIC
The KVM Over the NETTM switch is designed with two network interfaces. If 
Redundant NIC is enabled (the default), both interfaces make use of the IP 
address of Network Adapter 1.

Under this configuration, the second interface is usually inactive. If there is a 
network failure on the first interface, the switch automatically switches to the 
second interface.

Redundant NIC Enabled – Single IP Address for Both Interfaces
To enable the Redundant NIC function, do the following:

1. Click to put a check in the Redundant NIC checkbox.

2. Network Adapter 1 is selected in the network adapter listbox, and the 
listbox is disabled – you cannot configure Network Adapter 2.

3. Configure the IP and DNS server addresses for Network Adapter 1 (see 
the sections below).

Redundant NIC Not Enabled – Two IP Addresses
If you choose not to enable the Redundant NIC function, the two NICs can 
be configured with separate interfaces. Users can log into the KVM Over 
the NETTM switch with either IP address. To set up the switch with this 
configuration, do the following:

1. If there is a check in the Redundant NIC checkbox, click to remove it.

2. In the network adapter listbox; select Network Adapter 1.

3. Configure the IP and DNS server addresses for Network Adapter 1 (see 
the sections below).

4. Drop down the network adapter listbox; select Network Adapter 2.

5. Configure the IP and DNS server addresses for Network Adapter 2.
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IP Address
The KVM Over the NETTM switch can either have its IP address assigned 
dynamically (DHCP), or it can be given a fixed IP address.

For dynamic IP address assignment, select the Obtain IP address 
automatically radio button. (This is the default setting.)
To specify a fixed IP address, select the Set IP address manually radio 
button and fill in the IP address with values appropriate for your network.

Note: 1. If you choose Obtain IP address automatically, when the switch starts 
up it waits to get its IP address from the DHCP server. If it hasn’t 
obtained the address after one minute, it automatically reverts to its 
factory default IP address (192.168.0.60.)

2. If the switch is on a network that uses DHCP to assign network 
addresses, and you need to ascertain its IP address, see IP Address 
Determination, page 208, for information./

DNS Server
For automatic DNS Server address assignment, select the Obtain DNS 
Server address automatically radio button.
To specify the DNS Server address manually, select the Set DNS server 
address manually radio button, and fill in the addresses for the Preferred 
and Alternate DNS servers with values appropriate for your network.

Note: Specifying at the preferred DNS Server address is optional.

Network Transfer Rate
This setting allows you to tailor the size of the data transfer stream to match 
network traffic conditions by setting the rate at which the KVM Over the 
NETTM switch transfers data between the itself and the client computers. The 
range is from 4–99999 Kilobytes per second (KBps).

Finishing Up
After making any network changes, be sure Reset on exit on the Customization 
page (see Customization, page 138) has been enabled (there is a check in the 
checkbox), before logging out. This allows network changes to take effect 
without having to power the switch off and on.
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ANMS

The Advanced Network Management Settings page is used to set up login 
authentication and authorization management from external sources. It is 
organized in a series of related panels, as described, below:

kn2124v-4132.book  Page 128  Tuesday, January 12, 2010  5:08 PM



 Chapter 8. Device Management

129

IP Installer
The IP Installer is an external Windows-based utility for assigning IP addresses 
to the KVM Over the NETTM switch.

Click one of the radio buttons to select Enable, View Only, or Disable for the 
IP Installer utility. See IP Installer, page 208, for IP Installer details.

Note: 1. If you select View Only, you will be able to see the KVM Over the 
NETTM switch in the IP Installer’s Device List, but you will not be 
able to change the IP address.

2. For security, we strongly recommend that you set this to View Only 
or Disable after use.

SMTP Settings
To have the KVM Over the NETTM switch email reports from the SMTP server 
to you, do the following:

1. Enable the Enable report from the following SMTP server, and key in 
the IP address of your SMTP server.

2. If your server requires authentication, put a check in the My server 
requires authentication checkbox.

3. Key in the appropriate account information in the Account Name, 
Password, and From field.

Note: 1. Only one email address is allowed in the From field, and it cannot 
exceed 64 Bytes.

2. 1 Byte = 1 English alphanumeric character.

4. Key in the email address (addresses) of where you want the report of 
the DHCP address and event reports sent to in the To field.

Note: If you are sending the report to more than one email address, 
separate the addresses with a semicolon. The total cannot exceed 
256 Bytes.

5. Select the report options you would like sent. Choices include: Report 
IP address, Report system reboot, Report user login and Report user 
logout.
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Log Server
Important transactions that occur on the KVM Over the NETTM switch, such as 
logins and internal status messages, are kept in an automatically generated log 
file. Specify the MAC address and a port number for the computer that the Log 
Server resides on in this panel. The valid port range is 1-65535. The default 
port number is 9001.

Note: The port number must different than the one used for the Program port 
(see Program, page 125).

Installation and operation of the Log Server is discussed in Chapter 12. The 
Log File is discussed on page 98.

SNMP Settings
If you want to use SNMP to help with your installation management:

1. Check Enable SNMP Agent.

2. Key in the IP address and the port number of the computer to be notified of 
SNMP trap events. The valid port range is 1–65535.

Note: The following SNMP trap events are sent: system power On, login 
failure, and system reset.

Syslog Server
To record all the events that take place on KVM Over the NETTM switches and 
write them to a Syslog server, do the following:

1. Check Enable.

2. Key in the IP address and the port number of the Syslog server. The valid 
port range is 1-65535.

Disable Local Authentication
Selecting this option will disable login authentication locally on the KVM Over 
the NETTM switch. The switch can only be accessed using LDAP, LDAPS, MS 
Active Directory, RADIUS or CC Management authentication.

kn2124v-4132.book  Page 130  Tuesday, January 12, 2010  5:08 PM



 Chapter 8. Device Management

131

RADIUS Settings
To allow authentication and authorization for the KVM Over the NETTM switch 
through a RADIUS server, do the following:

1. Check Enable.

2. Fill in the IP addresses and port numbers for the Preferred and Alternate 
RADIUS servers.

3. In the Timeout field, set the time in seconds that the KVM Over the NETTM 
switch waits for a RADIUS server reply before it times out.

4. In the Retries field, set the number of allowed RADIUS retries.

5. In the Shared Secret field, key in the character string that you want to use 
for authentication between the KVM Over the NETTM switch and the 
RADIUS Server.

6. On the RADIUS server, set the entry for each user as follows:
su/xxxx

Where xxxx represents the Username given to the user when the account 
was created on the KVM Over the NETTM switch. The user’s access rights 
are the ones assigned for the KVM Over the NETTM switch, as well. 
(See Adding Users, page 107.)
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LDAP / LDAPS Authentication and Authorization Settings
To allow authentication and authorization for the KVM Over the NETTM switch 
via LDAP / LDAPS, refer to the information in the table, below:

Note: If LDAP Settings is enabled, the LDAP schema for MS Active 
Directory must be extended. See LDAP Server Configuration, 
page 173, for details.

CC Management Settings
To allow authorization for the KVM Over the NETTM switch through a CC 
(Control Center) server, check Enable and fill in the CC Server’s IP address 
and the port that it listens on in the appropriate fields.

Item Action

Enable Put a check in the Enable checkbox to allow LDAP / LDAPS 
authentication and authorization.

Type Click a radio button to specify whether to use LDAP or LDAPS.

LDAP Server IP and 
Port

Fill in the IP address and port number for the LDAP or LDAPS 
server. For LDAP, the default port number is 389; for LDAPS, 
the default port number is 636.

Admin DN Consult the LDAP / LDAPS administrator to ascertain the 
appropriate entry for this field. For example, the entry might 
look like this:

ou=kn4132,dc=aten,dc=com

Admin Name Key in the LDAP administrator’s username.

Password Key in the LDAP administrator’s password.

Search DN Set the distinguished name of the search base. This is the 
domain name where the search starts for user names.

Timeout Set the time in seconds that the KVM Over the NETTM 
switch waits for an LDAP or LDAPS server reply before it times 
out.
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OOBC

In case the KVM Over the NETTM switch cannot be accessed with the usual 
LAN-based methods, it can be accessed via the switch’s modem port. This 
page is used to enable support for PPP (modem) dial in operation.

An explanation of the items is given in the table below:

See PPP Modem Operation, page 212, for PPP setup and operation details.

Item Action

Enable Out of Band 
Access

Check this to enable dial-in out of band access to the KVM 
Over the NETTM switch.

Enable Dial Back As an added security feature, check this to have the switch 
disconnect the original dial-in connection and dial back to the 
phone number specified below.

Phone Number If Enable Dial Back is checked, this is the phone number the 
switch will use to dial back to initiate a PPP session with the 
user. This should be set to the same phone number that the 
user is dialing from.

Use username as dial 
back phone number

If Enable Dial Back is checked, and a phone number has 
been specified in the Phone Number field, and Use username 
as dial back phone number has been checked:

Use the phone number of the modem that the switch is 
dialing back to for the dial-in Username.

Use the phone number specified in the Phone Number field 
for the dial in password.

kn2124v-4132.book  Page 133  Tuesday, January 12, 2010  5:08 PM



KVM Over the NET™ User Manual

134

Security

The Security page controls access to the KVM Over the NETTM switch.
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IP and MAC Filtering
If any filters have been configured, they appear in the IP Filter and/or MAC 
Filter list boxes.

IP and MAC Filters control access to the KVM Over the NETTM switch based 
on the IP and/or MAC addresses of the client computers attempting to connect. 
A maximum of 100 IP filters and 100 MAC filters are allowed.

To enable IP and/or MAC filtering, Click to put a check mark in the IP Filter 
Enable and/or MAC Filter Enable checkbox.

If the include button is checked, all the addresses within the filter range are 
allowed access; all other addresses are denied access.
If the exclude button is checked, all the addresses within the filter range 
are denied access; all other addresses are allowed access.

Adding Filters
To add a filter, do the following:

1. After enabling IP and/or MAC filtering, click Add. A dialog box similar to 
the ones below appears:

Note: Each IP filter can consist of a single address, or a range of addresses. 
To filter a single IP address, key in the same address in both the 
From and To fields. To filter a continuous range of IP addresses, key 
in the start of the range in the From field; key in the end of the range 
in the To field.

2. Specify the filter addresses, then click OK.

Modifying Filters
To modify a filter, select it in the IP Filter and/or MAC Filter list boxes and 
click Modify. The Modify dialog box is similar to the Add dialog box. When 
it comes up, simply delete the old address(es) and replace it with the new 
one(s).
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Deleting Filters
To delete a filter, select it in the IP Filter and/or MAC Filter list boxes and click 
Delete.

Login String
The Login String entry field lets the super administrator specify a login string 
(in addition to the IP address) that users must include when accessing the KVM 
Over the NETTM switch with a browser. For example:

192.168.0.126/abcdefg

The following characters are allowed:
0–9 a–z A–Z ~ ! @ $ ^ & * ( ) _ + ‘ - = [ ] { } ; ’ < > , . | 
The following characters are not allowed:

% ” : / ? # \ [Space]
Compound characters (É Ç ñ ... etc.)

Note: 1. There must be a forward slash between the IP address and the string.

2. If no login string is specified here, anyone will be able to access the 
KVM Over the NETTM switch login page using the IP address alone. 
This makes your installation less secure.

For security purposes, we recommend that you change this string occasionally.

Account Policy
In the Account Policy section, system administrators can set policies governing 
usernames and passwords. Check a policy and enter the required information 
in the appropriate fields.

Item Description
Minimum Username Length Sets the minimum number of characters required for 

a username. Acceptable values are from 1–16.
Minimum Password Length Sets the minimum number of characters required for 

a password. Acceptable values are from 0–16.
Password Must Contain At Least Checking any of these items requires users to include 

at least one uppercase letter, one lowercase letter or 
one number in their password.
Note: This policy does not affect existing user 
accounts. Only new user accounts created after this 
policy has been enabled, and users required to 
change their passwords are affected.

Disable Duplicate Login Check this to prevent users from logging in with the 
same account at the same time.
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Encryption
These flexible encryption alternatives for keyboard/mouse, video, and virtual 
media data let you choose any combination of DES; 3DES; AES; RC4; or a 
Random cycle of any or all of them. Enabling encryption will affect system 
performance – no encryption offers the best performance; the greater the 
encryption the greater the adverse effect. If you enable encryption, the 
performance considerations (going from best to worst) are as follows:

RC4 offers the least impact on performance; DES is next; the 3DES or 
AES
The RC4 + DES combination offers the least impact of any combination

Private Certificate
When logging in over a secure (SSL) connection, a signed certificate is used to 
verify that the user is logging in to the intended site. For enhanced security, the 
Private Certificate section allows you to use your own private encryption key 
and signed certificate, rather than the default ATEN certificate.

Generating a Self-Signed Certificate
If you wish to create your own self-signed certificate, a free utility – 
openssl.exe – is available for download over the web. See Self-Signed Private 
Certificates, page 223 for details about using OpenSSL to generate your own 
private key and SSL certificate.

Obtaining a CA Signed SSL Server Certificate
For the greatest security, we recommend using a third party certificate 
authority (CA) signed certificate. To obtain a third party signed certificate, go 
to a CA (Certificate Authority) website to apply for an SSL certificate. After 
the CA sends you the certificate, save it to a convenient location on your 
computer.

Importing the Private Certificate
To import the private certificate, do the following:

1. Click Browse to the right of Private Key; browse to where your private 
encryption key file is located; and select it.

2. Click Browse to the right of Certificate; browse to where your certificate 
file is located; and select it.

3. Click Upload to complete the procedure.

Note: Both the private encryption key and the signed certificate must be 
imported at the same time.
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Customization

The Customization page is used to set Login Failure, Working Mode, and 
Miscellaneous parameters.

Login Failures
Allowed sets the number of consecutive failed login attempts that are 
permitted from a remote user.
Timeout sets the amount of time a remote user must wait before 
attempting to login again after exceeding the number of allowed failures.
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Working Mode
If ICMP is enabled, the KVM Over the NETTM switch can be pinged. If it 
is not enabled, the device cannot be pinged. The default is Enabled.
To permit browser access to the KVM Over the NETTM switch, click to put 
a check mark in the Enable Browser checkbox. If browser access is not 
enabled, users must use either the WinClient AP or Java Client AP 
program to access the switch. The default is Enabled.
Enabling Multiuser operation permits up to 32 users to log in at the same 
time to share the remote bus. If not enabled, only one user can log in at a 
time. The default is Enabled.
If Force all to grayscale is enabled, the remote displays of all devices 
connected to the KVM Over the NETTM switch are changed to grayscale. 
This can speed up I/O transfer in low bandwidth situations.
If Enable Device List is enabled, the switch appears in the Server List 
when using the WinClient AP (see WinClient AP Login, page 39). If this 
option is not enabled, the switch can still be connected to, but its name will 
not appear in the Server List.
When the Enable Adapter ID function is enabled (the default) the switch 
stores adapter cable information for each of its ports, so that when you 
move a KVM Adapter Cable from one port to another, it remembers the 
adapter cable’s port properties information at the new location (see The 
Adapter ID Function, page 28).
If this function is disabled, moving the adapter will mean having to key in 
its port properties information all over again at the new port (see Port 
Properties, page 86).
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Miscellaneous
The functions performed by the remaining elements at the bottom of the screen 
are described in the table, below:

Adapter Attributes
The Adapter Attribute Settings dialog box looks similar to the figure below:

Parameter Explanation

Clear Port Names This function removes the names that have been assigned to the 
ports settings (see Port Naming, page 88).

Reset Default 
Values

This function undoes all Customization page changes that have 
been made to the KVM Over the NETTM switch (except for the 
Port Names), as well as the Network Transfer Rate (on the 
Network page), and returns the parameters to the original factory 
default settings.

Adapter Attributes Clicking this button brings up a dialog box that allows you to set 
attribute parameters for each of the KVM Adapter Modules 
connected to the KVM Over the NETTM switch’s ports. See the 
next section for details.
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The attribute setting details are the same as the ones that were discussed in 
Chapter 6, Port Access. Refer back to Port Properties, page 86 for attribute 
details.

Select any of the available options from the dropdown listbox for any port.

Note: With the GUI version, you can use [Shift] Click or [Ctrl] Click to 
select several ports and set an attribute for all of them at the same time 

After making your choices, click Save to save your settings and exit.

Reset on Exit

Place a check here to have the KVM Over the NETTM switch reset itself and 
implement all the new settings when you log out. Following the reset, wait 
approximately 30 to 60 seconds before logging back in.

For network IP address settings the Reset on exit check box is automatically 
selected and the KVM switch will reset when you log out. Clearing the check 
mark before logging out will cause the new IP settings to be ignored and the 
original IP address settings will remain in effect.

Note: Even though the new IP information is ignored, it still remains in the 
field. The next time you access this page Reset on Exit will be enabled. 
The next time that the switch resets the IP settings that you thought you 
discarded will be saved. To avoid this problem, you should be sure that 
the IP settings that appear in the field are the ones you want to save.
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Date/Time

The Date/Time dialog page sets the KVM Over the NETTM switch time 
parameters:

Set the parameters according to the information below.

Time Zone
To establish the time zone that the KVM Over the NETTM switch is located 
in, drop down the Time Zone list and choose the city that most closely 
corresponds to where it is at.
If your country or region employs Daylight Saving Time (Summer Time), 
check the corresponding checkbox.
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Date
Select the month from the dropdown listbox.
Click < or > to move backward or forward by one year increments.
In the calendar, click on the day.
To set the time, use the 24 hour HH:MM:SS format.
Click Set to save your settings.

Network Time
To have the time automatically synchronized to a network time server, do the 
following:

1. Check the Enable auto adjustment checkbox.

2. Drop down the time server list to select your preferred time server
– or –

Check the Preferred custom server IP checkbox, and key in the IP address 
of the time server of your choice.

3. If you want to configure an alternate time server, check the Alternate time 
server checkbox, and repeat step 2 for the alternate time server entries.

4. Key in your choice for the number of days between synchronization 
procedures.

5. If you want to synchronize immediately, click Adjust Time Now.
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Chapter 9
Maintenance

Overview

The Maintenance function is used to upgrade the KVM Over the NETTM switch 
firmware, as well as the firmware of the KVM Adapter Cables.
Web Browser Interface

GUI Interface
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Page Layout

The organization of the Web Browser and GUI pages are similar The 
differences are as follows:

The Web version has separate menu bar entries for upgrading the main 
firmware and Adapter firmware.
The Web version has a menu bar entry for Backup and Restore.
The GUI backup and restore function is contained in the Port Access page. 
Export Configuration, and Import Configuration, page 85.

The dialog box is organized into three main areas: Firmware File, Options, and 
a large main panel. These are described in the following sections.

Firmware File
As new versions of the KVM Over the NETTM switch firmware become 
available, they are posted on our website and can be downloaded to a 
convenient location on your client computer. When performing an upgrade, 
use this section to navigate to where the download file is located.

Options
If you enable Check Main Firmware Version, or Check Adapter Firmware 
Version when you perform an upgrade the current firmware level(s) are 
compared with that of the upgrade file. If the current version is higher than the 
upgrade version, a message appears, and gives you the option to Continue or 
Cancel the operation.
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The Main Panel
A description of the items shown in this panel are described in the table, below:

Item Description

Name A listing of the KVM Over the NETTM switch ports. The 
checkbox is for selecting ports whose KVM Adapter firmware 
you want to upgrade.

Adapter Displays the type of KVM Adapter connected to the port.

F/W Version Displays the firmware version of the KVM Adapter connected 
to the port.

Progress Shows the progress of the firmware upgrade as it takes place.

Status Shows the status of the upgrade after the process has 
completed.

Upgrade Firmware Click this button to upgrade the switch’s main firmware. see 
Upgrading the Main Firmware, page 148, for firmware 
upgrading details.

Upgrade Adapters Click this button to upgrade the firmware of the selected 
adapters. See Adapter Firmware Upgrade, page 149, for 
details on upgrading adapters.

Adapter
Firmware Info

Shows the versions of the KVM Adapter firmware contained in 
the main firmware file. If anything is newer than the version 
displayed in the F/W Version column, you may want to 
upgrade the adapter to the newer version. See Adapter 
Firmware Upgrade, page 149, for details.
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Upgrading the Main Firmware

The following procedure describes upgrading the main firmware. To perform 
the upgrades, do the following:

1. Go to our website and download the new firmware file to a convenient 
location on your client computer.

2. In the Firmware File section of the Maintenance dialog box, click 
Browse; navigate to where the firmware file is located and select it.

3. Click Upgrade Firmware to start the upgrade procedure.
If you enabled Check Main Firmware Version the current firmware 
level is compared with that of the upgrade file. If the current version is 
equal to or higher than the upgrade version, a popup message appears, 
to inform you of the situation and stops the upgrade procedure.
If you didn't enable Check Main Firmware Version, the upgrade file is 
installed without checking what its level is.
As the upgrade proceeds, progress information is shown in the 
Progress column.
When the procedure completes the status of the upgrade (Succeeded or 
Failed) is shown in the Status column.
Once the upgrade completes successfully, the switch resets itself.

4. Log in again, and check the firmware version to be sure it is the new one.

Note: To recover from a “failed upgrade” situation, see Firmware Upgrade 
Recovery, page 150.
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Adapter Firmware Upgrade

The following procedure describes upgrading the firmware of selected KVM 
Adapter Cables. To perform the upgrades, do the following:

1. Click the Adapter Firmware Info button to see the adapter firmware 
versions stored by the main firmware.

2. Compare the adapter firmware information with the version shown in the 
F/W Version column of the Main Panel to see if the stored version is newer 
than the version in the adapter. If the stored version is newer, you will 
probably want to perform the upgrade.

3. In the Name column of the Main Panel, check the ports whose Adapters 
you want to upgrade.

4. Click Upgrade Adapters to start the upgrade procedure.
If you enabled Check Adapter Firmware Version, the current firmware 
level(s) are compared with that of the upgrade file. If the current 
version is equal to, or higher than the upgrade version, a message 
appears in the adapters Progress column informing you that no 
upgrade is available and stops the upgrade procedure.
If you didn't enable Check Adapter Firmware Version, the upgrade 
files are installed without checking what their level is.
As the upgrade proceeds, progress information is shown in the 
Progress column.
When the procedure completes the new adapter firmware version 
displays.

Note: 1. The switch may work with older adapter firmware versions, but for 
optimum compatibility we recommend upgrading your Adapter 
Cable firmware to that stored with the switch’s Main firmware. 

2. You can perform the upgrade procedure anytime you add an Adapter 
to the installation to make sure it is working with the latest firmware 
version.

3. To recover from a “failed upgrade” situation, see Adapter Cable 
Firmware Upgrade Recovery, page 150.
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Firmware Upgrade Recovery

Should the switch’s main firmware upgrade procedure fail, and the switch 
becomes unusable, the following firmware upgrade recovery procedure will 
resolve the problem:

1. Power off the switch.

2. Press and hold the Reset Switch in (see Reset Switch, page 11 for details).

3. While holding the Reset Switch in, power the switch back on.

This causes the switch to use the original factory installed main firmware 
version. Once the switch is operational, you can try upgrading the main 
firmware again.

Adapter Cable Firmware Upgrade Recovery

Should the adapter firmware upgrade procedure fail for one of the KVM 
Adapter Cables and the adapter becomes unusable, the following adapter 
firmware upgrade recovery procedure will resolve the problem:

1. Unplug the Adapter from the server it is connected to.

2. Slide its Firmware Upgrade Recovery Switch (located next to the Cat 5e 
connector) to the RECOVER position.

3. Plug the Adapter back into the server.

4. Repeat the Adapter upgrade procedure.

5. After the Adapter has been successfully upgraded, unplug the Adapter 
from the server it is connected to; slide the Firmware Upgrade Recovery 
Switch back to the NORMAL position; and plug the Adapter back in.
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Backup/Restore

When you select Backup/Restore on the Web version menu bar gives you the 
ability to back up the switch’s configuration and user profile information:

Backup

To backup the device’s settings do the following:

1. In the Password field, key in a password for the file.

Note: Make a note of the password, since you will need it to be able to 
restore the file.

2. Click Backup.

3. When the browser asks what you want to do with the file, select Save to 
disk; then save it in a convenient location.
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Restore
To restore a previous backup, do the following:

1. Click Browse; navigate to the file and select it.

2. In the Password field, key in the same password that you used to save the 
file.

Note: If you renamed the file, you can leave the new name. There is no 
need to return it to its original name.

3. Select as many of the options that are presented as you wish to restore.

4. Click Restore.
After the file is restored, a message appears to inform you that the 
procedure succeeded.
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Chapter 10
Download

Overview

Download is used to download stand-alone AP versions of the Windows 
Client, the Java Client, the Log Server, and Power Over the Net (PON) 
programs. When you select this tab, a list of available programs appears:

Note: The number and type of programs that appear will vary depending on 
your User Type.

Click the program you want to download; save it to a convenient location on 
your hard disk, and run it from there.

WinClient AP and Java Client AP operation is the same as browser 
operation. Refer to Chapter 4, Logging In, for login details. Refer to 
Chapter 6, Port Access and Chapter 11, Port Operation for port operation 
details.
The Log Server is discussed in Chapter 12.
If you are authorized to access a Power Over the Net™ (PON) device 
connected to the switch, the PON program will allow you to access it.

Note: The PON program can only be used in the current session. If you log 
out, the program will stop. You must download and run it again the 
next time you log in.
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Chapter 11
Port Operation

Overview

After you have successfully logged in (see Logging In, page 37), the KVM 
Over the NETTM switch’s Main Page appears with the Port Access tab selected:

Note: 1. The WinClient and Java Client AP programs have a hidden Control 
Panel either at the upper or lower center of the screen that becomes 
visible when you mouse over it. The Web Browser version’s Control 
Panel only appears after you switch to a port. The Control Panel is 
discussed on page 51.

2. See Chapter 6, Port Access for details about the Port Access page.

All the ports that a user is permitted to access are listed in the Sidebar at the left 
of the page. To access a device connected to one of the ports, double click its 
icon.
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Once you switch to a port, its screen displays on your monitor, and your 
keyboard and mouse input affects the remote server:

The Port Toolbar

The switch interface provides a toolbar to help you with port switching 
operations from within the captured port. To bring up the toolbar, tap the OSD 
Hotkey (Scroll Lock or Ctrl), twice. The toolbar appears at the upper left corner 
of the screen:

Depending on the settings that were selected for ID Display (see page 96), the 
Port Number and/or the Port Name display at the right of the toolbar. The 
meanings of the toolbar icons are given in a table on page 157.

Note: You can adjust the toolbar transparency (see Video Settings, page 64).

When the toolbar displays, mouse input is confined to the toolbar area and 
keyboard input has no effect on the server connected to the port. To carry out 
operations on the server, close the toolbar by clicking the X on it; or, recall the 
Port Access page and select the port again.
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The Toolbar Icons
The meanings of the toolbar icons are explained in the table below.

Icon Purpose

Click to skip to the first accessible port on the entire installation 
without having to recall the Port Access page.

Click to skip to the first accessible port previous to the current 
one without having to recall the Port Access page.

Click to begin Auto Scan Mode. The KVM Over the NETTM 
switch automatically switches among the ports that were 
selected for Auto Scanning with the Port Select and Filter 
functions (see Filter, page 90). This allows you to monitor their 
activity without having to switch among them manually.

Click to skip from the current port to the next accessible one 
without having to recall the Port Access page.

Click to skip from the current port to the last accessible port on 
the entire installation without having to recall the Port Access 
page.

Click to recall the Port Access page.

Click to close the toolbar.

Click to invoke Panel Array Mode (see Panel Array Mode, 
page 161).
Note: The Local Console does not have this function. See the 
entry below for the Local Console icon and function.

This icon is only found on the Local Console. Clicking this 
button cycles you through the I/O module's compensation 
mode choices (Short, Medium, Long) depending on the length 
of cable used to connect a device to the switch. The length of 
the line in the icon changes to indicate which choice is 
selected.
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Toolbar Hotkey Port Switching
When the toolbar displays, you can use hotkeys to provide KVM focus to a port 
directly from the keyboard. The KVM Over the NETTM switch provides the 
following hotkey features:

Auto Scanning 
Skip Mode Switching

The hotkeys are: A and P for Auto Scanning; and the Arrow Keys for Skip 
Mode.

Note: 1. In order for hotkey operations to take place, the toolbar must be 
visible (see The Port Toolbar, page 156).

2. To use the keys designated as hotkeys (i.e. A, P, etc.) for normal, non-
hotkey purposes, you must first close the toolbar.

3. For issues affecting multiple user operation in Auto Scan Mode, see 
Multiuser Operation, page 163.

Auto Scanning
The Scan function automatically switches among all the ports that are 
accessible to the currently logged on user at regular intervals, so that the user 
can monitor their activity automatically. Users can also limit the number of 
ports scanned with the Filter function of the Sidebar Tree. See Scan, page 89, 
and Filter, page 90, for further details.

Setting the Scan Interval:
The amount of time Auto Scan dwells on each port is set with the Scan 
Duration setting (see Scan Duration, page 97).

Invoking Auto Scan
To start Auto Scanning, with the toolbar showing, tap the A key. The Auto 
Scan function cycles through the ports in order - starting from the first port on 
the installation. An  appears in front of the Port ID Display to indicate that 
the port is being accessed under Auto Scan Mode.

S
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Pausing Auto Scan
While you are in Auto Scan Mode, you can pause the scanning in order to keep 
the focus on a particular server by pressing P. During the time that Auto 
Scanning is paused, the S in front of the Port ID blinks On and Off.

Pausing when you want to keep the focus on a particular server can be more 
convenient than exiting Auto Scan Mode because when you Resume scanning, 
you start from where you left off. If, on the other hand, you were to exit and 
then restart Auto Scan Mode, the scanning would start over from the very first 
server on the installation.

To Resume Auto Scanning after a pause, press any key except [Esc] or the 
[Spacebar]. Scanning continues from where it left off.

Exiting Auto Scan
While Auto Scan Mode is in effect, ordinary keyboard functions are 
suspended. You must exit Auto Scan Mode in order to regain normal control 
of the keyboard. To exit Auto Scan Mode press [Esc] or the [Spacebar]. Auto 
Scanning stops when you exit Auto Scan Mode.

Skip Mode
Skip Mode allows you to switch ports in order to monitor the servers manually. 
You can dwell on a particular port for as long or as little as you like - as 
opposed to Auto Scanning, which automatically switches after a fixed interval. 
The Skip Mode hotkeys are the four Arrow keys. Their operation is explained 
in the table below:

Arrow Action

← Skips from the current port to the first accessible port previous to it.

→ Skips from the current port to the first accessible port that comes after it.

↑ Skips from the current port to the very first accessible port on the 
installation.

↓ Skips from the current port to the very last accessible port on the 
installation.
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Recalling the Port Access Page
To dismiss the toolbar and bring back the Port Access page, do one of the 
following:

Tap the OSD Hotkey once.
From the toolbar, click the icon that recalls the Port Access page (see The 
Toolbar Icons, page 157).

The toolbar closes, and the Port Access Page appears.

OSD Hotkey Summary Table
The following table presents a summary of the OSD Hotkey actions after you 
have accessed a port. See OSD Hotkey, page 96 to set the OSD Hotkey.

To... Do This...

Open the Toolbar Click the OSD Hotkey twice

Open the Port 
Access Page

The Toolbar is open Click the OSD Hotkey once

The Toolbar is not open Click the OSD Hotkey three times
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Panel Array Mode

Clicking the toolbar's Panel icon invokes Panel Array Mode. Under this mode, 
the your screen divides into a grid of up to 42 panels:

Each panel represents one of the switch’s ports beginning with Port 1 at 
the upper left, and going from left to right; top to bottom.
The number of panels in the array can be selected by clicking the Show 
More Ports, and Show Fewer Ports symbols on the panel array toolbar 
(see the following page).
When the Array is first invoked, it scans through each of the ports that 
were selected for Auto Scanning with the Port Select and Filter functions 
(see Filter, page 90). The border of the panel that has the focus is 
highlighted.
Only ports that are accessible to the user are displayed. For ports that are 
not accessible, the panel is blank.
If the server connected to a port is on line, its screen displays in its panel, 
otherwise the panel is blank.
Mousing over a panel displays information about the port (port name, 
online status, port access status, and resolution).
You can access a server connected to a port by moving the mouse pointer 
over its panel and clicking. You switch to the server exactly as if you had 
selected it from the Port Access page.
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Panel Array Toolbar
The panel array toolbar, (hidden at the top center of the screen for the Java 
Applet Viewer and Java Client AP), provides shortcut navigation and control 
of the panel array. Mouse over the top center to bring up the toolbar. If you like, 
you can click and drag it anywhere on the screen. Mousing over an icon brings 
up a “tooltip” that provides a short description of the icon’s function. The icon 
functions are described in the table below:

Note: For issues affecting multiple user operation in Panel Array Mode, see 
Multiuser Operation, page 163.

Click the pushpin to have the toolbar always be on top.

Pause panel scanning, leaving the focus on the panel that currently has it.

Move back four panels.

Move to the previous panel.

Move to the next panel.

Move ahead four panels.

Show More Ports: Increase the number of panels in the array.

Show Fewer Ports: Decrease the number of panels in the array.

Toggle 4/3 aspect ratio.

Exit Panel Array mode.
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Multiuser Operation

The KVM Over the NETTM switch supports multiuser operation. When 
multiple users simultaneously access the switch from client computers, the 
rules of precedence that apply are shown in the following table:

Operation Rule

General Each bus is independent, for the method by which users are 
assigned to buses, see the next section, Users and Buses. 
Each user can open his own independent GUI Main Page.

Auto Scan Mode If a user has invoked Auto Scan Mode (see page 158), and 
then another user logs on and gets assigned to the same 
bus, at first the new user sees the GUI Main Page – but as 
soon as he accesses any port, he automatically enters Auto 
Scan Mode (since he is sharing the bus with the original 
user).
Any user on the bus can halt Auto Scan Mode by recalling 
the GUI Main Page. When this occurs, Auto Scan Mode 
stops and all the other users on the bus are switched to the 
port that was being accessed when Auto Scan Mode 
stopped.

Panel Array Mode If a user has invoked Panel Array Mode (see page 161), 
and then another user logs on and gets assigned to the 
same bus, at first the new user sees the GUI Main Page – 
but as soon as he accesses any port, he automatically 
enters Panel Array Mode (since he is sharing the bus with 
the original user).

Panel Array Mode continues until the original user stops it. 
(Administrators can override Panel Array Mode, however.)

Only the user who starts Panel Array Mode can use the 
Skip Mode (see page 159), function.

Only the user who starts Panel Array Mode can switch 
ports. Other users automatically switch to the ports that 
the original user selects. However, if one of the other 
users does not have access rights to the port that the 
original users switches to, that user will not be able to 
view the port.

Individual users can increase or decrease the number of 
panels they wish to view in Panel Array Mode; however, 
the picture quality may decrease as the number of panels 
decreases.
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Users and Buses
The KN2132, KN2124v, and KN2140v only support two remote buses. 
The first, third, fifth, etc., users to log in are all on one bus; the second, 
fourth, sixth, etc., users to log in are all on the other bus.
The KN4116, KN4132, KN4142v, and KN4140v support four remote 
buses. The first, fifth, ninth, etc. users are all on the first bus; the second, 
sixth, 10th, etc.; users are all on the second bus; the third, seventh, 11th, 
etc.; users are all on the third bus; the fourth, eighth, 12th, etc.; users are 
all on the fourth bus.
The switches support independent bus switching. With independent bus 
switching, if a user switches to a port that is being utilized by someone on 
a different bus, only the user that switched ports goes to the new port and 
the new bus – the other users on the original bus remain on the original 
port and original bus.

Note: Independent bus switching does not work when Auto Scan Mode or 
Panel Array Mode is being used by one of the members of the bus.

We recommend that the user who starts Panel Array Mode set it to display 
at least four panels. Otherwise, it is possible that the other users may only 
receive part of the picture.
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Chapter 12
The Log Server

The Windows-based Log Server is an administrative utility that records all the 
events that take place on selected KVM Over the NETTM switch units and 
writes them to a searchable database. This chapter describes how to install and 
configure the Log Server.

Installation

1. From the computer that you want to use as the Log Server, open your 
browser and log into the KVM Over the NETTM switch (see page 38).

2. Click the Log Server button at the left of the webpage to start the Log 
Server installation program.

3. If any security warning dialog boxes appear, ignore them and click Run or 
Open.

Note: If the browser cannot run the file, save it to disk, instead, and run the 
file from your disk.

The Log Server installation screen appears:

4. Click Next. Then follow the on-screen instructions to complete the 
installation and have the Log Server program icon placed on your desktop.
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Starting Up

To start the Log Server, either double click the program icon, or key in the full 
path to the program on the command line. The first time your run it, a screen 
similar to the one below appears:

Note: 1. The MAC address of the Log Server computer must be specified in 
theANMS settings – see Log Server, page 130.

2. The Log Server requires the Microsoft Jet OLEDB 4.0 driver. See The 
Log Server program does not run., page 205 if the program doesn’t 
start.

The screen is divided into three components:
A Menu Bar at the top
A panel that will contain a list of KVM Over the NETTM units in the 
middle (see The Log Server Main Screen, page 171).
A panel that will contain an Events List at the bottom

Each of the components is explained in the sections that follow.
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The Menu Bar

The Menu bar consists of four items:
Configure
Events
Options
Help

These are discussed in the sections that follow.

Note: If the Menu Bar appears to be disabled, click in the List window to 
enable it.

Configure
The Configure menu contains three items: Add; Edit; and Delete. They are 
used to add new units to the List; edit the information for units already on the 
list; or delete units from the list.

To add a unit to the list, click Add.
To edit or delete a listed unit, first select the target in the List window, then 
open this menu and click Edit or Delete.

When you choose Add or Edit, a dialog box, similar to the one below, appears:
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A description of the fields is given in the table, below:

Fill in or modify the fields, then click OK to finish.

Events
The Events Menu has two items: Search and Maintenance.

Search:
Search allows you to search for events containing specific words or strings. 
When you access this function, a screen, similar to the one below, appears:

Field Explanation

Address This can either be the IP address of the unit or its DNS name
(if the network administrator has assigned it a DNS name).

Port The port number that was assigned to the Log Server
(see Date/Time, page 142).

Description This field is provided so that you can put in a descriptive reference for 
the unit to help identify it.

Limit This specifies the number of days that an event should be kept in the 
Log Server's database. Events that exceed the amount of time 
specified here can be removed with the Maintenance function (see 
Maintenance:, page 169).
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A description of the items is given in the table, below:

Maintenance:
This function allows the administrator to perform manual maintenance of the 
database, such as erasing specified records before their expiration time is up.

Item Description

New search This is one of three radio buttons that define the scope of the 
search. If it is selected, the search is performed on all the 
events in the database for the selected unit.

Search last results This is a secondary search performed on the events that 
resulted from the previous search.

Search excluding last 
results

This is a secondary search performed on all the events in the 
database for the selected unit excluding the events that 
resulted from the previous search.

Server List KVM Over the NETTM units are listed according to their IP 
address. Select the unit that you want to perform the search on 
from this list. You can select more than one unit for the search. 
If no units are selected, the search is performed on all of them.

Priority Sets the level for how detailed the search results display 
should be. Least is the most general; Most is the most specific. 
Least results appear in black; Less results appear in blue; 
Most results appear in red.

Start Date Select the date that you want the search to start from. The 
format follows the YYYY/MM/DD convention, as follows:
2009/11/04

Start Time Select the time that you want the search to start from. The 
format follows the HH:MM:SS convention.

End Date Select the date that you want the search to end at.

End Time Select the time that you want the search to end at.

Pattern Key in the pattern that you are searching for here. The multiple 
character wildcard (%) is supported. E.g., h%ds would match 
hands and hoods.

Results Lists the events that contained matches for the search.

Search Click this button to start the search.

Print Click this button to print the search results.

Export Click this button to save the search results to file.

Exit Click this button to exit the Log Server.
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Options
Network Retry allows you to set the number of seconds that the Log Server 
should wait before attempting to connect if its previous attempt to connect 
failed. When you click this item, a dialog box, similar to the one below, 
appears:

Key in the number of seconds, then click OK to finish.

Help
From the Help menu, click Contents to access the online Windows Help file. 
The help file contains instructions about how to setup, operation and 
troubleshoot the Log Server.
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The Log Server Main Screen

Overview
The Log Server Main Screen is divided into two main panels.

The upper (List) panel lists all of the units that have been selected for the 
Log Server to track (see Configure, page 167).
The lower (Event) panel displays the tick information for the currently 
selected unit. (If there are more than one unit, the selected unit is the one 
that is highlighted).
To select a unit in the list, simply click on it.
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The List Panel
The List panel contains six fields:

The Event Panel
The lower panel displays log events for the currently selected unit. Note that if 
there are more than one units, even though they aren't currently selected, if their 
Recording checkbox is checked, the Log Server records their log events and 
keeps them in its database.

Field Explanation

Recording Determines whether the Log Server records the ticks for this 
unit, or not. If the Recording checkbox is checked, the field 
displays Recording, and the ticks are recorded. If the 
Recording checkbox is not checked, the field displays Paused, 
and the ticks are not recorded.
Note: Even though a unit is not the currently selected one, if 
its Recording checkbox is checked, the Log Server will still 
record its ticks.

Address This is the IP Address or DNS name that was given to the unit 
when it was added to the Log Server (see Configure, 
page 167).

Port This is the Access Port number assigned to the unit (see 
Configure, page 167).

Connection If the Log Server is connected to the unit, this field displays 
Connected.

If the Log Server is not connected, this field displays 
Waiting. This means that the Log Server's MAC address 
has not been set properly. It needs to be set on the Device 
Management Date/Time page (see page 142).

Days This field displays the number of days that the unit's log events 
are to be kept in the Log Server's database before expiration 
(see Configure, page 167).

Description This field displays the descriptive information given for the unit 
when it was added to the Log Server (see Configure, 
page 167).
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Chapter 13
LDAP Server Configuration

Introduction

The KVM Over the NETTM switch allows log in authentication and 
authorization through external programs. This chapter describes how to 
configure Active Directory for KVM Over the NETTM switch authentication 
and authorization.

To allow authentication and authorization via LDAP or LDAPS, the Active 
Directory’s LDAP Schema must be extended so that an extended attribute 
name for the KVM Over the NETTM switch – iKVM4140-userProfile – is 
added as an optional attribute to the person class.

Note: Authentication refers to determining the authenticity of the person 
logging in; authorization refers to assigning permission to use the 
device’s various functions.

In order to configure the LDAP server, you will have to complete the following 
procedures: 1) Install the Windows Server Support Tools; 2) Install the Active 
Directory Schema Snap-in; and 3) Extend and Update the Active Directory 
Schema.

The following section provides an example of configuring LDAP under 
Windows 2003 Server.

Install the Windows 2003 Support Tools

To install the Windows 2003 Support Tools, do the following:

1. On your Windows Server CD, open the Support → Tools folder.

2. In the right panel of the dialog box that comes up, double click 
SupTools.msi.

3. Follow along with the Installation Wizard to complete the procedure.
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Install the Active Directory Schema Snap-in

To install the Active Directory Schema Snap-in, do the following:

1. Open a Command Prompt.

2. Key in: regsvr32 schmmgmt.dll to register schmmgmt.dll on your 
Active Directory computer.

3. Open the Start menu; click Run; key in: mmc /a; click OK.

4. On the File menu of the screen that appears, click Add/Remove Snap-in; 
then click Add.

5. Under Available Standalone Snap-ins, double click Active Directory 
Schema; click Close; click OK.

6. On the screen you are in, open the File menu and click Save.

7. For Save in, specify the C:\Windows\system32 directory.

8. For File name, key in schmmgmt.msc.

9. Click Save to complete the procedure.

Create a Start Menu Shortcut Entry

To create a shortcut entry on the Start Menu for the Active Directory Schema, 
do the following:

1. Right click Start; select: Open all Users → Programs → Administrative 
Tools.

2. On the File menu, select New → Shortcut

3. In the dialog box that comes up, browse to, or key in the path to 
schmmgmt.msc (C:\Windows\system32\schmmgmt.msc), then click Next.

4. In the dialog box that comes up, key in Active Directory Schema as the 
name for the shortcut, then click Finish.
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Extend and Update the Active Directory Schema

To extend and update the Active Directory Schema, you must do the following 
3 procedures: 1) create a new attribute; 2) extend the object class with the new 
attribute; and 3) edit the active directory users with the extended schema.

Creating a New Attribute
To create a new attribute do the following:

1. From the Start menu, open Administrative Tools → Active Directory 
Schema.

2. In the left panel of the screen that comes up, right-click Attributes:

3. Select New → Attribute.

4. In the warning message that appears, click Continue to bring up the 
Create New Attribute dialog box.

(Continues on next page.)
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(Continued from previous page.)

5. Fill in the dialog box to match the entries for Description and Common 
Name shown below, then click OK to complete the procedure.

Note: The Unique X500 Object ID uses periods, not commas.
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Extending the Object Class With the New Attribute
To extend the object class with the new attribute, do the following:

1. Open the Control Panel → Administrative Tools → Active Directory 
Schema.

2. In the left panel of the screen that comes up, select Classes.

3. In the right panel, right-click person:

4. Select Properties; the person Properties dialog box comes up with the 
General page displayed. Click the Attributes tab.
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5. On the Attributes page, click Add:

6. In the list that comes up, select iKVM4140-userProfile, then click OK to 
complete the procedure.
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Editing Active Directory Users
To edit Active Directory Users With the Extended Schema, do the following:

1. Run ADSI Edit. (Installed as part of the Support Tools.)

2. In the left panel, open Domain, and navigate to the DC=aten,DC=com 
CN=Users node.

3. In the right panel, locate the user you wish to edit. (Our example uses 
jason.)

4. Right-click on the user’s name and select properties.

(Continues on next page.)
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(Continued from previous page.)

5. On the Attribute Editor page of the dialog box that appears, select 
iKVM4140-userProfile from the list.

6. Click Edit to bring up the String Attribute Editor:

(Continues on next page.)
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(Continued from previous page.)

7. Key in the KVM Over the NETTM switch permission attribute values. For 
example:

Note: Where user represents the Username of a KVM Over the NETTM 
switch user whose permissions reflect the permissions you want 
Jason to have (see Users, page 107).

8. Click OK. When you return to the Attribute Editor page, the iKVM4140-
userProfile entry now reflects the new permissions:

a) Click Apply to save the change and complete the procedure. Jason now 
has the same permissions as user.

b) Repeat the Editing Active Directory Users procedure for any other users 
you wish to add.
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OpenLDAP

OpenLDAP is an Open source LDAP server designed for Unix platforms. A 
Windows version can be downloaded from:

http://download.bergmans.us/openldap/openldap-2.2.29/
openldap-2.2.29-db-4.3.29-openssl-0.9.8a-
win32_Setup.exe.

OpenLDAP Server Installation
After downloading the program, launch the installer, select your language, 
accept the license and choose the target installation directory. The default 
directory is: c:\Program Files\OpenLDAP.

When the Select Components dialog box appears, select install BDB-tools and 
install OpenLDAP-slapd as NT service, as shown in the diagram, below:
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OpenLDAP Server Configuration
The main OpenLDAP configuration file, slapd.conf, is found in the /OpenLdap 
directory. It has to be customized before launching the server. This section 
provides a quick summary of the modifications to the configuration file in 
order for it to be used with the KVM Over the NETTM switch, for a complete 
explanation of OpenLDAP, refer to the official OpenLDAP documentation.

The modifications to the configuration file will do the following:
Specify the Unicode data directory. The default is ./ucdata.
Choose the required LDAP schemas. The core schema is mandatory.
Configure the path for the OpenLDAP pid and args start up files. The first 
contains the server pid, the second includes command line arguments.
Choose the database type. The default is bdb (Berkeley DB).
Specify the server suffix. All entries in the directory will have this suffix, 
which represents the root of the directory tree. For example, with suffix 
dc=aten,dc=com, the fully qualified name of all entries in the database 
will end with dc=aten,dc=com.
Define the name of the administrator entry for the server (rootdn), along 
with its password (rootpw). This is the server's super user. The rootdn 
name must match the suffix defined above. (Since all entry names must 
end with the defined suffix, and the rootdn is an entry.)

An example configuration file is provided in the figure, below:
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Starting the OpenLDAP Server
To start the OpenLDAP Server, run slapd (the OpenLDAP Server executable 
file) from the command line. slapd supports a number of command line 
options, the most important option is the d switch that triggers debug 
information. For example, a command of:

slapd -d 256

would start OpenLDAP with a debug level of 256, as shown in the following 
screenshot:

Note: For details about slapd options and their meanings, refer to the 
OpenLDAP documentation.
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Customizing the OpenLDAP Schema
The schema that slapd uses may be extended to support additional syntaxes, 
matching rules, attribute types, and object classes.

In the case of the KVM Over the NETTM switch, the User class and the 
permission attribute are extended to define a new schema. The extended 
schema file used to authenticate and authorize users logging in to the KVM 
Over the NETTM switch is shown in the figure, below:
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LDAP DIT Design and LDIF File

LDAP Data Structure
An LDAP Directory stores information in a tree structure known as the 
Directory Information Tree (DIT). The nodes in the tree are directory entries, 
and each entry contains information in attribute-value form. An example of the 
LDAP directory tree for the KN2124v / KN2140v / KN4124v / KN4140v / 
KN2132 / KN4116 / KN4132 is shown in the figure, below:

(Continues on next page.)
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(Continued from previous page.)

DIT Creation
The LDAP Data Interchange Format (LDIF) is used to represent LDAP entries 
in a simple text format (please refer to RFC 2849). The figure below illustrates 
an LDIF file that creates the DIT for the KN4140 directory tree. The name of 
the file is init.ldif and you create it in the /OpenLDAP directory, as follows:
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Using the New Schema
To use the new schema, do the following:

1. Save the new schema file (e.g., kn4140.schema) in the
/OpenLDAP/schema/ directory.

2. Add the new schema to the slapd.conf file (in the /OpenLDAP directory), 
as shown in the figure, below:

3. Restart the LDAP server.

4. Write the LDIF file and create the database entries in init.ldif with the 
ldapadd command, as shown in the following example:
ldapadd -f init.ldif -x -D "cn=ldapadmin,dc=aten,dc=com" 
-w password
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Safety Instructions

General
Read all of these instructions. Save them for future reference.
Follow all warnings and instructions marked on the device.
Do not place the device on any unstable surface (cart, stand, table, etc.). If 
the device falls, serious damage will result.
Do not use the device near water.
Do not place the device near, or over, radiators or heat registers.
The device cabinet is provided with slots and openings to allow for 
adequate ventilation. To ensure reliable operation, and to protect against 
overheating, these openings must never be blocked or covered.
The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 
this will block its ventilation openings. Likewise, the device should not be 
placed in a built in enclosure unless adequate ventilation has been 
provided.
Never spill liquid of any kind on the device.
Unplug the device from the wall outlet before cleaning. Do not use liquid 
or aerosol cleaners. Use a damp cloth for cleaning.
The device should be operated from the type of power source indicated on 
the marking label. If you are not sure of the type of power available, 
consult your dealer or local power company.
To prevent damage to your installation it is important that all devices are 
properly grounded.
The device is designed for IT power distribution systems with 230V 
phase-to-phase voltage.
The device is equipped with a 3-wire grounding type plug. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace your obsolete outlet. Do not attempt to defeat the 
purpose of the grounding-type plug. Always follow your local/national 
wiring codes.
Do not allow anything to rest on the power cord or cables. Route the 
power cord and cables so that they cannot be stepped on or tripped over.
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If an extension cord is used with this device make sure that the total of the 
ampere ratings of all products used on this cord does not exceed the 
extension cord ampere rating. Make sure that the total of all products 
plugged into the wall outlet does not exceed 15 amperes.
To help protect your system from sudden, transient increases and 
decreases in electrical power, use a surge suppressor, line conditioner, or 
un-interruptible power supply (UPS).
Position system cables and power cables carefully; Be sure that nothing 
rests on any cables.
When connecting or disconnecting power to hot-pluggable power 
supplies, observe the following guidelines:

Install the power supply before connecting the power cable to the 
power supply.
Unplug the power cable before removing the power supply.
If the system has multiple sources of power, disconnect power from the 
system by unplugging all power cables from the power supplies.

Never push objects of any kind into or through cabinet slots. They may 
touch dangerous voltage points or short out parts resulting in a risk of fire 
or electrical shock.
Do not attempt to service the device yourself. Refer all servicing to 
qualified service personnel.
If the following conditions occur, unplug the device from the wall outlet 
and bring it to qualified service personnel for repair.

The power cord or plug has become damaged or frayed.
Liquid has been spilled into the device.
The device has been exposed to rain or water.
The device has been dropped, or the cabinet has been damaged.
The device exhibits a distinct change in performance, indicating a need 
for service.
The device does not operate normally when the operating instructions 
are followed.

Only adjust those controls that are covered in the operating instructions. 
Improper adjustment of other controls may result in damage that will 
require extensive work by a qualified technician to repair.
Do not connect the RJ-11 connector marked “UPGRADE” to a public 
telecommunication network.
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Rack Mounting
Before working on the rack, make sure that the stabilizers are secured to 
the rack, extended to the floor, and that the full weight of the rack rests on 
the floor. Install front and side stabilizers on a single rack or front 
stabilizers for joined multiple racks before working on the rack.
Always load the rack from the bottom up, and load the heaviest item in the 
rack first.
Make sure that the rack is level and stable before extending a device from 
the rack.
Use caution when pressing the device rail release latches and sliding a 
device into or out of a rack; the slide rails can pinch your fingers.
After a device is inserted into the rack, carefully extend the rail into a 
locking position, and then slide the device into the rack.
Do not overload the AC supply branch circuit that provides power to the 
rack. The total rack load should not exceed 80 percent of the branch circuit 
rating.
Make sure that all equipment used on the rack – including power strips and 
other electrical connectors – is properly grounded.
Ensure that proper airflow is provided to devices in the rack.
Ensure that the operating ambient temperature of the rack environment 
does not exceed the maximum ambient temperature specified for the 
equipment by the manufacturer
Do not step on or stand on any device when servicing other devices in a 
rack.
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Technical Support

International
For online technical support – including troubleshooting, documentation, 
and software updates: http://support.aten.com
For telephone support, see Telephone Support, page iii

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support ATEN TECH support@aten-usa.com

ATEN NJ sales@aten.com

 Online 
Support

Technical Support ATEN TECH http://www.aten-usa.com/support

ATEN NJ http://support.aten.com

Troubleshooting
Documentation
Software Updates

ATEN TECH http://www.aten-usa.com

ATEN NJ http://www.aten.com

Telephone Support ATEN TECH 1-888-999-ATEN

ATEN NJ 1-732-356-1703
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Specifications

KN2124v / KN4124v
Function KN2124v KN4124v

Computer 
Connections

Direct 24

Max 384 (via cascade)

Port Selection Pushbutton / GUI / Hotkey

Connectors Console Port  1 x SPHD-18 Female (Yellow)

KVM Port 24 x RJ-45 Female (Black)

Power 2 x 3-prong AC socket

LAN 2 x RJ-45 Female (Black)

PON 1 x RJ-45 Female (Black)

Modem 1 x RJ-45 Female (Black)

USB 3 x USB Type A Female (White)

Audio 2 x Audio Jack Female

Switches Reset 1 x Semi-recessed Pushbutton

Power 2 x Rocker Switch

Port Selection 2 x Pushbutton

LEDs On Line 24 (Green)

Selected 24 (Red)

Power 1 (Blue)

Link
10 / 100 / 1000 Mbps

2 (Red / Red + Green / Green)

Emulation Keyboard/Mouse PS/2 / USB (PC, Mac, Sun) / Serial

Video 1600x1200 @ 60Hz

Scan Interval 1–255 Seconds

I/P Rating 100–240V AC; 50–60 Hz; 1.0 A

Power Consumption Single Power 110V/36.4W
230V/37.2W

110V/43.7W
230V/44.6W

Dual Power 110V/41.8W
230V/42.5W

110V/49.1W
230V/50W

Environment Operating Temp. 0–50° C

Storage Temp. -20–60° C

Humidity 0–80% RH Noncondensing

Physical Properties Housing Metal

Weight 5.99 kg 6.04 kg

Dimensions L x W x H 43.36 x 40.94 x 4.40 cm (19”1U)
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KN2140v / KN4140v
Function KN2140v KN4140v

Computer 
Connections

Direct 40

Max 640 (via cascade)

Port Selection Pushbutton / GUI / Hotkey

Connectors Console Port  1 x SPHD-18 Female (Yellow)

KVM Port 40 x RJ-45 Female (Black)

Power 2 x 3-prong AC socket

LAN 2 x RJ-45 Female (Black)

PON 1 x RJ-45 Female (Black)

Modem 1 x RJ-45 Female (Black)

USB 3 x USB Type A Female (White)

Audio 2 x Audio Jack Female

Switches Reset 1 x Semi-recessed Pushbutton

Power 2 x Rocker Switch

Port Selection 2 x Pushbutton

LEDs On Line 40 (Green)

Selected 40 (Red)

Power 1 (Blue)

Link
10 / 100 / 1000 Mbps

2 (Red / Red + Green / Green)

Emulation Keyboard/Mouse PS/2 / USB (PC, Mac, Sun) / Serial

Video 1600x1200 @ 60Hz

Scan Interval 1–255 Seconds

I/P Rating 100–240V AC; 50–60 Hz; 1.0 A

Power Consumption Single Power 110V/36.8W
230V/37.7W

110V/49W
230V/50W

Dual Power 110V/42.2W
230V/43W

110V/54W
230V/56W

Environment Operating Temp. 0–50° C

Storage Temp. -20–60° C

Humidity 0–80% RH Noncondensing

Physical Properties Housing Metal

Weight 6.08 kg 6.12 kg

Dimensions L x W x H 43.36 x 40.94 x 4.40 cm (19”1U)
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KN2116A / KN4116
Function KN2116A KN4116

Computer 
Connections

Direct 16

Max 256 (via cascade)

Port Selection Pushbutton / GUI / Hotkey

Connectors Console 
Port

Keyboard 1 x 6-pin Mini-DIN Female (Purple)
1 x USB Type A Female (White)

Video  1 x HDB-15 Female (Blue)

Mouse 1 x 6-pin Mini-DIN Female (Green)
1 x USB Type A Female (White)

KVM Port 16 x RJ-45 Female (Black)

Power 1 x 3-prong AC socket

LAN 2 x RJ-45 Female (Black)

PON 1 x RJ-45 Female (Black)

Modem 1 x RJ-45 Female (Black)

USB 3 x USB Type A Female (White)

Switches Reset 1 x Semi-recessed Pushbutton

Power 1 x Rocker Switch

Port Selection 2 x Pushbutton

LEDs On Line 16 (Green)

Selected 16 (Red)

Power 1 (Blue)

Link
10 / 100 / 1000 Mbps

2 (Red / Red + Green / Green)

Emulation Keyboard/Mouse PS/2 / USB (PC, Mac, Sun) / Serial

Video 1600x1200 @ 60Hz

Scan Interval 1–255 Seconds

I/P Rating 100–240V AC; 50–60 Hz; 1.0 A

Power Consumption 110V / 33W
230V / 33.8W

110V / 39.60W
230V / 40.00W

Environment Operating Temp. 0–50°C

Storage Temp. -20–60°C

Humidity 0–80% RH, Noncondensing

Physical Properties Housing Metal

Weight 5.46 kg 5.52 kg

Dimensions L x W x H 43.36 x 41.35 x 4.40 cm (19" 1U)
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KN2132 / KN4132

Function KN2132 KN4132

Computer 
Connections

Direct 32

Max 512

Port Selection Pushbutton / GUI / Hotkey

Connectors Console 
Port

Keyboard 1 x 6-pin Mini-DIN Female (Purple)
1 x USB Type A Female (White)

Video  1 x HDB-15 Female (Blue)

Mouse 1 x 6-pin Mini-DIN Female (Green)
1 x USB Type A Female (White)

KVM Port 32 x RJ-45 Female (Black)

Power 1 x 3-prong AC socket

LAN 2 x RJ-45 Female (Black)

PON 1 x RJ-45 Female (Black)

Modem 1 x RJ-45 Female (Black)

USB 3 x USB Type A Female (White)

Switches Reset 1 x Semi-recessed Pushbutton

Power 1 x Slide

Port Selection 2 x Pushbutton

LEDs On Line 32 (Green)

Selected 32 (Red)

Power 1 (Blue)

Link
10 / 100 / 1000 Mbps

2 (Red / Red + Green / Green)

Emulation Keyboard/Mouse PS/2 / USB (PC, Mac, Sun) / Serial

Video 1600x1200 @ 60Hz

Scan Interval 1–255 secs

I/P Rating 100–240VAC; 50–60Hz; 1.0A

Power Consumption 110V / 33.40W
230V / 34.20W

110V / 45.80W
230V / 46.30W

Environment Operating Temp. 0–50° C

Storage Temp. -20–60° C

Humidity 0–80% RH

Physical 
Properties

Housing Metal

Weight 5.59 kg 5.63 kg

Dimensions L x W x H 43.36 x 41.35 x 4.40 cm (19" 1U)
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Troubleshooting

General Operation
Problem Resolution

I am confused about which 
equipment the terms Local and 
Remote refer to.

See Terminology, page xv, for details.

Erratic Operation The switch needs to be started before any cascaded 
switches.
1. Make sure to power it on before powering on the 

switch.
2. If the cascaded switch was started before the 

switch, reset or restart the cascaded switch.

Press and release the Reset switch (see Reset 
Switch, page 11).

I have been given an account 
but I am unable to log in.

1. Make sure that you have correctly specified your 
Username and Password.

2. Make sure that the administrator has given you 
the necessary permission to access the switch.

3. Ask your administrator to see if the switch is 
under CC management. If it is, he will have to 
resolve the situation either by disabling CC 
management on the switch (see page 128), or by 
deselecting it on the CC server (see the CC User 
Manual for details).

I can’t access the switch, even 
though I have specified the IP 
address and port number 
correctly.

If the switch is behind a router, the router’s Port 
Forwarding (also referred to as Virtual Server) 
feature must be configured. See Port Forwarding, 
page 210, for details.

When logging in from a browser, 
the following message appears: 
404 Object Not Found.

If a login string has been set, make sure to include 
the forward slash and correct login string when you 
specify the switch IP address. (See Login String, 
page 136.)

Sudden loss of network 
connection.

Close your switch connection. Wait approximately 
30 seconds, and log in again.

No remote server video display 
on the client computer.

Check that your KVM Adapter Cable’s firmware 
version is the same as the version stored in the 
switch’s Main firmware. See Adapter Firmware 
Upgrade, page 149, for details.

Set the remote server resolution to 1280 x 1024 or 
less.
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No remote server video display 
on the client computer, but 
mouse movements appear on 
the local console and mouse 
clicks have no effect

Press and release the left Alt key, then press and 
release the right Alt key

The display on the client 
computer is distorted and 
performing an Autosync doesn’t 
resolve the problem.

Switch ports to a port with a different resolution, then 
switch back.
If the above didn’t resolve the problem, change the 
resolution and refresh rate for the system running on 
the port. Afterward, you can either run at the new 
resolution, or switch back to the original resolution.

The Lock Key LEDs on the 
Control Panel don’t accurately 
reflect the actual locked status of 
my keyboard input.

When you first connect, the LED display may not 
accurately reflect the LEDs on your keyboard. To 
resolve the problem, click the LEDs on the Control 
Panel until they match your keyboard. Afterward, 
when you change them from the keyboard they will 
change on the Control Panel.

When I log in, the browser 
generates a CA Root certificate 
is not trusted, or a Certificate 
Error response.

The certificate’s name is not found on Microsoft’s list 
of Trusted Authorities. The certificate can be trusted. 
See Trusted Certificates, page 219, for details.

In multiuser operation I had 
exclusive (or occupy) rights on 
the port I was viewing. After I 
recalled the Port Access page 
and then came back to the port I 
was occupying, it had been 
taken over by another user. Why 
did this happen?

If you try to return to the port by selecting again in 
the tree, the switch acts as if you are accessing the 
port for the first time. If another user was waiting on 
the port, he takes precedence and gets the port. The 
correct way to return to the port is to click the Close 
icon at the top right of the Port Access page.

I can’t access my PN9108 when 
I run the PON AP.

Since the PN9108 already has over IP functionality, 
there is no need for the KN2124v / KN2140v / 
KN4124v / KN4140v / KN2132 / KN4116 / KN4132 
to provide it. Therefore, only PON devices that don’t 
have their own over IP functionality (such as the 
PN0108) are supported.

Problem Resolution
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Mouse Problems
Problem Resolution

Mouse and/or Keyboard not 
responding.

Check that your KVM Adapter Cable’s firmware version 
is the same as the version stored in the switch’s Main 
firmware. See Adapter Firmware Upgrade, page 149, for 
details.

Unplug the cable(s) from the console port(s), then plug it/
them back in.

Mouse movement 
extremely slow

There is too much data being transferred for your 
connection to keep up with. Lower the video quality (see 
Video Settings, page 64) so that less video data is 
transmitted.

There are two mouse 
pointers after the remote 
server is accessed.

You can select another pointer type. See Mouse Pointer 
Type, page 75, for details.

When the mouse pointer is 
in Single Pointer mode, I 
can’t access the Control 
Panel.

Recall the Control Panel and immediately change the 
pointer to Dual mode.

Why is there a Dual Pointer 
mode?

When you are not in Mouse DynaSync Mode, you need 
the two pointers so that you know the remote server 
pointer is actually at the location you think it is at. 
Otherwise, you might perform a mouse operation and 
because of net lag the remote server pointer may not be 
at the location that your client computer pointer is at.

Mouse pointer confusion If you find the display of two mouse pointers (local and 
remote) to be confusing or annoying, you can use the 
Toggle Mouse Display function to shrink the non-
functioning pointer. See Toggle mouse display, page 56, 
and Mouse Pointer Type, page 75.

When I log in with my 
Windows system, the local 
and remote mouse pointers 
do not sync.

1. Check the status of the Mouse Sync Mode setting 
(see Mouse DynaSync Mode, page 76). If it is set to 
Automatic, change the setting to Manual and refer to 
the information for Manual Mouse Synchronization on 
page 77.

2. If you are in Manual mode, use the AutoSync feature 
(see Video Settings, page 64), to sync the local and 
remote monitors.

3. If that doesn't resolve the problem, use the Adjust 
Mouse feature (see Adjust mouse, page 56) to bring 
the pointers back in step.

4. If the above fails to resolve the problem, refer to 
Additional Mouse Synchronization Procedures, 
page 216, for further steps to take.
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When I log in with my Mac 
system, the local and 
remote mouse pointers do 
not sync.

There are two automatic Mouse DynaSync settings: the 
default, and Mac2. If mouse synchronization is not 
satisfactory with the default, try the Mac 2 setting. See 
the Note on page 77 for details.

When I log in with my Sun 
system, the local and 
remote mouse pointers do 
not sync

Automatic Mouse DynaSync sync only supports USB 
mice on Windows and Mac (G4 or higher) systems. You 
must sync the pointers manually. See Mouse DynaSync 
Mode, page 76, and Manual Mouse Synchronization, 
page 77, for further details.
After doing the above, refer to Sun / Linux, page 217, 
under Additional Mouse Synchronization Procedures for 
further steps to take.

When I log in with my Linux 
system, the local and 
remote mouse pointers do 
not sync.

Automatic Mouse DynaSync sync only supports USB 
mice on Windows and Mac (G4 or higher) systems. You 
must sync the pointers manually. See Mouse DynaSync 
Mode, page 76, Manual Mouse Synchronization, 
page 77, and Mac and Linux Considerations, page 77, 
for further details.
After doing the above, refer to Sun / Linux, page 217, 
under Additional Mouse Synchronization Procedures for 
further steps to take.

Problem Resolution
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Virtual Media

Web Browser

Problem Resolution

Virtual Media doesn’t 
work.

The remote server’s mainboard does not support USB. If 
there is a newer firmware and BIOS version for the remote 
server’s mainboard – one that supports USB – get it from 
the manufacturer and upgrade the server’s mainboard 
firmware and BIOS.

There is no Virtual Media 
icon on my Control 
Panel.

1. Virtual Media only supports the KA7175 and KA7176 
KVM Adapter Cables.

2. You must be have Administrator privileges on your client 
computer. (This is a Windows limitation.)

I can’t boot my remote 
server from my Virtual 
Media drive.

Your remote server’s BIOS doesn’t support booting from a 
USB drive. Get the latest firmware and BIOS version for 
your mainboard from the manufacturer and upgrade your 
mainboard BIOS.

If I connect a USB floppy 
drive to a remote server, 
it can boot the remote 
server. But, if I map it to 
the remote server as a 
Virtual Media drive, it 
cannot boot the remote 
server.

USB floppy drives have two types of format: UFI and CBI. 
Both can be used for OS level virtual media functions, but 
currently only UFI is supported for BIOS level (such as 
boot) functions.

I cannot mount Folder as 
a Virtual Media device.

If the actual Folder is formatted with the FAT16 file system, 
it cannot be mounted if its size exceeds 2GB.

Problem Resolution

After upgrading the 
firmware, after logging in 
with my web browser, the 
switch appears to still be 
using the old firmware 
version.

The switch is using the new firmware version but the 
browser is displaying a page that is stored in its cache. 
Simply log out and clear your browser’s cache.

IE: Tools → Internet Options → Temporary Internet 
Files → Delete Files

Firefox: Tools → Clear Private Data

 Firefox only opens the 
Java Applet Viewer. It 
doesn’t open the 
WinClient ActiveX 
Viewer.

The WinClient ActiveX Viewer requires ActiveX. Since 
Firefox doesn’t support ActiveX only the Java Applet Viewer 
is available.
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The WinClient ActiveX Viewer and the WinClient AP
Problem Resolution

My switch units don’t 
show up in the Server List 
window when I start the 
WinClient AP program.

Only units whose Access Port settings for Program (see 
page 124) match the number specified for Port in the 
Server area of this dialog box appear in the Server List 
window. Make sure that your entry for Port matches the 
entry you have specified for Program on the Device 
Management Network page.

The WinClient ActiveX 
Viewer and the WinClient 
AP won't connect to the 
switch.

DirectX 8.0 or higher must be installed on your client 
computer.

After upgrading the 
firmware, the WinClient 
ActiveX Viewer or 
WinClient AP do not run.

The old version of your .ocx file was not deleted. You must 
delete the old file. There are two methods to delete the file.

1. For the ActiveX Viewer: Open IE → Tools → Manage 
Add-ons. Delete or disable all occurrences of WinClient.

2. For the WinClient AP: Open Explorer and search for 
WinClient.ocx. Delete all occurrences.

Part of the remote 
window is off my monitor.

1. Perform an Auto Sync (see WinClient Control Panel 
Functions, page 53, for details).

2. If Keep Screen Size is not enabled (see Screen Options, 
page 79), use the AutoSync feature (see Video Settings, 
page 64), to sync the local and remote monitors.

3. If Keep Screen Size is enabled, you can scroll to the 
areas that are off screen.

The remote screen is 
rotated 90 degrees.

Enable Keep Screen Size (see Control Panel 
Configuration, page 78).

I cannot run Net Meeting 
when the WinClient is 
running.

Enable Keep Screen Size (see Control Panel 
Configuration, page 78).

After logging in I can’t 
open the WinClient 
ActiveX viewer.

1. You don’t have the authority to install the WinClient Con-
trol add-on on your client computer. Have the person 
with administrator privileges on your client computer run 
the program the first time to get it installed. It will open 
for you after that.

2. Under Vista, you must also add the switch’s URL 
address to the list of trusted sites: Tools → Internet 
Options → Security → Trusted Sites → Sites.
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The Java Applet and Java Client AP

Under Vista, after I open 
the WinClient ActiveX 
viewer and try to mount a 
driver or removable disk, I 
get a “Driver not ready” 
message.

This is a result of Vista’s UAC (User Account Control). 
There are two methods to resolve this problem:
1. If you are your client computer’s administrator, open 

your browser by right clicking its icon and choosing Run 
as... then choose to run the browser with the administra-
tor account.

2. If you are not your client computer’s administrator, you 
must ask your client computer’s administrator to disable 
UAC.

Problem Resolution
I can't connect to the switch. 1. The latest Java version must be installed on your cli-

ent computer.
2. Check if you need to specify the Program port along 

with the IP address. See Java Client AP Login, 
page 42, for details.

3. Close Java reopen it, and try again.
I have installed the latest 
Java JRE, but I am having 
performance and stability 
problems.

There may be issues with the latest version because it is 
so new. Try using a Java version that is one or two 
versions earlier than the latest one.

After upgrading the 
firmware, after logging in 
with the Java Applet Viewer 
or the Java Client AP, the 
switch appears to still be 
using the old firmware 
version.

Log out. Delete your Java temporary internet files as 
follows:

1. Open Control Panel → Java.

2. In the Temporary Internet Files section, click Settings.
3. In the Disk Space section, click Delete Files.
4. In the dialog box that comes up, click OK.

The national language 
characters that I input do not 
appear.

Change the keyboard language of your client computer to 
English-UK.
Use the switch On-Screen Keyboard and set the on-
screen keyboard to the same language that the other 
system is using. (See The On-Screen Keyboard, 
page 74.)

Java performance 
deteriorates.

Exit the program and start again.

Pressing the Windows Menu 
key has no effect.

Java doesn't support the Windows Menu key.

When I try to Add a folder to 
be mounted as a virtual 
media drive, I can’t select 
the folder. My only choice is 
Desktop.

In the folder selection entry field, enter the root directory 
of the folder you want to add. After that, the folders 
contained under the root directory will display. You can 
now navigate to the folder you want to select.

Problem Resolution
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Sun Systems

* These solutions work for most common Sun VGA cards. If using them fails 
to resolve the problem, consult the Sun VGA card's manual.

Mac Systems

Problem Resolution

Video display problems with 
HDB15 interface systems 
(e.g. Sun Blade 1000 
servers).*

The display resolution should be set to 1024 x 768 @ 
60Hz:
Under Text Mode:
Go to OK mode and issue the following commands:
setenv output-device screen:r1024x768x60
reset-all
Under XWindow:
1. Open a console and issue the following command:

m64config -res 1024x768x60
2. Log out
3. Log in

Video display problems with 
13W3 interface systems 
(e.g. Sun Ultra servers).*

The display resolution should be set to 1024 x 768 @ 
60Hz:
Under Text Mode:
Go to OK mode and issue the following commands:
setenv output-device screen:r1024x768x60
reset-all
Under XWindow:
1. Open a console and issue the following command:

fbconfig -res 1024x768x60
2. Log out
3. Log in

I have a KA9131 USB 
adapter. Will it work with the 
switch?

Yes. Although we recommend the KA9170 for new 
purchases, if you already have a KA9131 you can use it 
instead of the KA9170.

Problem Resolution

When I log in to the switch 
with my Safari browser, it 
hangs when I use the 
Snapshot feature.

Force close Safari, then reopen it. Don’t use the 
Snapshot feature in the future.

To use the Snapshot feature with Safari, upgrade to Mac 
OS 10.4.11 and Safari 3.0.4.
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Redhat Systems

The Log Server

Panel -Array Mode

Problem Resolution
With Redhat 9.0 (2.4.20-8) installed as 
a server, the keyboard and mouse 
aren’t working normally with the 
KA7175/KA7176 console modules.

Choose the AS3.0 setting for your mouse 
synchronization mode. See Mac and Linux 
Considerations, page 77, for details.

With Redhat 9.0 (2.4.20-8) installed as 
a desktop system, the keyboard and 
mouse aren’t working normally with the 
KA7175/KA7176 console modules.

First, plug your keyboard and mouse into a 
USB 2.0 hub, then plug the hub into the 
Redhat 9.0 server.

Problem Resolution
The Log Server program 
does not run.

The Log Server requires the Microsoft Jet OLEDB 4.0 
driver in order to access the database.
This driver is automatically installed with Windows ME, 
2000 and XP.
For Windows 98 or NT, you will have to go to the 
Microsoft download site: 
http://www.microsoft.com
and do a search for MDAC to retrieve the driver file:

MDAC 2.7 RTM Refresh (2.70.9001.0)
Since this driver is used in Windows Office Suite, an 
alternate method of obtaining it is to install Windows 
Office Suite. Once the driver file or Suite has been 
installed, the Log Server will run.

Problem Resolution
Low resolution video – the 
screens don’t display clearly.

This sometimes occurs due to the screens being scaled 
to fit in the panels. Decrease the number of panels that 
are displayed.

When multiple remote users 
are logged in, some of them 
only receive a partial image.

The first user to invoke Panel Array Mode should set it to 
display at least four panels.

When I try to move forward 
or backward one port, the 
display sometimes moves 
forward two ports or remains 
on the original port.

This occurs occasionally due to a net lag problem. The 
array automatically moves through the ports at a pre-
selected time. By the time it gets your input It has already 
moved forward a port on its own - but that hasn’t shown 
up on your display as yet.
So, when it moves ahead or back due to your input it 
appears to have moved two ports (from its own 
movement plus your “forward one port” command), or 
remains on the original port (from its own forward 
movement plus your “back one port” command).
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Q1: When I open a viewer, the web page does not display or work correctly, 
and I receive an error message that is similar one of the following:

1. Reset the Internet Explorer security settings to enable Active Scripting, 
ActiveX controls, and Java applets
By default, Internet Explorer 6 and some versions of Internet Explorer 5.x 
use the High security level for the Restricted sites zone and Microsoft 
Windows Server 2003 uses the High security level for both the Restricted 
sites zone and the Internet zone. You may want to enable Active Scripting, 
ActiveX controls, and Java applets. To enable Active Scripting, ActiveX 
controls, and Java applets, follow these steps: 

a) Start Internet Explorer.

b) On the Tools menu, click Internet Options.

c) In the Internet Options dialog box, click Security.

d) Click Default Level.

e) Click OK.

2. Verify that Active Scripting, ActiveX, and Java are not blocked
If some client computers work but others do not, verify that Internet 
Explorer or another program on your client computer such as an anti-virus 
program or a firewall are not configured to block scripts, ActiveX 
controls, or Java applets. 

3. Verify that your anti-virus program is not set to scan the Temporary 
Internet Files or Downloaded Program Files folders
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4. Delete all the temporary Internet-related files
To remove all the temporary Internet-related files from your client 
computer, follow these steps: 

a) Start Internet Explorer.

b) On the Tools menu, click Internet Options. 

c) Click the General tab.

d) Under Temporary Internet files, click Settings.

e) Click Delete Files.

f) Click OK.

g) Click Delete Cookies.

h) Click OK.

i) Under History, click Clear History, and then click Yes.

j) Click OK.

5. Make sure that you have the latest version of Microsoft DirectX installed
For information about how to install the latest version of Microsoft 
DirectX, visit the following Microsoft Web site: 

http://www.microsoft.com/windows/directx/default.aspx?url=/windows/
directx/downloads/default.htm

6. Make sure that you have the latest version of the Java JRE installed.
For information about how to install the latest version of the JRE visit the 
Java Web site: www.java.com
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IP Address Determination

If you are an administrator logging in for the first time, you need to access the 
switch in order to give it an IP address that users can connect to. There are three 
methods to choose from. In each case, your client computer must be on the 
same network segment as the switch. After you have connected and logged in 
you can give the switch its fixed network address. (See Network, page 124.)

The Local Console
The easiest way to assign an IP address is from the local console. Refer to First 
Time Setup, page 31, for details on the procedure involved.

IP Installer
For client computers running Windows, an IP address can be assigned with the 
IP Installer utility. The utility can be obtained from the Download area of our 
web site. Look under Driver/SW, and the model of your switch. After 
downloading the utility to your client computer, do the following:

1. Unzip the contents of IPInstaller.zip to a directory on your hard drive.

2. Go to the directory that you unzipped the IPInstaller program to and run 
IPInstaller.exe. A dialog box similar to the one below appears:
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3. Select the switch in the Device List.

Note: 1. If the list is empty, or your device doesn't appear, click 
Enumerate to refresh the Device List.

2. If there is more than one device in the list, use the MAC address 
to pick the one you want. The switch MAC address is located on 
its bottom panel.

4. Select either Obtain an IP address automatically (DHCP), or Specify an 
IP address. If you chose the latter, fill the IP Address, Subnet Mask, and 
Gateway fields with the information appropriate to your network.

5. Click Set IP.

6. After the IP address shows up in the Device List, click Exit. See IP 
Installer, page 129 for more information.

Browser
1. Set your client computer's IP address to 192.168.0.XXX

Where XXX represents any number or numbers except 60. (192.168.0.60 is 
the default address of the switch.)

2. Specify the switch's default IP address (192.168.0.60) in your browser, and 
you will be able to connect.

3. Assign a fixed IP address for the switch that is suitable for the network 
segment that it resides on.

4. After you log out, reset your client computer's IP address to its original 
value.
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Port Forwarding

For devices located behind a router, port forwarding allows the router to pass 
data coming in over a specific port to a specific device. By setting the port 
forwarding parameters, you tell the router which device to send the data 
coming in over a particular port to.

For example, if the switch connected to a particular router has an IP address of 
192.168.1.180, you would log into your router’s setup program and access the 
Port Forwarding (sometimes referred to as Virtual Server) configuration page. 
You would then specify 192.168.1.180 for the IP address and the port number 
you want opened for it (9000 for internet access, for example).

Since configuration setup can vary somewhat for each brand of router, refer to 
the router’s User Manual for specific information on configuring port 
forwarding for it.
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Keyboard Emulation

The PC compatible (101/104 key) keyboard can emulate the functions of the 
Sun and Mac keyboards. The emulation mappings are listed in the table below.

Note: When using key combinations, press and release the first key (Ctrl), 
then press and release the activation key.

PC Keyboard Sun Keyboard PC Keyboard Mac Keyboard

[Ctrl] [T] Stop [Shift] Shift

[Ctrl] [F2] Again [Ctrl] Ctrl

[Ctrl] [F3] Props

[Ctrl] [F4] Undo [Ctrl] [1]

[Ctrl] [F5] Front [Ctrl] [2]

[Ctrl] [F6] Copy [Ctrl] [3]

[Ctrl] [F7] Open [Ctrl] [4]

[Ctrl] [F8] Paste [Alt] Alt

[Ctrl] [F9] Find [Print Screen] F13

[Ctrl] [F10] Cut [Scroll Lock] F14

[Ctrl] [1] =

[Ctrl] [2] [Enter] Return

[Ctrl] [3] [Backspace] Delete

[Ctrl] [4] [Insert] Help

[Ctrl] [H] Help [Ctrl] F15

Compose

-

+
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PPP Modem Operation

Basic Setup
In addition to the browser and AP methods, the switch can also be accessed 
through its RS-232 port using a PPP dial-in connection, as follows:

1. Set up your hardware configuration to match the diagram, below:
:

2. From your client computer, use your modem dial-in program to dial into 
the switch modem.

Note: 1. If you don’t know the switch modem’s serial parameters, get 
them from the switch administrator.

2. An example of setting up a modem dial-in program under 
Windows XP is provided on the next page.

3. Once the connection is established, open your browser, and specify 
192.168.192.1 in the URL box.

Note: The default username and password are blank.

From here, operation is the same as if you had logged in from a browser or with 
the AP programs.

Remote
Operator

Modem

ModemPhone Line

Serial Modem Cable

Cat 5e Cable SA0142
(DB9-M, DTE - DCE)
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Connection Setup Example (Windows XP)
To set up a dial-in connection to the switch under Windows XP, do the 
following:

1. From the Start menu, select Control Panel → Network Connections → 
Create a New Connection.

2. When the Welcome to the New Connection Wizard dialog box appears, 
click Next to move on.

3. In the Network Connection Type dialog box, select Connect to the network 
at my workplace, then click Next.

4. In the Network Connection dialog box, select Dial-up connection, then 
click Next.

5. In the Connection Name dialog box, key in a name for the connection (for 
example, TPE-KN4132-01), then click Next.

6. In the Connection Availability dialog box, you can select either Anyone’s 
use or My use only, depending on your preferences, then click Next.

Note: If you are the only user on this client computer, this dialog box won’t 
appear.

7. In the Phone Number to dial dialog box, key in the phone number of the 
modem connected to the switch (be sure to include country and area codes, 
if necessary), then click Next.

8. In the Completing the New Connection Wizard dialog box, check Add a 
shortcut to this connection on my desktop, then click Finish.

This completes the connection setup. Double click the desktop shortcut icon to 
make a PPP connection to the switch.
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KA7140 Configuration and Operation

The KA7140 Adapter Cable connects a serial device to the switch.

Configuration
To configure the KA7140 to interact with the connected device, you need to set 
its serial parameters to match the parameters of the device, as follows:

1. In the Port Access page Sidebar, select the port that the KA7140 is 
connected to.

2. Select Access on the menu bar.

3. In the Properties section, drop down each of the lists to select the port 
property values that match the ones used by the connected serial console 
device. The port property settings that the KA7140 supports are given in 
the following table:

Setting Meaning

Bits per second
(Baud Rate)

This sets the port’s data transfer speed. Choices are from 
300—38400 (drop down the list to see them all). Set this to 
match the baud rate setting of the serial console device. 
Default is 9600 (which is a basic setting for many serial console 
devices).

Data Bits This sets the number of bits used to transmit one character of 
data. Choices are: 7 and 8. Set this to match the data bit setting 
of the serial console device. Default is 8 (which is the default for 
the majority of serial console devices).
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4. When you have finished making your selections, click Save.

Operation
To operate the device connected to the port, in the Port Access page double 
click the port. After you switch to the port, issue the command that calls up the 
device.

KA7140 Pin Assignments
Pin assignments for the KA7140 Adapter are given in the table, below:

Parity This bit checks the integrity of the transmitted data. Choices 
are: None; Odd; Even. Set this to match the parity setting of the 
serial console device. Default is Odd.

Stop Bits This indicates that a character has been transmitted. Set this to 
match the stop bit setting of the serial console device. Choices 
are: 1 and 2. Default is 1 (which is the default for the majority of 
serial console devices).

Flow Control This allows you to choose how the data flow will be controlled. 
Choices are: None, Hardware, and XON/XOFF. Set this to 
match the flow control setting of the serial console device. 
Default is None.
Note: None is only supported for baud rates of 9600 and lower. 
For baud rates greater than 9600, you must choose Hardware 
or XON/XOFF.

Access Mode This allows you to set the serial console device’s access mode. 
Choices are: Share, Occupy, and Exclusive. Default is Share. 
See Access Mode, page 87 for information regarding this 
function.

Pin Assignment

1 DCD

DB9 Female

2 RXD

3 TXD

4 DTR

5 GND

6 DSR

7 RTS

8 CTS

9 N/A

Setting Meaning
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Additional Mouse Synchronization Procedures

If you use Manual Mouse Synchronization, you must perform the following 
operations on the servers that connect to the switch.

Note: 1. These procedures are to be performed on the servers attached to the 
switch’s ports - not on the client computer you are using to access the 
switch.

2. In order for the local and remote mice to synchronize, you must use 
the generic mouse driver supplied with the Windows operating 
system. If you have a third party driver installed - such as one 
supplied by the mouse manufacturer - you must remove it.

Windows:
1. Windows 2000:

a) Open the Mouse Properties dialog box (Control Panel → Mouse → 
Mouse Properties)

b) Click the Motion tab

c) Set the mouse speed to the middle position (6 units in from the left)

d) Set the mouse acceleration to None
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2. Windows XP / Windows Server 2003:

a) Open the Mouse Properties dialog box (Control Panel → Mouse)

b) Click the Pointer Options tab

c) Set the mouse speed to the middle position (6 units in from the left)

d) Disable Enhance Pointer Precision

3. Windows ME:
Set the mouse speed to the middle position; disable mouse acceleration 
(click Advanced to get the dialog box for this).

4. Windows NT / Windows 98 / Windows 95:
Set the mouse speed to the slowest position.

Sun / Linux
Open a terminal session and issue the following command:

Sun: xset m 1
Linux: xset m 0
or
xset m 1
(If one doesn’t help, try the other.)
Linux using the Redhat AS3.0 mouse mode: xset m 1
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Additional Video Resolution Procedures

If you are running Windows, and wish to use the refresh rates indicated with 
an asterisk (*) on page 8, do the following:

1. Open Control Panel → Display → Settings → Advanced → Monitor.

2. In the dialog box that comes up, make sure that the Hide modes that this 
monitor cannot display checkbox is unchecked.

3. Click the arrow at the right of the Screen refresh rate listbox, and select 
the refresh rate you want from the list that appears.

Note: Make sure that your monitor supports the refresh rate you choose – if 
not, you may seriously damage your monitor.

kn2124v-4132.book  Page 218  Tuesday, January 12, 2010  5:08 PM



 Appendix

219

Trusted Certificates

Overview
When you try to log in to the device from your browser, a Security Alert 
message appears to inform you that the device’s certificate is not trusted, and 
asks if you want to proceed.

The certificate can be trusted, but the alert is triggered because the certificate’s 
name is not found on Microsoft list of Trusted Authorities. You have two 
options: 1) you can ignore the warning and click Yes to go on; or 2) you can 
install the certificate and have it be recognized as trusted.

If you are working on a client computer at another location, accept the 
certificate for just this session by clicking Yes.
If you are working at your own client computer, install the certificate on 
your client computer (see below for details). After the certificate is 
installed, it will be recognized as trusted.
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Installing the Certificate
To install the certificate, do the following:

1. In the Security Alert dialog box, click View Certificate. The Certificate 
Information dialog box appears:

Note: There is a red and white X logo over the certificate to indicate that it is 
not trusted.

2. Click Install Certificate.

3. Follow the Installation Wizard to complete the installation. Unless you 
have a specific reason to choose otherwise, accept the default options.

4. When the Wizard presents a caution screen:

Click Yes.
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5. Next, click Finish to complete the installation; then click OK to close the 
dialog box.

Certificate Trusted
The certificate is now trusted:

When you click View Certificate, you can see that the red and white X logo is 
no longer present – further indication that the certificate is trusted:
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Mismatch Considerations
If the site name or IP address used for generating the certificate no longer 
matches the current address of the switch a mismatch warning occurs:

You can click Yes to go on, or you can disable mismatch checking.

To disable mismatch checking, do the following:

1. After the page you are logging in to comes up open the browser’s Tools 
menu; Select Internet Options → Advanced.

2. Scroll to the bottom of the list and uncheck Warn about trusted 
certificates:

3. Click OK. The next time you run the browser the change will be in effect.
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Self-Signed Private Certificates

If you wish to create your own self-signed encryption key and certificate, a free 
utility – openssl.exe – is available for download over the web at 
www.openssl.org. To create your private key and certificate do the following:

1. Go to the directory where you downloaded and extracted openssl.exe to.

2. Run openssl.exe with the following parameters:
openssl req -new -newkey rsa:1024 -days 3653 -nodes -x509 
-keyout CA.key  -out CA.cer -config openssl.cnf

Note: 1. The command should be entered all on one line (i.e., do not press 
[Enter] until all the parameters have been keyed in).

2. If there are spaces in the input, surround the entry in quotes (e.g., 
“ATEN International”).

To avoid having to input information during key generation the following 
additional parameters can be used:

/C /ST /L /O /OU /CN /emailAddress.

Examples
openssl req -new -newkey rsa:1024 -days 3653 -nodes -x509 
-keyout CA.key  -out CA.cer -config openssl.cnf -subj 
/C=yourcountry/ST=yourstateorprovince/L=yourlocationor 
city/O=yourorganiztion/OU=yourorganizationalunit/
CN=yourcommonname/emailAddress=name@yourcompany.com

openssl req -new -newkey rsa:1024 -days 3653 -nodes -x509 
-keyout CA.key  -out CA.cer -config openssl.cnf -subj 
/C=CA/ST=BC/L=Richmond/O="ATEN International"/OU=ATEN
/CN=ATEN/emailAddress=eservice@aten.com.tw

Importing the Files
After the openssl.exe program completes, two files – CA.key (the private key) 
and CA.cer (the self-signed SSL certificate) – are created in the directory that 
you ran the program from. These are the files that you upload in the Private 
Certificate panel of the Security page (see Security, page 134, and Private 
Certificate, page 137).
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Fan Location and Speed Information

Fan Location
The switch has 6 fans that feed realtime fan speed information to the WinClient 
/ Java Client Device Management page.

The fan locations in the above image are listed in the Device Information 
section under Fan Speed. See , page 144, for details.

Fan Speed
The fan speed automatically adjusts according to temperature as follows:

If any sensor senses that the temperature is greater than 32° C, all the fans 
are set to spin at half speed.
If any sensor senses that the temperature is greater than 45° C, all the fans 
are set to spin at full speed.
When all four sensors sense that the temperature is less than 40° C, all the 
fans return to half speed.
When all four sensors sense that the temperature is less than 30° C, all the 
fans turn off.

1
2

3

4
5

6
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Temperature Sensor Location and Information

The switch has 4 temperature sensors on its mainboard that feed realtime 
temperature updates to the WinClient / Java Client Device Management page.

The sensors in the above image are described in the Device Information section 
under Temperature. See Temperature, page 123, for details.

Note: The temperature inside the case can be higher than the ambient (room) 
temperature (0–50° C). IC chips can tolerate temperatures of up to 105° 
C. If the temperature reading rises past 85° C or so, you should either 
make the ambient temperature cooler or, if necessary, shut the switch 
down until it cools off.

1

2

3

4
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Clear Login Information

If you are unable to perform an Administrator login (because the Username and 
Password information has become corrupted or you have forgotten it, for 
example) you can clear the login information with the following procedure.

Note: Performing this procedure also returns all settings to their defaults.

To clear the login information (and return all settings to their defaults), do the 
following:

1. Power off the switch and remove its housing.

2. Use a jumper cap to short the mainboard jumper labeled J23.

3. Power on the switch.

4. When the Link and 10/100Mbps LEDs flash, power off the switch.

5. Remove the jumper cap from J23.

6. Close the housing and start the switch.
After powering on the unit, you can use the default Super Administrator 
Username and Password (see First Time Setup, page 31), to log in.
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Factory Default Settings

The default settings are as follows:

Serial Adapter Pin Assignments

SA0142: RJ45-F to DB9-M (Black Connector) DTE to DCE

Setting Default

Language English

OSD Hotkey [Scroll Lock] [Scroll Lock]

Port ID Display Port Number + Name

Port ID Display Duration 3 Seconds

Scan/Skip Mode All

Scan Duration 5 Seconds

Screen Blanker 0 Minutes (disabled)

Beeper On

Viewer Auto Detect

Welcome Message Hide

Accessible Ports Super Administrators – Full for all ports

All other users – None for all ports.

switch
(RJ45)

Pins (8) Modem/Device 
(DB9)

RTS 1 <————————> 7

DTR 2 <————————> 4

TXD 3 <————————> 3

CTS 4 <————————> 8

GND 5 <————————> 5

RXD 6 <————————> 2

DCD 7 <————————> 1

DSR 8 <————————> 6

9 NC not used
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Supported KVM Switches

The following is a list of fully supported KVM switches that can be used in a 
cascaded installation:

KH88
KH98
KH1508
KH1516
CS9134
CS9138

Note: 1. Some of the KVM Over the NETTM switch’s features may not be 
supported, depending on the functionality of the cascaded KVM 
switch. (For example, some switches do not support virtual media.)

2. The installation cannot be cascaded beyond the second level.
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Virtual Media Support

WinClient ActiveX Viewer / WinClient AP
IDE CDROM/DVD-ROM Drives – Read Only
IDE Hard Drives – Read Only
USB CDROM/DVD-ROM Drives – Read Only
USB Hard Drives – Read/Write*
USB Flash Drives – Read/Write*
USB Floppy Drives – Read/Write

* These drives can be mounted either as a Drive or as a Removable Disk 
(see Virtual Media, page 70). Removable disks allow the user to boot the 
remote server if the disk contains a bootable OS. In addition, if the disk 
contains more than one partition, the remote server can access all the 
partitions.

ISO Files – Read Only
Folders – Read/Write

Java Applet Viewer / Java Client AP
ISO Files – Read Only
Folders – Read/Write
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Limited Warranty
ALTUSEN warrants this product against defects in material or workmanship for a period of one 
(1) year from the date of purchase. If this product proves to be defective, contact ALTUSEN's 
support department for repair or replacement of your unit. ALTUSEN will not issue a refund. 
Return requests can not be processed without the original proof of purchase.

When returning the product, you must ship the product in its original packaging or packaging that 
gives an equal degree of protection. Include your proof of purchase in the packaging and the RMA 
number clearly marked on the outside of the package.

This warranty becomes invalid if the factory-supplied serial number has been removed or altered 
on the product.

This warranty does not cover cosmetic damage or damage due to acts of God, accident, misuse, 
abuse, negligence or modification of any part of the product. This warranty does not cover damage 
due to improper operation or maintenance, connection to improper equipment, or attempted repair 
by anyone other than ALTUSEN. This warranty does not cover products sold AS IS or WITH 
FAULTS.

IN NO EVENT SHALL ALTUSEN'S LIABILITY EXCEED THE PRICE PAID FOR THE 
PRODUCT. FURTHER, ALTUSEN SHALL NOT BE RESPONSIBLE FOR DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING 
FROM THE USE OF THE PRODUCT, ITS ACCOMPANYING SOFTWARE, OR ITS 
DOCUMENTATION. ALTUSEN SHALL NOT IN ANY WAY BE RESPONSIBLE FOR, 
WITHOUT LIMITATION, LOSS OF DATA, LOSS OF PROFITS, DOWNTIME, GOODWILL, 
DAMAGE OR REPLACEMENT OF EQUIPMENT OR PROPERTY, AND ANY EXPENSES 
FROM RECOVERY, PROGRAMMING, AND REPRODUCTION OF ANY PROGRAM OR 
DATA.

ALTUSEN makes no warranty or representation, expressed, implied, or statutory with respect to 
its products, contents or use of this documentation and all accompanying software, and specifically 
disclaims its quality, performance, merchantability, or fitness for any particular purpose.

ALTUSEN reserves the right to revise or update its product, software or documentation without 
obligation to notify any individual or entity of such revisions, or update.

For details about extended warranties, please contact one of our dedicated value added resellers.
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Access Ports, 125
Adapter Attributes, 140
Adapter cable

firmware upgrade recovery, 150
Adapter Cables

upgrading, 149
Adapter connection diagram, 25
Adapter ID Function, 28
Adding Users, 107
Additional Video Resolution 
Procedures, 218
Administration Page

Date/Time, 142
ANMS, 128
Array, 89
Authentication

external, 128
Auto Scanning, 158

Exiting, 159
Invoking, 158
Pausing, 159
Scan Interval, 158

Auto scanning, 89

B
Backup/Restore, 151
Beeps, 123

C
Cat5 cable length, 87
CC Management, 132
Clear Login Information, 226
Clear Port Names, 140
Components, 10

Front View, 10
Rear View, 12

Control Panel, 48
Java Client AP, 80
WinClient, 51

Creating Groups, 111
Customization page, 138

D
Date/Time Settings, 142

Synchronize, 47
Deleting groups, 113
Deleting user accounts, 110
Device Assignment, 118
Device Management, 121

Customization, 138
General, 122
Network, 124
Security, 134

Device Permissions
assigning, 118, 120

DNS Server, 127
DynaSync, 76

E
Event Panel, 172
External authentication, 128

F
Factory Default Settings, 227
Fan Location and Speed, 224
Fan Warning Message, 123
Favorites, 94
Features

V-Series exclusive, 6
Filter, 90, 99
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Filtering
IP, 135
MAC, 135

Firmware
upgrading, 145, 148

Firmware Upgrade
Adapters, 149

Firmware upgrade recovery, 150
Firmware, Upgrading, 47
Front View, 10

G
General page, 122
Groups

assigning users, 114, 116
creating, 111
Deleting, 113
Managing, 111
Modifying, 113
removing users, 115, 117

H
Hardware Setup, 15
Hot Plugging, 28

I
Installation

Single Station, 21
Two Stage, 26

Introduction, 1
Invalid login, 37
IP

Address determination, 208
IP Address, 127
IP Filtering, 135
IP Installer, 129, 208

J
Java Client AP

GUI, 48
Logging in, 42

K
KA7140 Pin Assignments, 215
KA7140 Setup and Operation, 214
Keyboard

On-Screen, 74
Keyboard Emulation, 211

Mac, 211
KVM Adapter Cables

upgrading, 149

L
LDAP / LDAPS, 132
LDAP Server Configuration, 173
List Panel, 172
Local Console

GUI, 50
Main Page, 50

Log, 98
filter, 99

Log Server, 205
Configure, 167
Event Panel, 172
Events, 168
Installation, 165
List Panel, 172
Main Screen, 171
Menu Bar, 167
Options, 170
Starting Up, 166

Log server, 130, 165
Logging in

Browser, 38
Java Client AP, 42
Local console, 37
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WinClient AP, 39
Login

Invalid login, 37
Login Failures, 138
Login String, 136

M
MAC Filtering, 135
Mac Keyboard Emulation, 211
Macros

Search, 61
Managing Groups, 111
Managing Users, 107
Message Board

Windows Client, 67
Modem operation, 212, 225
Modifying groups, 113
Modifying user accounts, 110
Module connection diagram, 25
Mouse

DynaSync Mode, 76
Synchronization, 76

Mouse pointer type, 75
Mouse Problems, 199
Mouse synchronization

Windows, 216

N
Network page, 124
Network Time, 143
Network Transfer Rate, 127
NIC Settings, 126

O
Online

Registration, iii
On-Screen Keyboard, 74
OOBC, 133
OpenLDAP

Server Configuration, 183
Server Installation, 182

Overview, 1

P
Panel array, 89
Panel Array Mode, 161, 205
Panel Array toolbar, 162
Port

Naming, 88
Properties, 86

Port Access, 81
Access, 101
filter log, 99
log page, 98
Sessions, 100

Port Access Page
Recalling, 160

Port Forwarding, 210
Port ID Numbering, 29
Port names

clearing, 140
Port Operation, 155
Port Selection, 29

Sidebar, 83
Tree, 83

Port Utilities, 84
Power Supply Detection, 123
Powering Off and Restarting, 28
PPP, 212, 225
Private Certificates, 223

R
Rack Mounting

Front, 17
Rear, 19

RADIUS
settings, 131

Rear View, 12
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Redhat, 205
Redundant NIC, 126
refresh screen, 65
Requirements

Operating Systems, 9
OS Support, 9

RoHS, ii

S
Safety Instructions

General, 189
Rack Mounting, 191

Scan, 89
screen, refresh, 65
Search

Macros, 61
Security

Login string, 136
Security page, 134
Self-signed certificates, 223
Serial Adapter pin 
assignments, 227
Sessions, 100
Single Station Installation, 21
SJ/T 11364-2006, ii
Skip Mode, 159
Stacking, 16
Sun Keyboard Emulation, 211
Supported KVM Switches, 228
Synchronization

mouse, 76
System Requirements, 7

KVM Adapter Cables, 8

T
Technical Support, 192
Telephone support, iii
Time settings, 142

Toolbar
Hotkey port switching, 158
Icons, 157

Troubleshooting
General Operation, 197
Java Applet, 203
Log Server, 205
Mac Systems, 204
Mouse problems, 199
Panel Array Mode, 205
Redhat, 205
Sun Systems, 204
Virtual Media, 201
Web Browser, 201
WinClient ActiveX Viewer, 202
WinClient AP, 202

Trusted Certificates, 219
Two IP Addresses, 126
Two Stage Installation, 26

U
User Interface, 45

GUI, 48
Local Console, 50
Tab bar, 47
Web Browser Main Page, 45

User interface
Page components, 46

User Management, 105
User Notice, iii
Users

Adding, 107
assigning to groups, 114, 116
Deleting, 110
Managing, 107
Modifying, 110
removing from groups, 115, 117

Users and Groups, 114
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V
Video requirements, 8
Video Resolution

additional procedures, 218
Video Settings, 64
Virtual Media

Troubleshooting, 201
WinClient, 70

Virtual Media Support, 229

W
Warning beeps, 123

Web Browser Main Page, 45
WinClient AP

GUI, 48
Logging in, 39

Windows AP
Connection Screen, 40
File Menu, 41

Windows Client
Auto Scanning, 158
Message Board, 67

Working Mode, 139
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